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1 INTRODUCTION

1.1 PREREQUISITES

This  manual  is  not  a  general  introduction  to  weaving.  If  you  have  no  idea  on  how  fabrics  are

manufactured, it is unlikely that you will learn it from here. You should study a textile textbook to learn

the textile basics.

The  user  guide  assumes  you  have  a  working  knowledge  of  your  computer  and  its  operating
conventions, including how to use a mouse and standard menus and commands. It also assumes you
know how to load, save, and locate files.

You can read this  manual wherever you want, but it  will  be beneficial  if  you have  the ArahWeave
system up and running on your computer, so you can immediately try out the things you learn.

1.2 THANKS & WARNING

Thank you for having chosen Arahne's product. Arahne is weaving its programs day and night so that it

would be easier for you to make quality  fabrics.  Therefore it  can happen that this  manual and the

program you will be using are inconsistent. This means that you will find some more features, or some

functions  will  be  implemented  in  a  different  (we  hope:  better)  way.  We  are  trying  to  make  our

programs as simple as possible and also provide online help, so these changes should not disturb you

too much. If they do, we apologize and we will get better in the next version.

We also appreciate comments and suggestions from our users, as well as reports of malfunctions. The

sooner you fax/email them to us, the sooner your suggestions will be implemented or bugs removed.

Sometimes we will not be able to implement all your suggestions, but we will be able to make good

decisions on what to do next, based on your feedback.

1.3 OVERVIEW OF WEAVING CAD/CAM
If you are new to CAD, you may find it difficult at the beginning. Still, the basic operations are similar to

using a word processor. You run the program, enter some data, control it on screen so that it looks

correct, you print it out and save it to disk for future reference or reuse.

ArahWeave distinguishes itself from the competition by the fact that it was written from scratch for the

multitasking windowing platform. Because of this, it fully exploits the windowing possibilities:

• Most windows can be resized to provide a bigger view of data, if necessary.

• Windows can be freely moved on the desktop.

• Printing will not block your work.

• You can work with many tools at once.

• Program will  always try to give you a coherent view of your data, no matter which part you

perform the change.

The fact that you can have more tools on the screen may be confusing at the beginning, but it permits

you to have a personal style of work. You can close down the tools,  which you do not need at the

moment, or keep them open, make changes and immediately observe the effect on the fabric.

There is no general Undo function in ArahWeave, but most functions have their own Undo.

It is relatively easy to construct a fabric. The whole art is to combine these elements:

• Weave (the way the threads interlace) – dobby weaves are mostly small and can be drawn by hand, 

while jacquard weaves are big, and are constructed from a color image, where each color is replaced 

by one weave.

• Warp and weft sequences.

• Yarn, count, and structure.

• Colors.
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• Density of weaving.

Still, sometimes you will be surprised by what a simple interplay of these factors will produce. This is 

the very reason why you should use ArahWeave:

• To play with these settings without constraints and with minimal expenses.

• To communicate the result of your creative work to non-textile people, by printing out the 

simulation.

• To provide your production departments with printouts of production tickets or CAM data for 

production.

In this way, expensive design errors will be avoided, and the CAD system will soon pay itself back. You

will also gain a lot in response time, since you will be able to give an answer to customer inquiries in

just  a few minutes.  As worldwide digital  communication is  a reality  available to everyone, you can

email a fabric simulation to the client. You can use the CAD data on your home page with your current

collection, images of fabrics, pricing, availability, etc. Or your design system can be configured as an

Intranet  web  server,  which  delivers  technical  data  sheets  to  anyone  in  the  company,  using  any

computer or any operating system, as long as it is networked and it has an Internet browser.

Now we must also tell what ArahWeave will not do for you: it does not create a weave structure based

on the fabric digital image. Some users expect that they will simply scan a fabric in a computer and get

a printout of the production ticket out of the computer. This is not possible, because the current level

of automatic image recognition does not (yet) enable us to distinguish the weave from different yarn

colors used in the fabric. Still,  ArahWeave is a great tool in getting a fabric’s weave structure: you can

enter data as you analyze the fabric, and verify it on the fly. You will be able to enter the data both as a

number of threads or as a length in millimeters. The simulation view also enables you to match fabric

against screen fabric simulation, since they should be of the same size if data was entered correctly.

The program will  also  help you with automatic adaptation to different  “qualities”,  that is  different

density settings without changing the overall size of the pattern.

For jacquard users,  ArahWeave can also be useful to change/adapt a jacquard card file prepared for

weaving in one format/loom layout into another format/loom layout.

The majority of the readers of this manual will only be interested in the dobby capability of ArahWeave

since they greatly  outnumber jacquard weavers.  The chapters  or  sections,  which are useful  almost

exclusively to jacquard or dobby weavers, will be marked by word jacquard or  dobby in the title. We

want to avoid confusion of readers with additional information, which they do not need.

And finally, we must tell you what the logic behind the organization of this manual is. We have decided

to group chapters and sections into logical problem groups. For each group of functions, we first try to

explain why they are needed, and then how and why they work in this way. So we have avoided the

classical programmer’s manual,  which just lists  the menu entries from left to right and from top to

bottom. We have also included some tips for weaving, which we have learned thanks to our customers.

Unfortunately, weaving itself is a tightly interwoven topic, so if you read the manual from beginning to

the end, you will find references to topics that will be fully explained in later sections. So you should

really read it in a forward/backward manner, or maybe re-read a previous section once you learn new

topics that were mentioned before. The negative side of our approach is that it may be difficult to find

just an explanation of a certain function. Fortunately, PDF viewers have the search function, so it is

easy to find all places which mention a certain topic.

1.4 HOW TO GET ARAHWEAVE UP AND RUNNING

You know, press the power button on your computer. Wait until the computer finishes its power-on

diagnostics. If you have several operating systems installed on your computer, you will be prompted by

a list  of  installed  systems.  Select  by  highlighting  it  with  up  /  down arrows  on the list  of  available

systems. If you wait too long, it will automatically boot the one that was last loaded or the default one.

If you have installed only one operating system, it will boot automatically without asking any questions.

On modern Linux desktops, ArahWeave is available as one of the program icons  on the Desktop. 



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  3

Figure 1: ArahWeave on OpenSUSE Linux using KDE Desktop

 

1.5 PROGRAM INSTALLATION

You  will  need  three  files  for  installation  on  Linux:  aw64.tar.bz2,

aw2.tar.bz2 and INSTALL_AW64 (for ArahWeave Personal Edition the

files are awpe64.tar.bz2, awpe2.tar.bz2 and INSTALL_PE64). Copy them

to the Desktop and click on the file INSTALL_AW64 (or INSTALL_PE64).

This will launch the installation utility (Figure 2). Click the OK button to

start the installation.

Figure 2: ArahWeave
installation

When the installation is finished, a message indicating successful

completion will  appear. Click on the  Exit button.  After that, you

can delete the program’s installation files.

1.6 RUNNING THE PROGRAM FOR THE FIRST TIME

There are some user settings, which you should set through  Help >  Save setup to make  ArahWeave

really usable. These settings are:

• Program activation

• Language

• Measurement system

• Screen size

Figure 3: Message after successful
installation
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Click  Arahweave’s icon   on  the  desktop.

Because you are running it for the first time, and

it  is  not  activated  yet,  the  program

automatically opens the Save setup window.

Figure 4: Save setup window

1.6.1 SETTING THE LANGUAGE

English is the default language. You can change the language

in the Save setup window, which is accessible from the main

ArahWeave window through the Help > Save setup. You can

choose  one  of  nine  languages.  In  languages  other  than

English, the menu entry Save setup is written in English and

in  the current language, so it  will  be easier to change the

language back if  you make a mistake.  Language change is

immediate  for  ArahWeave,  but  you  must  restart  other

programs  (ArahPaint,  ArahDrape)  if  they  are  already

running.

Figure 5: Language selection

1.6.2 PROGRAM ACTIVATION

The  Owner field  contains  the Arahne  DEMO text.

Type in  the owner’s name,  which was assigned to

you.
Figure 6: Activation code field

After  clicking  OK the  Information window  with

your personal registration code pops up.

Figure 7: Registration code

Send  the  registration  code  to  Arahne’s e-mail  address

arahne@arahne.si We will  send you back the activation code. Type

your activation code into the red field. The program will give notice of

successful activation.

Figure 8: Information about
activation

mailto:arahne@arahne.si
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1.6.3 USER INTERFACE PROFILES

Arahne makes the program simple for beginners, with all the basic functions without much distraction,

but also offers all the advanced functions for customers, who can handle them.

The Mode menu offers you the choice between Simplified, Normal, Expert, and Server mode.

• Simplified mode is for beginners, it is the default mode in the demo version of the

program. It will  hide most of the complex,  hard-to-understand features, and keep

the essential.  For example, a beginner probably won’t make fabric with dual weft

insertion, two warp beams, and does not care about the fabric price calculation. A

weaving course in school should use simplified mode.

• Normal mode is the default for ArahWeave Personal Edition or Pro versions. It shows

all functions, options, buttons, and menus.

• Expert  mode offers  some  exotic,  potentially  dangerous  functions,  and  should  be

used for those who know what they are doing.  One such function in this  mode allows users  to

convert jacquard cards into fabric files by using a loom layout. Or converting all the weaves from

BMP, TIFF, GIF... to Arahne weave file format.

• Server mode blocks the program’s  GUI functions,  and the program actions are triggered by XML

files, created and delivered by the ERP system.

1.6.4 MEASUREMENT SYSTEM

Click  the  Measurement  system in  the  Save  setup

window. You can choose between  Metric (m, cm, kg),

Imperial (yards, inches, pounds), or Mixed.

The  Mixed system enables you to set imperial  or

metric systems for fifteen different parameters if

you live in a country where you use both systems

contemporary. If you need to use both the imperial

and metric system, but one at a time, and you wish

to quickly switch between the two, you can press

keyboard shortcut  U to toggle unit from metric to

imperial and back.

1.6.5 DISPLAY SIZE

The display size (or viewable image size) of your monitor

is the next important setting. Based on the display’s width

and height information (the unit could be millimeters (or

inches)  or  dpi  (dots  per  inch),  the program  adjusts the

fabric simulation to match 1:1 size,  and the rulers (bars

with numbers) on the upper and left-hand sides of the main ArahWeave window will match a physical

ruler.  The  program  detects the  correct  values  automatically  if  the  display  and  graphics  card  are

properly configured. In case you have changed a monitor, the old values are wrong – to get new values,

click the bulb icon  next to the unit button (mm or dpi). If the system reports the wrong screen size,

Figure 10: Measurement system

Figure 11: Mixed measurement system

Figure 9: The
Mode menu

Figure 12: Screen size
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measure a display with a physical ruler and type in the size values. To save the screen size values, click

OK in the Save setup dialog window.

1.6.6 SETTING THE NUMBER OF CPU CORES

The speed of many ArahWeave’s operations, like a simulation’s rendering and file browsing, depends

on the  speed of  the processor (CPU). During the installation,  ArahWeave detects the number of CPU

cores  and  adjusts  the  setting  according  to  this  number.  However,  if  you  change  the  number  of

processors  with  installing  a new  CPU or  most  likely  if  you  run  the  ArahWeave virtual  machine  on

VMware Player or other virtualization software, ArahWeave will not detect the change automatically.

To update ArahWeave’s settings, open Help > Save setup, choose the Expert tab, and click the bulb icon

 next to the  Number of CPU cores field. After a few seconds in which the program has found the

correct number of cores, ArahWeave pops-up the Information window with the Number of cores and

the Speedup factor information. It also writes the new number into the Number of CPU cores field, and

closes the Information window. You just need to click the OK button the Save setup dialog window to

save the new CPU cores number in ArahWeave’s setting.

Figure 13: Finding the number of CPU cores

 

1.6.7 DEFAULT WINDOW SIZE

The current size of the ArahWeave windows and dialog boxes is saved when you save the setup (Help >

Save setup; click OK). When you open ArahWeave again, the size of the following windows will remain

exactly  the  same  as  when  you  saved  the  setup:  Weave  editor,  Decomposed  weave  editor,  Print

preview, Main window, Multi-image jacquard conversion,  Multi-fabric  print  setup,  Weave browser,

Image  browser,  Fabric  browser,  Image  area  of  the  jacquard  conversion  window,  Consumption

calculation HTML area, Warp sections HTML.

If you don't want to save the current window sizes when you save the setup, uncheck the Save default

size option in the Save setup window's Appearance tab. 
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The  other  way  of  saving  the  size  of  the  windows  is  to

access the Save default window size function directly from

the  Help menu.  Choose  Help >  Save default  window size,

and the size of the windows will be set to the current size.

Figure 14: Saving the program's windows
size

1.6.8 DEFAULT WINDOW POSITIONS ON THE DESKTOP

You can save the location of ArahWeave's windows on the Desktop by

selecting the  Save default position option in the  Appearance tab of the

Save setup dialog and then saving the configuration. When you launch

ArahWeave again, it will appear on the Desktop in the same location as it

was  when  you  saved  the  settings  with  the  Default  position  option

enabled. Figure 15: Saving the
default window position

2 WORKING WITH FILES

2.1 DIRECTORIES AND FILE TYPES

Since ArahWeave is a versatile program, it needs to read and write many files for different purposes. So

before going into details of the many capabilities of this program, we should have a clear idea about

what ArahWeave can read and write, and where should the necessary files be located.

All  the user data files  are stored in  directory  /home/user_name/data and it  contains  the following

subdirectories:

• img (color images  in jacquard conversion;  standard formats;  suffix PNG, GIF,  PCX, JPG,  TIF,  BMP,

webP).

• textures (fabric simulation images for usage with ArahDrape; standard image formats).

• models (model images for usage with ArahDrape; standard image formats).

• colors (color database with color specified in CIELab space, Arahne’s custom format), suffix .col (color

measurement  for  CIELab  data  read  with  a spectrophotometer,  ASCII,  Arahne’s custom  format)

suffix .cm

• fabrics (contains all information relevant to fabric: colors, yarns, weave, density and other technical

details; Arahne’s custom format), no suffix.

• demo (100 samples so you see what you can do once you learn the program).

• tartans (300 samples of Scottish tartans).

• yarns (yarn containing yarn colors, count, twist, etc., Arahne’s custom format) no suffix

• weaves (weave containing drafting and card; can also be a full jacquard weave up to 65520x65520,

Arahne’s custom format) no suffix

• demo (100 sample weaves with English names)
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• Fressinet (2900 weaves from an old weave library/book)

• Gunetti (1700 weaves from an old weave library/book)

• Poma (2200 weaves from an old weave library/book)

• Posselt (1900 weaves from an old weave library/book)

• Serrure (3200 weaves from an old weave library/book)

• selvedges (place where you should put your weaves for selvedges)

• shading (some satin and serge weaves, which are suitable for grayscale jacquard shading)

• cards (jacquard files ready for weaving; in loom specific jacquard formats,  like Stäubli JC5, Grosse,

Bonas)

• conversion (jacquard  conversion,  contains  associations of  colors and weaves,  and  the  selected

conversion type; Arahne’s custom format), no suffix

• loom (loom layout,  weft layout;  machine specific  allocation of  hooks  and weft change;  Arahne’s

custom  format),  no  suffix.  This  directory  also  contains  the  .looms file,  used  for  jacquard  loom

networking.

• warp pattern (warp patterns in Arahne’s custom format)

• weft pattern (weft patterns in Arahne’s custom format)

• drafting (drafting data in Arahne’s custom format)

• denting (denting data in Arahne’s custom format)

• HTML (fabric technical calculations in HMTL format)

• XML (fabric technical data exported in XML format), also location of XML import files

• drape (drape projects; Arahne’s custom format), suffix .drape.

The above division of directories is Arahne’s suggestion; you are free to make your own or to create

subdirectories, wherever necessary – make them by clients, years of collection, or whatever you are

comfortable with.

2.1.1 FABRIC FILE FORMAT

When you save a fabric file, it is saved in its own Arahne format. It contains all information relevant to

fabric: colors, yarns, weave, density, and other technical details. If you generate a fabric by replacing

colors in the image with weaves (Jacquard conversion), then also the image and corresponding weaves

are saved in the file.

By default, ArahWeave saves only yarns, which are used in the fabric, in  a fabric file. Next time, when

you load that file, only saved (used) yarns are loaded, the other yarns in the Edit warp and weft pattern

dialog  (25  yarns  for  each)  are default  yarns.  But,  if  you enable  the  Save  unused  warp/weft in  the

Weaving option of the Save setup dialog, then all currently yarns from the Edit warp and weft pattern

dialog are saved in fabric file, and thus loaded when you open the fabric file next time.

2.2 SETTING A DEFAULT FABRIC

When you open ArahWeave, it displays the default fabric. If you want that another fabric becomes a

default one,  load  it into the program, and choose  Help >  Set current fabric as default from  the  main

menu bar. 
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2.3 CHANGING DEFAULT LOCATION (FOLDERS) FOR SAVING

To change the default location, from where

the files are loaded or saved, you have to

load  the  desired  file  from  a  specific

location into ArahWeave (a fabric file in the

main  ArahWeave window,  a  weave file  in

the  Weave editor,  a  yarn  file  in  the  Edit

yarns window,  an  image  file  in  the

Jacquard  conversion window,  a  loom

layout  file  in  the  Save  cards  from

production window,  etc...).  Then choose

Help >  Save  setup.  Check the  Set  default

directories button, and click the OK button

in the Save setup window. 
Figure 17: Currently active folders are displayed in the Save
setup window. If you save the setup now, these folders will

become the default folders for loading or saving files.

There is also an option to save the position of the

default opening location for a particular directory

directly from the Help menu:

• Fabrics: Help > Set current fabric as default.

• Colors: Help > Set current color atlas as default.

• Loom  layouts:  Help >  Set  current  layout  as

default.

• Yarns,  Weaves,  Images,  Cards,  HTML,  XML:

Help >  Set  current  directory  as  default,  and

select  a  type of  files,  for  which  you  want  to

keep a current opening location.

 

Figure 16: Setting current fabric
as default

Figure 18: Setting the current directory as default
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2.4 CHANGING THE DEFAULT LOCATION OF THE ARAHNE DATA FOLDER

Another  way  to  change  the  default

location is to change and save it in one

step. The default location of the data

folder  is  /home/user_name/data  (in

case of ArahWeave Personal Edition it

is   /home/user_name/arahne/data). If

you want to change location, open the

Save  setup  window and  click  the  Set

default  path button. Type the desired

path  to  a  location  in  the  dialog  and

click OK.

2.5 HOW TO SOLVE PROBLEMS WITH PERMISSIONS

When several users are working on the same data files, and files are shared via  the  network, it can

happen that one user cannot modify  or  read files  written by another user.  By default,  all  the files

written  by  Arahne’s programs  are  saved  with  read/write  permissions  to  everybody,  so  that  this

problem would not occur. If you don’t like this behavior, you can switch it off in the Expert section of

Save  setup.  But  in  the  case,  you  copy  the  files  from  an  external  source,  for  example  from  email

attachments, CD-ROM, or USB memory key, the permissions will be set to system defaults. This usually

means that others cannot modify your files. You should remember to use  the right mouse button on

the newly copied files, and change access permissions so that everybody can read and modify them. If

you forgot to do this, and you get a lot of permission errors, you can use one command to get all the

permissions right.

Open a terminal and type:

su root
---enter your password---

chmod -R a+rw /home/user_name/data
exit

3 FABRIC FILES

Fabric  files  related  menus  are  under  the  File menu  in  the  main

ArahWeave window.

Figure 20: Fabric file menu

 

3.1 LOADING FILES FROM FABRIC BROWSER

To load a fabric file using Fabric Browser choose File > Load fabric (keyboard shortcut B). Thumbnails of

fabrics are displayed to identify each fabric.

Do one of the following to open the fabric in ArahWeave: double click a fabric icon, or select a fabric

icon and then click OK or press Enter.

Figure 19: Set default path dialog
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If  you set that both, File selection dialog and Fabric browser,  are available, then use File >  Browse to

open the fabric browser.

Figure 21: Icon fabric browser

The meaning of icons in the toolbar is described in the table below.

one directory up

back

forward

reload

default directory

switch to detailed view; switch to icon view

sort order

find fabric

create new directory

rename fabric

delete fabric

open selected fabric with ArahWeave in a new window (middle-click on a fabric icon does

the same)

The options icon menu and filter options are positioned at the bottom of the window.

• Filters (icon ) allow you to narrow down the number of displayed fabric icons  by  entering the

limits of weave size x, weave size y, date of creation, number of shafts, warp and weft yarns, number

of threads in fabric width, warp and weft density, denting and regulator, and file name. If you use the

file name filter, the program will interactively change the display to show you only the fabrics, which

match the search filter. In this way you will find your fabric very quickly.
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• The  sort  drop-down  option  button  allows  you  to  choose  a  criterion,  by

which you want to sort the fabric files.  The default criterion is  the name,

followed by file size, date, weave size in the horizontal direction, weave size

in the vertical  direction, weave size in  both directions,  number of shafts,

number of different yarns used in the warp, number of different yarns used

in the weft, size of warp pattern repeat (number of threats),  size of weft

pattern repeat (number of threats), number of threads in fabric width, warp

density, weft density, number of reed dents in fabric width, and number of

advances (regulator) in weave repeat.

• The Repeat option is  enabled by default.  It  means that the

fabric icon is displayed in continuous repeat; if disabled, then

only one repeat of the fabric is shown.

• Then there are some options to change what is shown in the information below fabric icon: Name,

Size (repeat size of warp and number of yarns in warp; repeat size of weft and number of yarns in

weft; the weave size), Density (warp density; weft density; number of threads in fabric width), Image

(  it displays the size of the image used in Jacquard conversion and used number of colors),  File

size, Date.

• If  you want to check  the  number of  files  and sub-

directories in the directories displayed in the Browse

window, do enable the Show number of files option

.  The  number  of  files  in  the  directory  is

displayed below  the  directory icon, the number of

sub-directories  is  displayed  next  to  the   directory

icon.

Figure 23: Same icon with a repeat
option enabled (left), and disabled.

Figure 22: Menu of
sorting criteria

Figure 24: The number of files in directory and
the number of sub-directories
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3.1.1 FILTERING BY FABRIC FEATURES

You  can narrow  down  the  number  of  displayed  fabric  icons  by  selecting  multiple  fabric  features,

temporarily hiding any fabrics that don't match the criteria. These features are:

•  Fringe

•  Variants

•  Overprint

•  Variable density

•  Regulator

•  Fil coupe

•  Shading

• Wrinkle

• Weft blanket

•  Jacquard conversion

To change the state of the feature icon, you want to filter by, click on it. Icons can have three states:

•  Inactive (grayed out): as a gray checkbox indicates, the icon in this state does nothing.

•  Unchecked: fabrics that don’t contain the feature will be displayed in the fabric browser.

•  Checked: fabrics that contain the feature will be displayed in the fabric browser.

Figure 25: Filter by fabric features: an option may be inactive (grayed out), unchecked
or checked.

3.1.2 USING TOOLTIPS

Position the pointer over an icon, and pause. A tooltip appears, showing

Name, Date of modification, Weave size warp, Weave size weft, Number

of shafts, Density warp, Density weft, Number of threads in fabric width,

Warp repeat, Number of different yarns in the warp, Weft repeat, Number

of  different  yarns  in  the  weft,  Dents  in  denting  repeat,  Advances

(regulator), and File size.

Figure 26: Fabric’s tooltip

3.1.3 BROWSING SUBDIRECTORIES

Arahweave’s browsers have the capability of showing files in subdirectories. It is very useful when you

search for a file, but you don’t know in which directory you have saved it. If there are subdirectories in

your parent directory, then the Fabric browser displays the “leafless tree” icon  in the upper-right

corner of the window (in the same line as a directory path). To display all files from subdirectories, click
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the tree icon. It changes to the “tree with leaves and fruits” icon   , which means that the Fabric

browser shows all  files  from the parent directory  and its  subdirectories.  If  a fabric  was found in  a

subdirectory, then the name of the subdirectory appears in the fabric’s icon.

You should be careful in the use of this option, since it may take a very long time to finish and display

the fabrics if you enable it at the start of your disk (/). The program will not crash, but it must read all

the files on your hard disk, and this takes some time. So only use subdirectory browsing of directories

which actually contain the fabrics.

3.1.4 RECENTLY USED DIRECTORIES

In  Arahweave’s browsers,  the

program  shows  a  small  arrow

with  a  drop-down  menu  of

recently used directories in the

editable  location  bar.  You  can

use this  to quickly  switch from

one directory to another.

3.1.5 BROWSER IN DETAILS VIEW

In Details view mode, a fabric list is represented by a grid containing information about fabrics: Name,

Warp’s  name (code),  Date  of  modification,  Weave size  warp,  Weave size  weft,  Number  of  shafts,

Density warp, Density weft, Number of threads in fabric width, Warp repeat, Number of different yarns

in warp, Weft repeat, Number of different yarns in weft, Dents in denting repeat, Advances (regulator),

and File size. You can sort fabrics by any of these criteria. A column of this property is highlighted in

yellow.

Figure 28: Details fabric browser view

 

3.1.6 DELETING FILES FROM ARAHWEAVE SYSTEM

If you want to delete a fabric file, weave file, or image file, choose File > Browse from ArahWeave, Edit

weave, or the Jacquard conversion window, select a file you want to delete, and press the Delete button

on your keyboard, or click  icon in the toolbar. You will be warned before the file is actually deleted,

but once you do it, there is no way back.

Figure 27: Selecting recently used directory
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3.1.7 RENAMING FILES

You can also rename fabric files from the Browse window: press the left mouse button on the name

below the  fabric’s icon, or  icon in the toolbar. A small window appears and you just type the new

name and press Enter. For the rest of the files, use the file manager.

3.2 LOADING RECENTLY USED FABRICS

ArahWeave remembers recently used files

and  directories.  To  open  one  of  the

recently  used  files,  choose  File >  Load

recent.  Set  the  number  of  recently  used

files in the  Number of recent files field in

Save setup > Appearance. You can also set

the icon size, and either you want detailed

fabric information or not.

3.3 SAVING THE FABRIC

To save a fabric  file, select the  Save fabric function from the  File

menu if you want to save it under  an  existing name, or  the Save

fabric as function if you want to make a fabric with a new name.

All the data relevant to this fabric will be saved, including density,

weave, warp and weft pattern, colors, etc.

The Save fabric dialog also enables you to create a new directory:

click  and enter the name of the new directory.

To generate a filename from the information that you have stored

in  the fabric properties dialog,  click   icon.  Please read more

about the automatic filename creation in Chapter 20.3.1.

To replace the last character or number in the existing filename

with an ascending one, click  icon. For instance, if you click on

it in the Save fabric dialog in Figure 30, the filename will change to

Paisley3.

Figure 30: The Save fabric dialog

Figure 29: Loading recently used files
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3.3.1 HIDING THE SAVE MENU

Some customers work really fast, and sometimes hit  Save instead of

Save as. There is no way back when  a file is overwritten. But, if  you

hide the Save option from the menu list, then this will never happen to

you again.

To  hide  the  Save menu,  open  the  Save  setup window,  click  the

Appearance tab, and mark the Hide save menu button. Figure 31: Hiding the Save
menu

3.4 RELOAD FROM DISK

Function  Reload from disk reloads the current fabric from  the  disk and loses all recent changes. The

keyboard accelerator is  [Ctrl+U].  It  is  useful  when you are experimenting,  mess  up a file beyond

undoing, and just want to quickly get the latest valid state of the file.

3.5 SAVING A FABRIC IN .WIF FORMAT

The WIF format is a simple plain ASCII file format intended for the exchange of weaving files among

different programs. To save fabric in a wif format, you have to write .wif extension to the file name in

the Save fabric as dialog.

Things that WIF lacks (and ArahWeave supports):

• Fabric background color 

• Colorimetry with CIE Lab specified colors (only RGB colors are supported, and only one color - no

distinction between screen and print colors) 

• The concept of repeat 

• Denting 

• Regulator 

• Yarn composition 

• Multicolor yarns 

• Mouliné / mélange / chenille / printed / slub yarns 

• Data necessary  for  fabric  calculation  of  fabric  consumption  (total  number  of  ends  in  the  warp,

selvedges, reed width, finished width, ...) 

• Yarn count

What WIF has (in Arahweave’s implementation) 

• Weave up to 99 shafts 

• Warp and weft pattern 

• Warp and weft colors 

• Warp and weft density (in the form of yarn space) 

• Yarn diameter; each yarn can have its own diameter

4 VIEWING THE FABRIC

The main window of ArahWeave program will always display fabric in a particular view mode and zoom

factor. View mode will determine the quality (and speed) of the simulation, while zoom will permit you

to work with more precision or inspect greater detail of a very dense fabric.

The display area of the fabric always matches the total number of warp threads in the fabric. So it is

quite important to enter this  number correctly.  You set the number of threads in the  Consumption

window (Fabric > Consumption).
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4.1 ZOOM LEVEL

There are six ways to change the zoom level in ArahWeave:

1. Choose the Zoom menu, and click desired zoom level from the list. There are 39 entries from 1:20 to

20:1. 1:8 means 12,5%, 1:1 means 100%, and 1:15 means 1500%.

2. Press key + to zoom in, or press key – to zoom out.

3. Click Zoom-in   or Zoom-out   in the main menu bar. If  you click Zoom 1   program goes

straight to zoom 100%. If Zoom1  is grayed out (inactive), then the zoom is already set to 100%.

4. Press the Ctrl key on the keyboard and roll the mouse wheel up or down.

5. If you press any number from 0-9 on the keyboard, you will change zoom directly to that level (1

means 100%, 6 means 600%, 0 means 1000%).

6. If you press any number from 0-9 + CTRL on the keyboard, you will zoom out fabric view (CTRL + 1

means 10%, CTRL + 5 means 50%). This only works in the simulation view.

4.2 VIEW MODE

There are four possible view modes, and they are always available from the View menu:  Weave [w],

Integer [a], Shaded integer [s], and Simulation [s]. Simulation comes in several quality levels—from 1 to

9. As you increase the level of simulation, the program calculates more points for each screen point

and calculates average color,  and you get more accurate simulations.  In this  way, you can vary the

speed and quality of the simulation according to your computer speed, type of design, and stage of

designing (creative modifications or final preview).

4.2.1 WEAVE VIEW

This view mode shows the weave repeat in black and white. It is useful when you are drawing a new

weave since it is easier to see the errors in the weave repeat. If you enable the Fringe option you can

also see the warp and weft pattern on the bottom and left of the weave.

Figure 32: The weave view of the fabric with fringe

 

4.2.2 INTEGER VIEW

This view mode just shows the fabric in repeat. One pixel (point on the screen) will be used to simulate

one thread. If you choose bigger zoom (200%, 300%) two or more pixels will be used for one thread.

This is the fastest mode and is usually used in the design phase. In all view modes, the fabric simulation

starts from the bottom, in full respect of textile tradition. In the title of the main ArahWeave window,
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you will also find the name of the currently loaded fabric and the size of the repeat in warp and weft,

expressed in the number of threads. If the sizes of weave and warp/weft pattern are not divisible, this

number will be the smallest common denominator of these values. However, the upper limit of repeat

size in threads is 65520 × 65520 threads. If you see this value in the title of the main window, check the

size of the weave and the size of the pattern repeat. Something is probably wrong since they do not

divide each other.

Figure 33: Integer view of the fabric with fringe

 

4.2.3 SHADED INTEGER VIEW

This  mode shows the fabric in the repeat,  but on zoom levels  higher than 300 % adds shadows to

threads, so you can easier see interlacing and distinguish between warp and weft.

Figure 34: Shaded integer view of the fabric with fringe
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4.2.4 SIMULATION VIEW – SETTING THE DENSITY

The Simulation mode shows the fabric in real density with respect to

finished  fabric.  You  must  enter  the  density  for  warp  and  weft,

expressed as the number of threads per centimeter (or inch). To set

density, choose Fabric > Density.

You can set  the density  as  the  number of  threads per centimeter

(inch), or as the size of repeat in cm (inches), for both warp and weft.

Note that only  the number of threads per one cm is saved in  a file;

the repeat size is  calculated from the other data. You can also set

Zoom (%) to any value between 5% and 2000%. The Simulation view

shows the fabric in real 1:1 size, including yarn diameter with holes

(in  background  color,  which  can  be  defined  in  the  Edit  colors

window), if the yarns are thin with respect to density.

Figure 35: Setting the weaving
density

If you activate the Density from technical data button in the upper part of the dialog, then the density is

automatically  calculated from other data, which you enter in the  Calculation of  thread consumption

window (Fabric > Consumption; more about setting the technical data in Chapter 14). The density entry

numeric fields are grayed out to indicate, that you cannot change them in this window.  Density from

technical data must be activated, if you want to have a simulation of variable denting or variable weft

density effect. Otherwise, the fabric will be simulated with single density across the whole fabric. The

reason for this behavior is that a big majority of fabrics will be simple, and all you will need is the warp

and weft densities. Besides, in the design phase, you will not have all the technical details necessary for

the correct automatic calculation of density.

You will be able to see the shades, which are caused by the thread interlace. It is the most accurate and

also the slowest view mode. You have 9 simulation quality levels, each being approximately two times

slower than the previous one. Do not use simulation quality 9, unless you really need it, since it is very

slow. Try simulation quality level 5, and then increase it, until you get a simulation of proper quality.

Figure 36: Simulation view of the fabric
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4.2.5 SETTING THE FABRIC DENSITY UNIT

ArahWeave has an option in the Measurement system section of

the Save setup dialog, to set the Density unit. For example, many

customers like to express density per 10 cm, not in 1 cm, which

is Arahweave’s default. Once you set it,  the program will display all densities in that unit. The Density

unit is also saved in the .arahne configuration file.

4.3 RAISED FINISH SIMULATION

If you want to simulate the raised finish,

activate the  Simulation function from the

Fabric menu. You will be able to enter the

length  of  raising  in  tenths of  mm  for

warp and weft, as well as direction (up /

down / left / right) and intensity (0-10).

You  should  play  a  little  with  these

parameters  to  find  values  that best

represent  the  finishing  that  you  are

actually  using.  The raised finish window

displays the  preview  of  the  selected

effect.  Once  you  are  satisfied  with  the

result, click the OK button, and it will be

applied to the fabric  in the main  display

window.
Figure 38: Raised finish simulation 

4.4 FRINGE VIEW

This option will  enable you to view  the warp and weft patterns on the left and bottom of the main

ArahWeave window. The Fringe option is a toggle button in the View menu, but you can also enable it

from the keyboard by pressing f. It works in all views, but you must scroll the fabric to the left edge and

to  the  bottom to see it. Using this feature, it is easier to graphically see the emerging warp or weft

pattern, as you type it in or draw it with the mouse.

4.5 RULER

When visible,  a  ruler appears along the top and left sides of the main window. Markers  on the ruler

display the  pointer’s position when you move it. To show or hide  the  ruler, choose  View >  Ruler  or

press Ctrl+R on the keyboard. It displays the length and position in threads or in centimeters. To switch

between the two units, click on the ruler unit indication (points, cm) (see Figure  39).  If you want to

have the ruler in inches instead of centimeters, you must change the measurement unit from metric to

imperial  in  ArahWeave’s  Help >  Save  setup.  The ruler  has  also  two functions  which  help  you  find

positions in warp or weft pattern (right-click on ruler positions cursor on that place in thread pattern

editor) and denting or regulator (middle click on ruler position cursor in weave editor in the denting or

regulator fields at that place).

Figure 37: Setting a density unit
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Figure 39: Ruler with unit in threads and centimeters

If there is an image loaded in the Jacquard conversion window, then the ruler has an additional, third

mode: the image preview, which is displayed instead of a ruler. Using this function, it is easy to copy

warp/weft patterns from scanned samples.

Figure 40: Image (scanned fabric) displayed in ruler
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4.6 ONE REPEAT

One repeat fabric view is available from the View menu of the main

window. It  is  most useful  when you are making a blanket,  shawl,

napkin,  or any other one-piece type of fabric.  You will  clearly see

where does the repeat end. One repeat means a repeat of all fabric

parameters:  weave  size,  warp  and  weft pattern,  and

denting/regulator.  If  one  of  them  will  not  divide  the  other,  the

repeat may be larger than you expect.  One  repeat is  both a view

mode and a fabric property. It is saved in the fabric file. This feature

is usually used for one-piece designs, like picture weaving, blankets,

shawls, napkins,  and tablecloths. You can also choose to view one

repeat only in  the  warp, or in  the weft direction. This is useful for

narrow  designs,  where  you  want  them  to  be  repeated  in  one

direction, but not in the other.

Figure 41: One repeat view

4.7 PAN TOOL

To pan the fabric, move it while holding the left mouse button down.

During moving the cursor pointer changes from an open hand  to a

closed hand . You can modify the color of the hand in  Save setup >

Colors by changing  the  RGB values (click the Edit button to open the

Color Editor to specify color). The pan tool is not working, when warp/weft editor, yarn editor, or color

editor are open. In that case, the mouse pointer will be used to draw a warp or weft patterns. If you still

want to use  the  pan tool  with those windows open,  select background color (#)  at the end of  the

warp/weft letters in those editors.

4.8 MODIFIED FILE STATUS

The color of  the square in the bottom right

corner  of  the  main  ArahWeave window

indicates the modified fabric file status. The

square  turns  to  red  from  green  after

applying  some changes in  the fabric (yarn,

color,  weave, technical  data) to the fabric.

When  you  save  the  fabric,  the  square

becomes green again. Figure 43: After change, the square turns to red

4.9 CLOSING ALL POP-UP WINDOWS

The Close windows function from the View menu closes all pop-up windows, so you don’t have to close

them one by one. It serves for quickly cleaning up the desktop if you have too many windows open.

You can also do it by pressing Ctrl+W, or by clicking on the modified file status indicator ( doesn’t matter

if it is red or green).

Figure 42: Changing the mouse
pointer color
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Figure 44: After clicking the file status button only the main window remains open

5 EDITING THE WEAVE

The weave is  the basic element of fabric construction, which controls  the way in which threads will

interlace. A black point means that the warp (vertical thread) will be on top, and a white point means

the weft (horizontal thread) will be on top.

To create a new weave, go to the Weave menu and select Edit. The weave editor window will appear

(right-clicking on the fabric also pops up the weave editor). Place the mouse over the desired point and

use the left mouse button to draw a black point (warp over weft), while the right mouse button is used

to draw white points (actually, to change the black points into white). Pressing and holding the mouse

button enables you to draw interactively. While editing the weave, you can see what the new weave

will look like in the fabric at any time.

5.1 ELEMENTS OF THE WEAVE EDITOR

Figure  45 shows the elements of the Edit weave window (the Dobby view should be enabled,  View >

Dobby; otherwise, only the weave section of the weave editor is visible; see Chapter 5.8.4).

The weave starts in the lower left corner with the first warp and weft threads. The draft is found in the

upper left corner, the dobby card is located on the right, and the tie-up occupies the upper right corner.

On the leftmost part of the weave editor, you see the weft pattern (starting from the bottom), and on

the bottom, the warp pattern (starting from the left). 

A denting is displayed on top of the weave and below the drafting.

A regulator is displayed to the right of the dobby card. 

The variable weft control functions have a place next to the regulator. You have to enable them in the

Density window if you want to use them (see Chapter 14.7.1).
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Figure 45: Weave editor

The small triangles (meant to be arrows) indicate the end of the repeat. They will be displayed for warp

and weft pattern, denting, and regulator, if present.

The  Edit  weave window title displays  some additional  information:  the weave filename, the weave

repeat size in warp and weft, the number of shafts used in this weave (if it is a dobby weave), and the

number of warp and weft thread systems (if different from 1).

If the number of shafts is not minimal, it will display them as 8/6, which means there are 8 shafts, but 

only 6 are really needed. A larger number of shafts is often used in weaving to balance the weight 

(numbers of warp ends per shaft) of the shafts.

The weave editor supports very large weaves; a full jacquard weave can be loaded in ArahWeave. In 

such cases, the program does not show  or drafting. It stops displaying these data when the number of 

shafts exceeds 99. Actually, nobody uses more than 36 shafts, but having up to 99 shafts can be useful 

for editing purposes.
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Figure 46: A Jacquard weave in the weave editor

5.2 SETTING THE WEAVE SIZE

To change the size of the weave, choose Edit > Dimension. You will be able to 

change:

• Repeat—size for warp and weft (maximum 65520 by 65520, minimum 1 by 

1).

• Grid: the number of pixels used for one weave point (we can call it zoom as 

well, as you change it by zooming in and out).

• Thicken—after how many lines should one be thickened to facilitate 

counting (on screen and in print).

• System: the number of threads in the warp and weft (leave it at 1 for single-

layer fabrics). They are meant only for documentation. It shows the user’s 

intent for this weave and does not reflect the real effect of the weave on 

the fabric.

• Shafts—how many shafts you intend to use (do not be disturbed by the 

large value on jacquard weaves; just leave it as it is).

Figure 47: Setting the
dimensions of the

weave

You can freely change these values; you will not lose the previously entered data if you diminish the

weave to something smaller than what you have previously drawn. Just enlarge it again, and it will be

where  you  left  it.  The  size  of  the  weave  will  change  interactively  if  you  use  the  arrow  buttons.

Otherwise, you have to click the OK button to apply the new settings.
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5.2.1 SETTING THE WEAVE SIZE WITH THE MOUSE

You  can  change  the  weave  size  using  the

middle  mouse  button  by  clicking  on  the

weave control row and column at the desired

position. For instance, if you want to set the

size of the weave repeat to 16 by 8, just click

with the middle button the 16th point of the

weave control  row and  the 8th point  of  the

weave control  column (in  Figure  48,  arrows

indicate the weave control row and column;

the 8th and 16th points are marked with X).

5.3 WEAVE EDITOR TOOLBAR

The toolbox is in the upper-left corner of the weave editor. It contains 28

icons, most of which are self-explanatory. When you make any change to

the weave,  either by  drawing or  by  using  these tools,  the result  will  be

immediately visible on fabric in the main window if you are in integer view.

If  you are in  simulation view,  you will  have to apply the changes to the

weave (click Redraw  )  to see the result.  If  there is  a selection in  the

weave, tools work only on the selection.

Clear weave Tilt right (transforms vertical line to right diagonal)

Horizontal mirror Tilt left (transforms vertical line to left diagonal)

Vertical mirror Tilt up

Rotate 90 degrees Tilt down

Shift left by 8 Shift right by 8

Shift up by 8 Shift down by 8

Shift down by 1 Shift right by 1

Shift up by 1 Shift left by 1

Add warp (black) points Redraw (refresh) a fabric simulation

Remove warp (black) points Invert (shortcut is the Space key)

Match weave size to warp pattern Undo

Match weave size to weft pattern Redo

Draw twill (diagonal) Deactivate selection

Lock drafting Edit decomposed

Copy Paste

Figure 49: Tool-box of the
weave editor

Figure 48: Setting the weave size with mouse
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5.3.1 SHIFTING THE WEAVE

As the name indicates, clicking one of the shifting icons shifts the weave in the desired directions for

one (single arrow) or eight pixels (double arrow).

Shift left by 8 Shift right by 8

Shift up by 8 Shift down by 8

Shift down by 1 Shift right by 1

Shift up by 1 Shift left by 1

5.3.2 TILTING THE WEAVE

The tilt tool shifts every next line (or column) of the weave for one thread in the desired direction. The

most common use is for the fast creation of satin weaves.

Tilt  right  (transforms  vertical  line  to  right

diagonal)

Tilt  left  (transforms  vertical  line  to  left

diagonal)

Tilt up

Tilt down

5.3.3 ADDING AND REMOVING POINTS

The Add tool adds one point to the right of the already-black point. You can keep pressing it until you

get the desired result. The Remove tool works similarly; it removes the black (warp) point to the left of

the white point.  Both tools  are useful  for quickly  converting warp weaves to weft weaves and vice

versa.

Figure 52: Adding or removing points
 

5.3.4 DRAWING DIAGONAL LINE (TWILL)
This tool enables you to draw a twill weave with one click. Actually, it negates the color of points, which

form a diagonal line. If the initial weave size is not square, it continues to draw a diagonal line until it

reaches the edge (last thread) of the weave. The tool works best in combination with the adding and

removing points described in the previous chapter.

Figure 51: Original image, tilting one
time, and tilting three times to the right

Figure 50: Original
weave, and weave

shifted by two to the
right
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Figure 53: Drawing a diagonal

5.4 OPENING WEAVES FROM THE LOAD WEAVE DIALOG

You can open a weave in weave editor from the Load weave dialog  (File >  Load weave).  The dialog

enables you sorting weaves by name, size or date. You can delete or rename a file by clicking with right

mouse button the filename, which opens the menu, where you select either Delete or rename.

Besides Arahne’s proprietary weave format, ArahWeave also loads GIF, PNG, JPG, PCX, BMP, and TIFF

formats, as well as electronic jacquard formats (Bonas, Grosse, Schleicher, Stäubli, TIS/Actrom, Müller

UPT)  and  some dobby  formats.  The exceptions  are  Stäubli  JC3  and JC4,  so  we have implemented

function  Read Jacquard floppy in the  Weave menu of main window, which copies them to Linux (to

directory /tmp/floppy).

Figure 54: The load weave dialog  

5.5 OPENING WEAVES FROM THE WEAVE BROWSER

More convenient way to open a weave is using a graphical weave browser. To open the weave browser,

choose File > Browse (keyboard ALT+B) in the Edit weave window's menu. The program will  display all

the weaves from the current weave directory. The window title shows the total number of weaves.
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Figure 55: Weave browser

 

The meaning of icons in the toolbar is described in the table below.

one directory up

back

forward

reload

default directory

find weave

create new directory

rename weave

delete weave

The Filter option allows you to search for a particular weave by weave size x,  weave size y,  number of

shafts, effect (warp or weft), float x, float y, total float, K factor x, K factor y, K factor xy. If you use the

file name filter, the program will interactively change the display to show you only the weaves, which

match the search filter.

You can toggle the Grid size (number of screen pixels) from 1 to 4. The Size of area reserved for display

of one weave is also modifiable – you can choose between 30, 40, 50 and 60 weave points. Your view

of weaves can have an indication of repeat, can be in black and white or in warp / weft colors, and can

have the weave filename and size in the title (Label). To load a weave just double click on it or click the

OK button.
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5.5.1 SHRINK OVERSIZED OPTION

When weave is  big the icon display area becomes too small  for

clear  weave  presentation.  Weave  browser  has  an  additional

display mode: the  Shrink oversized mode. In this mode, browser

scales big weaves, so you get a clearer idea about the weave. To

enable the Shrink oversized mode, switch on  icon. Figure 56

shows the icon of the same weave in the default view mode, and

in the Shrink oversized view mode. Figure 56: Shrink oversized view
disabled and enabled on a large

weave

5.5.2 BROWSING SUBDIRECTORIES

Arahweave’s browsers have the capability of showing files in subdirectories. It is very useful when you

search for a file, but you don’t know in which directory it is. If there are subdirectories in your parent

directory, then the Weave browser displays the “leafless tree” icon  in the upper right corner of the

window (in the same line as a directory path). To display all files from subdirectories, click the tree icon.

It changes to the “tree with leaves and fruits” icon  , which means, that the Weave browser shows

all files from the parent directory and its subdirectories. If the weave is from the subdirectory, then the

name of subdirectory appears in the weave icon.

You should be careful in the use of this option, since it may take a very long time to finish and display

the weaves, if you enable it at the start of your disk (/). The program will not crash, but it must read all

the files on your hard disk, and this takes some time. So only use a subdirectory browsing on directories

which actually contain the weaves.

5.5.3 RECENTLY USED DIRECTORIES

In Arahweave’s browsers, in the directory entry text field, the program shows a small arrow with a drop

down menu of  recently  used directories.  You can use this  to quickly  switch from one directory  to

another.

Figure 57: Weave browser's recently used directories list  

5.5.4 DATABASE OF WEAVES

A  huge  database  of  about  35.000  weaves  in  the  directories  Ashenhurst,  Donat,  Serrure,  Gunetti,

Fressinet and Poma is included in the standard ArahWeave installation.

5.6 SAVING A WEAVE

Choose File > Save weave as to save a weave with a new filename.
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Please  note  that  a  weave  must  be

consistent  if  you  want  to  save  it.  In  the

case of  shaft weaves, this means that  the

weave, drafting, and card (peg-plan) must

all  be  in  place  and  correspond  to  each

other.  The  program  always  checks the

weave before saving  and will draw a draft

and  card from  the  weave  if  they  are

incorrect or missing. But if you draw only a

dobby  card  (peg-plan) while  draft  and

weave  are  empty,  it  will  clear  the  card

during saving.

Normally  you  save  the  weave  in  Arahne

format,  but  f  you  need  to  export  the

weave  to  some  other  program,  you  can

use one of these formats:  WIF,  PNG,  TIFF,

GIF,  BMP,  Bonas EP,  Grosse  WEA,  Stäubli

JC4, Stäubli JC5, Müller UPT. Choose the

format  for saving  in  the  Save  weave

window from a drop-down menu.

Figure 58: Choosing a weave format

5.6.1 LOADING RECENTLY USED WEAVES

ArahWeave keeps  track  of  recently

accessed files and directories. To open

one of  the recently used files, choose

File >  Load recent. Set the number of

recently  used  files  in  the  Number  of

recent  files field  in  Save  setup >

Appearance.  Additionally,  you  may

choose the icon size  and whether or

not  you  want  specific  details  about

the weave. 

Figure 59: Loading recently used files
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5.7 DEFAULT WEAVES

Some of the most common weaves can be found in a list under File > Load

Default. However, using keyboard shortcuts, which are simply the number

keys  from 1 to 9,  makes the function much more useful.  For example,

pressing 2 on a keyboard (while the weave editor window is focused) will

change the weave to plain weave.

The same is true for:

• The weave editor's decomposed weave

• the weave entering area in the Jacquard conversion window.

• the  weave (selvage)  entering  area in  the Save  cards  for  production

window.

0 1 2 3 4 5 6 7 8 9

Figure 60: Weaves and corresponding keyboard shortcuts

Here's another keyboard shortcut to go along with the weaves keyboard

shortcuts: the Space key inverts weave in the weave editor; for example,

if  you want the warp effect satin 5 weave, simply press 5 and then the

Space key to invert the weft effect into the warp effect. 

Figure 61: Loading default
weaves

5.8 WEAVE EDITOR VIEW MODES

5.8.1 YARN

If  you  enable  the  Yarn  colors toggle

button from the  View menu, the weave

will be displayed in warp and weft colors.

On  the  card,  weft  points  are  drawn  in

weft  colors,  while  warp  points  remain

black.  Other  elements  of  the weave

remain unchanged.

Figure 62: Yarn colors view mode

5.8.2 JACQUARD

Jacquard colors is  an  additional view of weave in  the  weave editor. You can access it from the  View

menu of the weave editor. It is intended for use in jacquard design when you are fixing the long floats

and want to be able to precisely see the transition between two colors. If you only see the weave in

black and white, you cannot see the exact transition from one weave effect to another, since weaves
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are sometimes similar.  This  view is  enabled only if  the  jacquard weave size  in jacquard conversion

matches the weave size. This view mode also works with a decomposed weave view.

Figure 63: Jacquard colors view mode; you can see the weave of each color

5.8.3 REGULATOR VIEW

The  Regulator  view helps  you  distinguish  between “normal”  and  extra  wefts.  It  is  useful  on  large

Jacquard  weaves,  especially  if  you  want  to  draw  some  regulator  control  marks  manually  (with  a

mouse). Warp points of the extra weft are drawn in blue, while weft points are drawn in yellow.

Figure 64: Normal weave view and regulator view mode   

5.8.4 DOBBY VIEW

The dobby view enables you to switch the dobby card on

or off, since sometimes you do not wish to be disturbed

by  it.  For  example,  customers  who only  have  jacquard

looms don’t need to look at the dobby card and drafting.

Figure 65: Dobby view on and off

5.8.5 CROSS SECTION VIEW

You can also enable the display of horizontal and vertical cross sections. The cross section is interactive

—it shows you the cut at the current mouse position. You can draw over the cross section with the

mouse to change the position of threads, and the weave will be modified accordingly.
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Figure 66: Cross section in the weave editor

 

To control a number of threads in the cross section at a time, set the System parameter in the Change

weave dimension window (Figure 67).

5.8.6 DECOMPOSED COLORS VIEW

The  Decomposed  colors view mode is  a great tool  for  composing  multilayer  weaves,  especially  for

placing  the  stitching  points  between  the  fabric  layers.  Each  layer  has  a  different  color  pair  for

presenting  warp  and  weft  points,  which  enables  faster  and  more  accurate  placement  of  stitching

points.

Figure 68: Default view and Decomposed colors view

 

Figure 67: Setting the weave
System
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5.9 THE EDIT MENU

The edit menu contains some usual commands like Undo, Redo,

Select all,  Crop,  Copy,  Paste, and some nonstandard commands

relating  to  the  manipulation  of  weaves,  like  functions  that

change the weave size or fix floats.

Figure 69: The Edit menu

5.9.1 EXTENDING THE WEAVE

To repeat (extend) the whole weave, choose Edit > Extend weave. In the Extend weave dialog, set the

number of repeats that you want to have in a new weave. As you change the number of repeats, the

program extends the weave. You can observe the final repeat size in the title bar of the weave editor.

Figure 70: Extending the weave in a quick way
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5.9.2 DOUBLING THE WEAVE SIZE IN WARP / WEFT

The Double weave size in warp (or

weft)  function is  another way to

increase  the  size  of  the  repeat.

Each time you call it, the size will

double the previous value.

The  downside  of  doubling  the

weave  size  is,  that  it  probably

won’t  give  you  exactly  the  size

you want so you must first make a

bigger one and then reduce it  to

the desired one.

Figure 71: The Double weave size in warp and Double weave size in
weft menu  

5.9.3 EXTEND A WEAVE ACROSS THE WEAVE EDITOR AREA

This function allows you to extend the weave that you just drew in the weave editor's part across the

entire area of the weave editor. To do so, hold down the Ctrl key and click the left mouse button in the

upper left corner of the area you want to copy over.

Figure 72: Extending the weave with Ctrl+left click on the left upper point of the area, that you want to
extend

This function also works in the Edit decomposed weave editor.

5.9.4 COPY / PASTE

You can use copy/paste of  the weave inside one instance of  the ArahWeave,  or  between multiple

programs, including ArahPaint.

If you use the copy command (Edit >  Copy; Ctrl+c;   in the toolbox) and there is no selection in the

weave editor, then the whole weave is put into the copy buffer (clipboard).  Same happens with the

paste:  if  there is  no selection in  the weave editor,  then the paste (Edit >  Paste;  Ctrl+v;   in  the

toolbox) replaces the whole content with a clipboard item; if there is a selection, then the program puts

it only in the selected area of the weave.

The copy/paste also works between the weave editor and Jacquard conversion.
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5.10 LONG FLOATS: STATISTICS AND CORRECTION (JACQUARD)
The maximal length of floats—that is, how many warp (weft) threads one weft (warp) thread passes

without  interruption  (stitch  point)—is  one  of  the most  important  weave properties.  There  are  no

golden rules for these—it all depends on the density and the purpose of the fabric.

Usually you will only remove long floats in jacquard fabrics; dobby weaves are relatively simple, so long

floats are not an issue. In any case, reviewing long float reports can be very instructive. Why do we

have problems with long floats in jacquard but not in dobby? In jacquard, we are putting together many

weaves;  each of  them is  probably  perfect,  but  at  their  junctions  (the point  where one weave will

change into another), long floats are almost certain to pop up.

The quality of weave selection and the resulting number of long floats depend a lot on the experience

of the designer. You can use the long float report as an early warning: something could be wrong with

your weave selection if you have many long floats. You can also use the automatic float correction, but

do not overuse it. If there are a significant number of long floats, you should reconsider your design

and weaves.

To enable long float report, choose Float from the Edit menu. You will see a window with a separate

graphical report of float length for the warp, weft, face, and back of the fabric. You may need to resize

the window to see all the data. If there is enough space, the program will display the exact number of

floats of length 1, length 2, length 3, etc. To see how many floats of warp are longer than 5, just click on

column 5 or set the number 5 in the Warp Face field, and the program will sum up the total number of

long floats and display them in red in the relative upper right corner. Besides, it will also display the

length of float over 5 threads in mm, according to the current density setting.

Figure 73: Correcting long floats: warp floats longer than 6 are displayed in red, weft floats longer than
10 are displayed in pink.

 

By selecting the float report, you can specify the acceptable float length. To see the location of errors,

toggle the Mark long floats toggle button. Warp long float errors will be highlighted in magenta, while

weft float errors will be highlighted in red.

Long-float errors are displayed in the Edit weave window and, if the view mode is Weave or Integer, in

the main fabric display window as well. Negate  the weave or reverse (Fabric > Reverse X) the fabric

to see the long floats on the back side. You can intervene directly on the weave and correct the long
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floats as if you were drawing a weave, or in the fabric main window, using the middle mouse button.

The statistics of the long floats are updated interactively. Do not keep the float errors marked or the

float  report  window mapped when you  do  not  need it,  since  it  will  significantly  slow down some

interactive operations on large designs.

If  the weave is  very large and you cannot find the location of  the float error(s),  just  click the  Find

button. It will scroll the weave window to the location of the first float error on the bottom left. To go

to the next float error, correct the first one and click Find again.

A  float report  can be mapped even if  the weave window is  not  mapped.  It  can be made in  three

variations (for both warp and weft): total, by threads, and by denting or regulator. This allows you to

treat floats of different thread types separately. For example, you have some ground effect threads and

some extra figuring wefts. You can allow longer floats for figuring wefts and short floats for ground

weave.

To automatically remove long floats, click the Remove button. This function will only work if long floats

are marked, and it will correct only errors on the face of the fabric. To correct them on the back of the

fabric, you can reverse the fabric or choose Fix float face and back from the Edit menu in the Edit weave

window. Sometimes, it can't correct all of the errors since, by correcting the error on the warp, it may

create an error in the weft.

Last, but not least, if you make a mistake by clicking Remove when you did not mean it, click Undo 

in the toolbox.

5.10.1 CORRECTING LONG FLOATS IN FIL COUPÉ FABRICS

Fil coupé literally means "cut threads" in French. This weaving technique produces an interesting fringe

effect on the surface of the fabric. Extra weft yarns are floating between motifs and will be later cut off.

If we apply the long float correction to these wefts, the floated yarns will be connected to the ground

fabric, and this would prevent cutting off the threads from woven fabric. So we have to tell the program

that this is a fil coupé fabric and that these long floats between motifs shouldn’t be tied to the ground

fabric. How do I do this? Select Fabric > Simulation and check the Fil coupé box. Set the Coupe length.

The floats that are longer than the Coupe length number will not be corrected.

Figure 74: Setting the coupe length; wefts floats,
floating over 70 warp threads will not be

corrected.  

5.11 DRAFTING

A draft determines which shaft controls  which warp threads  (the terms leaves,  cambs,  staves,  and

healds are synonymous with shafts). The number of shafts used depends on the complexity of the

weave.
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There are two modes of drawing drafting points:

• Left mouse button click draws a draft point and copies corresponding “shaft points” from the card

into the weave.

• Middle mouse button click draws a draft point and copies corresponding “warp points” from  the

weave into the card.

You can access the draft-constructing functions through the Dobby menu of the Weave editor.

5.11.1 OPTIMIZING THE NUMBER OF SHAFTS

After you have drawn a weave, the fastest way to draw a draft is using Change > Optimize the number of

shafts > Left (or Right). Left means that the program starts to draw shafts from left, right means that it

starts to draw from the right side of the weave.

If you intend to save the weave with the least possible number of shafts, then you don’t need to apply

the Optimize the number of shafts—the program does it automatically prior saving if there is no draft in

the weaving plan.

5.11.2 HEAVY SHAFTS FIRST (DOBBY)
This function is available from Dobby >  Check weave menu. It puts the heavy shafts to first shafts. In

this way, the selvedge shafts, if entered in the design manually, will appear last, as usual. On normal

weave optimization, they would appear first, since they are at the left edge.

5.11.3 LOADING AND SAVING DRAFTS

You can save or load any draft from the File menu in the  Edit weave window. It is useful, when you

want to apply a complex draft from one weave to another.

5.11.4 BALANCING THE WEIGHT OF SHAFTS

In practice, it is sometimes better to use more shafts than the least possible number, mainly because of

the high number of warp threads.

Figure  75 shows  weave  with  6-shaft  draft.  The  information  in  the  Consumption window  (Fabric >

Consumption) tells us that first two shafts carry 1600 threads each. We think that this is too many, so

we have to divide threads from first two shafts to two additional shafts. Choose Check weave > Balance

the weight of shafts. Change Desired number of shafts to 8. The program draws a new draft and updates

a number of heddles per shaft.

Figure 75: Changing from 6 shaft draft to 8 shaft draft
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5.11.5 POINTED DRAFTING

If your weave will be vertically mirrored, you can draw just half of the weave and apply  the function

Drafting >  Pointed >  Add  from the  Dobby menu.  ArahWeave automatically  expands and mirrors the

weave in horizontal  direction.  The program will  also draw the drafting,  while the number of shafts

remains unchanged. Note that first and last warps are not mirrored, to avoid two adjacent warps with

equal weave. If the width of your weave is 10 prior to calling this function, it will become 18. If you

change your mind, click Drafting > Pointed > Remove.

Figure 76: Before and after applying Add pointed drafting

 

This function is located in the  Dobby menu, but can be of great use in a jacquard. To overcome the

limited number of jacquard hooks, weavers will often use pointed harness arrangement, to effectively

double the size the weave. To produce such a fabric, only half of the weave is necessary, and it is a

good practice to draw only  half  of  the color  image,  to  reduce its  size.  But  if  we want  to  make a

simulation of the fabric, we would like to see it mirrored in repeat, as it will be really woven. Using this

function, it is a snap to switch between the two view modes for such fabrics.

5.11.6 DIVIDED DRAFT (DOBBY)
Automatic step 2,3,4,5 drafting is available from the Dobby >  Drafting >  Step menu. Step 2 would be

normally called divided draft, and step 3 or 4 would be satin draft, depending on the size of the weave.

5.11.7 REDUCING THE NUMBER OF SHAFTS (DOBBY)
If  the  number  of  shafts in  the  particular

draft exceeds the number of shafts on your

loom,  you have one more possibility—you

can  make  a  small  change  in  the  weave,

which  will  enable  further  reduction  of

number of shafts. First you should optimize

the  number  of  shafts,  and  then  choose

Dobby >  Check  weave >  Suggest  shaft

merge.  Program finds  the two shafts  that

are  the  most  similar,  and  draws  a  red

rectangle  around  these  two  shafts,  and

indicates  the  points  of  difference  in  the

weave. If the changes which are necessary,

to  make  the  two  shafts  equal,  are

acceptable  for  you,  just  click  them,  and

optimize the number of shafts again. If you

have reached the desired number of shafts,

you  have  solved  the  problem,  otherwise

repeat these two steps.

Figure 77: Suggestion to merge two shafts
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5.11.8 NUMERIC DRAFTING

Choose  Dobby >  Numeric  drafting to  enter

drafting  as  numbers,  write  the  drafting,  and

after  pressing  the  OK button,  the  program

draws  drafting  as  you  wrote  it.  The  weave in

Figure 78 has eight repeats of shafts 1, 2, 3, 4,

then five repeats of shafts 5, 6, 7, 8, and again

six repeats of shafts 1, 2, 3, 4.

Figure 78: Numeric drafting

5.12 DENTING

Both the wires and the slots in the reed are known as dents (namely, teeth). The warp threads pass

through the dents after going through the heddles and before becoming woven cloth. The number of

dents per centimeter or inch determines the fineness of the reed. The number of warp threads that go

through each dent depends on the warp. Usually, there is the same number of threads in each dent,

and denting is simply written 2 or 3 or 4 or 5..., where number means the number of threads per dent. 

There are some types of fabrics, however, which require an irregular order of denting to emphasize a

certain design feature. Irregular means that the number of threads in each dent is not constant for a

whole warp. In such cases the order of arrangement of the ends in the reed becomes an essential part

of the design and must be indicated carefully and in the correct relationship in respect of the weave

and the draft.

To determine the denting data, enter them either in the Denting (dents/cm) field of the Weave Editor

(Weave > Edit), or in the field of the same name, located in the Calculation of the thread consumption

window (Fabric >  Consumption). You can use parenthesis in the denting pattern like: 2 2 10(3) which

will expand to: 2 2 3 3 3 3 3 3 3 3 3 3. You can have several different dents within repeat section, like 2

2 7(1 2 3). ArahWeave supports up to 125 threads in one dent.

Figure 79: Entering denting in the Calculation of thread consumption window or in the Edit weave window

5.12.1 EMPTY DENTS

To mark an empty dent enter 0 in the denting pattern. A green line and a number in the Weave editor

indicate a position of empty dent(s) (see Figure  80).  Important note: a fabric in  ArahWeave cannot

start on an empty dent (so the first dent should not be 0 (zero)).



42    C hap t er  5   
 E di t in g t he  w eave

www.arahne.si  

Figure 80: Empty dents in the denting pattern

A weave with empty dents in the denting pattern looks slightly different on a printout as it does in the

Weave editor. Empty space in the weave area and dents in a green color indicate empty dents (Figure

81).

Figure 81: Printout of a weave with empty dents

 

To get a proper fabric simulation of fabric with empty dents, you need to set technical data ( Threads in

fabric  width,  Reed  width,  Finished  width,  Denting,  Weft  density)  in  the  Calculation  of  thread

consumption window (Fabric > Consumption), and mark the Density from technical data check box. For a

detailed explanation about Consumption and setting the technical data see Chapter 14.

Figure 82: Simulation of fabric with empty dents 

Denting and regulator are handled in a different way in weave editor, in spite of the fact that they can

be both entered in the Edit weave window in the same way. The reason is, that a regulator is directly

linked to the weave, since it must be present on the dobby (or jacquard) card or machine file.
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The  denting,  on  the other  hand,  is  not  directly  linked  to  the weave.  Its  repeat  can be longer,  as

demonstrated in Figure 83, where the weave repeat is 8 threads and the denting repeat is 50 threads in

30 dents.

Figure 83: Fabric with denting

5.12.2 DRAWING DENTING WITH A MOUSE

You can draw denting with mouse in the Edit weave window. As you draw, the denting in the Denting

field is automatically rewritten.

To add a thread in a dent, left-click on the dent. To remove a thread from the dent, right-click on it

(Figure 84).

Figure 84: Adding or deleting threads from dent: left click on a dent adds one thread in it (center
image), right click takes out one thread (right image)

 

To add a dent (actually duplicate existing one) in a denting pattern, left-click below it. To remove a dent

from denting, right-click below it (Figure 85).

Figure 85: Adding or deleting dents: left click below dent (red area) duplicates dent (center
image), right click deletes dent (right image)

 

5.12.3 DOBBY AND JACQUARD

Some looms have both lifting mechanisms, dobby and jacquard. Dobby threads pass through heddles,

which are held and lifted by shafts,  Jacquard part of  warp ends are lifted by hooks.  To distinguish

between threads, which are lifted by dobby (shafts), and threads, lifted by jacquard (hooks), mark the

dents, where the jacquard warp ends are, with a negative number. “Jacquard dents” are indicated by

gray color in the Weave editor (see Figure 82).
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Figure 86: "Dobby" and "Jacquard" dents

5.13 REGULATOR

Looms advance (take-up) the fabric after each weft insertion. Sometimes we need to stop automatic

advance on certain wefts, so that two or more weft threads can be inserted during one advance. When

we do this, we use the regulation stop (regulator).

In ArahWeave, a regulator has the same format of entry as denting. If you do not use the regulator, just

leave it at 1, or even empty. You can use parentheses in the regulator like: 2 2 10(3) which will expand

to: 2 2 3 3 3 3 3 3 3 3 3 3.  Fabric cannot start with  an  active regulator  on the first weft thread.

Maximal  number consecutive wefts  with  regulator  active is  125  (that is  1  normal  thread plus  124

crammed, or in other words, 1 advance of warp beam and 124 wefts without advance).
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Figure 87: You can edit the regulator (also called stop-motion, extra weft, or lancé) on the right side of the
weave editor or parametrically at the top of the window in the regulator text field.

In the regulator we don’t use 0 for marking weaving without weft (fringe). Instead we use y in the weft

pattern. 

The repeat size of the regulator should not be

bigger  than  the  weave  height;  if  it  is  longer

than the weave height, then the weave height

must  be  enlarged  accordingly.  The  program

gives  you  a  warning  if  your  regulator  pattern

does  not  divide  the  height  of  the  weave  –  it

draws the regulator field in red. If it divides, the

regulator  field  is  green.  Figure  88 shows  a

weave, which has the repeat of 24 weft threads,

but regulator repeat is 22 threads (sixteen plus

six (16(1)  3(2)).  The sizes are not the same, so

the regulator field is displayed in red color.

Figure 88: Repeat size of the regulator may be
different than size of weave - red field warning
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5.13.1 DRAWING REGULATOR WITH A MOUSE

You  can  also  draw  the  regulator  control  points

with mouse in the regulator control column in the

weave editor (see Figure 89). Every time you draw

a  point  in  regulator,  the  program  writes  the

regulator pattern for the full height of the weave.

If  you  have  written  the  regulator  pattern  which

does not divide the height of the weave, just draw

one  point  of  regulator  in  the  weave,  and  then

delete it  again.  This  will  make the height  of  the

regulator the same as the height of the weave.

5.14 THE TOOLS MENU

In the Tools menu you can find advanced weave editing functions, which can be used both on dobby or

jacquard fabrics.

5.14.1 EDITING DECOMPOSED

5.14.1.1 BASICS

ArahWeave has a special function for constructing multiple layer (double) weaves; you specify basic

weaves for  each  warp  against  each weft  and  the program automatically  constructs  the composite

weave. This function is available as a special pop-up window in the weave editor. To open it, choose

Tools > Edit decomposed.

In the Edit decomposed window you have to specify the number of warps (Warp layout), and number of

wefts (Weft layout).  The default mode for both Warp and weft layout is the Custom mode, where you

simply enter the number of warp and weft layers. The weave area is split into a “weave table”, where

the number of columns is  the number of warps, and the number of rows is the number of wefts. The

table on the right side of the tool bar is just a smaller presentation of the “weave table”, and serves as

a tool for selecting and copying weaves (very useful when the weave is bigger than screen size), and

also indicates with  a grid  in  red color,  which weave is  selected.  Tools  in  the tool  bar work on the

selected weave. Same as in Weave editor you can load weaves to the Edit decomposed window: choose

File >  Browse, double click on the weave you want to use, and it will load into  the selected area. To

copy a weave into another area, select it with the left button, and click with the right button in the area

where you want to copy it.

Figure  90 shows a weave created of  five warps and three wefts.  The currently  selected weave is  a

combination of the third warp and first weft. The selected weave size and warp/weft combination are

indicated on the window title bar.

Figure 89: The regulator control column
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Figure 90: Edit decomposed window
 

Figure  91 shows a weave with  1  warp

and 3 wefts, with 5-satin on top and 5-

satin  on  back  for  attachment  of  the

second  weft,  and  10-satin  for

attachment of third weft.

Figure 91: Edit decomposed window and the resulting weave in
the Weave editor

5.14.1.2 ADVANCED WARP AND WEFT LAYOUTS

CUSTOM

You can edit even more complicated composed weaves, for instance those with different densities of

top and bottom fabrics. Figure 92 shows a special double fabric with uneven top and bottom density,

plus an extra weft which is hidden in the middle and just links the two fabrics together. The warp layout

is simple: 112—this means that the first two warp ends go in  the first block, and the third warp end

goes into the second block. In this way we have two times higher density in warp. Weft is similar, just

that we need to repeat the layout until the end, so we can add the third block for extra hidden thread:

1121121121121121121121123; can also be written as 8(2a1b)1c.

We enter elongated twill for the top fabric, and regular 2/2 twill for back fabric. The middle weft thread

(shown in red) has just two points which link it to the top and to the bottom fabric. Note that the fabric

simulation in the lower left angle does not show any threads from the back (gray) or middle (red), since

they are completely covered by the top fabric (black weft and dark blue warp).
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Figure 92: Edit decomposed - different density in layers

 

WARP LAYOUT AS A DENTING; WEFT LAYOUT AS A REGULATOR

Sometimes you want to change (or simply check) extra warp weave, extra weft weave or the ground

weave.  The task  can be difficult  since the extra weave is  discontinued by  ground weave (and vice

versa). But if you choose Denting instead of Custom in the Warp layout (or Regulator in the Weft layout

field) the program divides weave on the ground weave and extra threads weave.

LAYOUT AS A THREAD PATTERN

In many fabrics the warp and weft layout is equal to thread pattern. If this is

your case instead of typing custom layout, just select Yarns from the drop-

down menu.

USING MORE THAN 9 BLOCKS IN WEAVE CONSTRUCTION

In the decomposed weave editor, some advanced users want to work with more than 9 weave blocks.

This is not possible if you are using numbers 1-9 as a layer indication.

But there are two ways to enter more than nine layers:

• Using the layout by yarns, instead of custom. Then, you can use more than 9 yarns and in this way

you achieve more than 9 weave blocks.

• Writing the custom layout as a pattern (for example 2a2b2c), instead of with numbers (112233).

If you use the pattern, you can again use more than 9 letters and thus get a bigger layout.

5.14.1.3 RESIZE TO DIVISIBLE

If  you  make the combinations  of  weaves,  which  have different  repeat  size,  and  you  use  different

densities in layers (like two threads on the top and one thread at the back), it is quite complicated to

calculate the correct repeat size of the composed weave, but there is ArahWeave tool which calculates

the final size from the warp and weft layouts and sizes of each individual weave. 

There are two different approaches on how to use the Resize to divisible tool:

• USING RESIZE TO DIVISIBLE AS ONE-TIME OPERATION

Clicking the Resize to divisible entry in the Tools menu checks the size and if necessary, redraw the

final weave to match the calculated size.

Figure 93: Layout as a
thread pattern
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Figure 94 shows a double weave with twill on face and plain weave on back. For two threads on the

face there is only one on the back (layout is 112). Set the size of the final weave to 12 by 12, to be

sure that we have enough space for twill and plain weave. Then draw or load the weaves into the

decomposed weave editor. The area for twill weave is 8 by 8 points: this is obviously wrong, because

the repeat size of twill is 3 by 3, and 8 is not divisible by 3.

Figure 94: Editing compound weave with twill on face and plain weave on
back: notice the mistake in weave repeat in background

 

At this point choose Tools > Resize to divisible. Program resizes and extends the weave automatically.

We get a new total repeat size 18 by 18 points;  the selected twill area is now 12 by 12 points. If  a

smaller repeat would be adequate, the program would also shrink the weave.

Figure 95: Similar weave as above, but now it is divisible; the weave in the
background is now correct

 

• USING RESIZE TO DIVISIBLE FUNCTION ON THE FLY

If you check the checkbox next to Resize to divisible  on the right side of the menubar, the Resize

to divisible function is automatically applied after every change in the edit decomposed window.

5.14.1.4 EXTENDING WEAVES WITH CTRL+LEFT CLICK (OR MIDDLE MOUSE BUTTON CLICK)
In  decomposed  weave editor,  you  cannot  select  and copy  the area with  middle  mouse button (or

Shift+left click) like in the main weave editor. But there is a function on a middle mouse button (or

Ctrl+left click), which helps you copy (extend) the weave across the whole sub-section. Just draw one

repeat of the weave, and click with the middle mouse button (or Ctrl+left click) on the upper right point

of the drawn weave repeat, and this repeat will be copied across the whole weave sub-section in the

decomposed weave editor.
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Figures from  96 to  98 show  how to draw a combination of satin-16 and twill-4,  one warp and two

wefts. Since the satin repeat is  16×16, and twill  is  4×4, the composed size is  16×32. Set the size in

weave editor to 16 by 32, open the Edit decomposed editor, set the Weft layout to 2 (or if you have two

colors in weft you can select Yarns as a type of Weft layout). Draw the twill repeat in the upper section,

and just one point in the lower section.  Press Ctrl and click with the left mouse button in the upper

right point of the area that you want to copy across the section.

Figure 96: Extending weaves wit middle mouse button click (or Ctrl+left click)

 

Now you need to press  icon three times to tilt each point of the straight line for one point to the left

to get satin 16 weave.

Figure 97: Extended weaves

 

Figure 98 shows compound weave with satin on the face, and twill on the back of the fabric.
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Figure 98: Final weave

 

5.14.2 SELECT/COPY AREA

Often we want to limit the area of the operation to a specific part of the weave. By selecting a particular

rectangular region, you set the boundaries of the operation. You can also save a selection as a weave,

just use File >  Save weave, and the saved weave will be the selection, and not the whole weave. It is

very useful, when you want to get all the weaves from a complex Jacquard weave.

You can make selection in a two different ways:

• Press Shift+left mouse button (or only the middle mouse button) and move the mouse until the 

desired area is selected. As you drag a mouse, a grid color is changing to red.

Figure 99: Selecting with mouse  

• Choose  Tools >  Select/copy  area.  In  the  Select/copy  area window enter the starting and ending

points of the selections. Instead of ending points you can set Size.

The grid of the selected area is drawn in red. All tool operations work now only on a selected area.
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Figure 100: Weave selection

 

You can copy and multiply this selection again in two different ways:

• Press the left mouse button and drag it to draw the repeated area. The mouse pointer turns color to

red, if you have a selection.

• In the Copy to part of the Select/copy window enter the coordinates of the starting point (From, To)

and the size of the area, where you want to copy the selection.

If you want that the copied area has the same weave offset as the selection, mark the Copy in repeat

toggle button in the Edit menu. The program copies the selected weave with offset from bottom left of

the jacquard weave, not from the selected weave area. In this way, weave will start correctly.

To disable selection, click with the middle button somewhere in the weave area, or click the deselect

icon ( ) in the Weave editor toolbar. The icon changes color to black.

Copy area operations in weave editor, and editing in decomposed weave editor on dobby weave will

leave drafting intact and will modify dobby card. This is important for users who want to design new

weaves on a fixed drafting (so you can tie-up to the same warp). So if you don’t want this effect, delete

drafting by Dobby > Drafting > Clear drafting.

5.14.2.1 LOADING A WEAVE (PART OF WEAVE) INTO SELECTION

You can load any weave into a selection, using the weave browser or the Load weave dialog.

If the selected area is bigger than the repeat of a loaded weave, then the weave is repeated until it fills

a selection.

If the weave, which you want to load into selection, is bigger than selection, then ArahWeave takes just

part of the weave big enough to fill a selection.

The Offset option in the Select/Copy area window enables you to set the starting point of area in the

weave, which you want to load into selection. It is mostly useful when you copy a part of  a jacquard

weave into another jacquard weave.

Figure  101 shows two jacquard weaves. We want to copy the logo and numbers from one weave to

another.
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Figure 101: We want to copy the logo and numbers from one weave to another   

Make a selection in the first weave. Set the offset parameter: logo starts on point 1056 (warp), 6 (weft).

Load the second weave from the weave browser. Logo is placed exactly into selection in the first weave

(Figure 102).

Figure 102: Setting the offset option; weave after copying another weave into selection   

5.14.2.2 WEAVE PEN

Weave pen function enables freehand drawing with selection across the weave editor. To use it you

must have a selection in the weave; then click with right mouse button and drag a mouse. The program

will draw with selection under mouse pointer. The size of drawing area is 3 by 3 points. If you keep the

Shift key pressed during drawing, the size of drawing area is 5 by 5 points.

5.14.2.3 FINDING REPEAT IN SELECTION

The function is very useful, when you want to get the single weaves from complex Jacquard weaves.

First make a selection, which covers the area of only one weave. Then choose Change > Find repeat in

selection. The program reduces the size of selection to one repeat of weave.
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Figure 103: Selection, and finding a repeat in selection

To save a selection as a weave, just use File > Save weave, and the saved weave will be the selection, 

and not the whole weave.

5.14.2.4 REPLACING WEAVE ( JACQUARD)
Replace weave enables you to replace a single weave in a finished jacquard card design, or reconstruct

the original color image (which we obviously don't have anymore) from a jacquard card. This function is

mainly  intended for  jacquard mills  with  old  designs  in jacquard formats,  which they would like  to

modify and re-use, to create new designs with different weaves inserted.

First,  draw a selection in  the weave using  middle  mouse button (or  use  parametric  mode  Tools >

Select/copy area),  which you want to replace. Selection must include at least  one complete weave

repeat. Then choose Jacquard > Replace selected weave.

The program will  try  to find all  areas,  which are covered by the selected weave, and mark it  with

magenta color. If the resulting mask includes undesired weave areas, modify the Thin  parameters. If

the resulting mask does not include all the weave areas, modify the Grow parameters. Times means the

number  of  times  thinning  or  growing  is  repeated.  Neighbors means  the  minimum  number  of

neighboring points (maximum is 8), which should be the equal to the selected weave for the operation

to take place. You can use left mouse button (adding points to masked area) and right mouse buttons

(deleting points from masked area) for drawing the masked area, if the parametric guessing does not

give the desired results.

Figure 104: Selection and masked area
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The masked area is also indicated in the main window (the view mode should be set to Integer).

Figure 105: The masked area in the main window  

Then simply load a different weave into the masked area (File > Load weave).

Figure 106: Load a different weave into the masked area

 

In some cases program finds portions of the selected weave in the areas, where you do not want it.

Figure 107 shows a sample, where program masks additional area to selected plain weave. To prevent

this,  apply  the  Thin parameter,  and  increase  the  Neighbors parameter,  and  click  the  OK button.

Program recalculates the masked area.

Figure 107: Explanation of the Thin parameter
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The meaning of  the function  Get image from weave,  accessible from the  Replaced selected weave

window is described in the Jacquard conversion chapter (9.12.4). There is no need to use it for simple

weave replacement.

5.14.3 REPLACE SIMILAR (CORRECTING LONG FLOATS ON A JUNCTION OF TWO WEAVE SECTIONS)
When you combine different basic weaves into one complex weave, it is very important to avoid the

formation of long floats where the different sections of a design are in contact. Certain equal-sided

twills, and weaves that are the reverse of each other, may be arranged to cut at the junctions—that is,

with warp float against weft float. If possible, no longer float should be made at the junctions than

there is in the weaves that are combined.

But sometimes this is  impossible or would require a time consuming redesigning. Here the Replace

similar function comes handy: you “teach” the program how to correct an error, and then it will correct

(replace) all similar areas found in a weave in the same manner, as you did in the first place.

Procedure: 

1. Make changes in the weave.

2. Make the selection of the area in the weave where you have made these changes. The changed

weave points should not be on the border of the selection.

3. Choose  Edit >  Replace  similar.  There  are two variables  in  the dialog:  the  Border means that the

program will  not alter the areas within the border; the  Maximum changes means it will  search for

similar  areas which have up to defined number of  differences.  When  ArahWeave  finds the areas

which are similar to that of the selected area, it marks them with pink and red.

4. Confirm the changes with the OK button.

Figure 108: Five stages of the Replace similar function.

Figure 108 shows the use of the function in five stages. First one shows the original weave. The green

circle indicates one of the mistakes in the weave. We correct the mistake by deleting one warp point,

and drawing it again next to the weft point. These are two changes. Then we select the area where we

have made a change. We open the Replace similar dialog (Edit > Replace similar). We set the Maximum

changes to 2.  Pressing  the  OK button applies  the changes across  the weave,  and closes  the dialog

window.

If  you alter the Maximum changes or  the Border parameter,  click  the Eye  icon ( )  to redraw the

selection similar area (red/pink) based on the new parameters.

5.14.4 INSERTING AND DELETING WARPS OR WEFTS IN WEAVE

You can insert a warp thread or weft thread at any point of the weave. You can do it in two different 

ways:

• Left mouse click on the gray area to the left or below the weave (in Figure 45: weave control row,

weave control  column)  duplicates  (add identical)  weave thread at  the selected point,  and right

mouse  click  deletes  it.  To  add  empty  space in  the  weave  area,  press  Shift  while  inserting  the

warp/weft with mouse, and added area will  be empty.  Weave, card and drafting are shifted and

resized accordingly. It is also possible to add / remove shafts in the same way – just click on the gray
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area below the shaft. These functions can also be used  to fast weave resize  without opening the

Dimensions window. There is a slight difference in the functioning of the two resize ways: normal

resizing will  not change the weave, so it is easy to  revert to  the  previous value. But if you delete

many warps / wefts, it will not be possible to get them back, because the weave is shifted / copied all

the time. Note: Regulator and denting are not changed with this function.

• Choose Tools > Insert/delete warps/wefts. In the dialog, you have to select a mode (insert or delete)

and directions (warp or  weft).  Then type the insertion/removal position in the  From field and the

number  of  threads  inserted/deleted in  the  Size field.  The  program will  draw a  magenta  line  to

indicate where the insertion begins. Note that an area is always inserted on the right or above this

line.  Similarly,  if  you  delete  warps/wefts,  the area selected for  removal will  be crossed out with

magenta lines.

When you click on the  OK button, ArahWeave inserts the area as a selection, so you can load a

weave into it.

Figure 109: Insert warps/wefts: set From and Size, then click on the OK

5.14.4.1 INSERTING WARPS OR WEFTS BOTH IN WEAVE AND THREAD PATTERN

If  the  warp/weft  pattern toggle  button  in  the  Insert/delete  warps/wefts window  is  on,  then  the

program will also insert the thread pattern, which you write in the field  to the right of toggle button,

into the main thread pattern. Figure 110 shows an example, where we insert four threads in the weave,

and the pattern of the threads inserted is 1a1b (one orange, one blue).
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Figure 110: Inserting warp in weave and thread pattern simultaneously

 

5.14.4.2 INSERTING WARP THREADS BOTH IN WEAVE AND IN THREAD PATTERN WITH MOUSE

With this feature you  can add an extra warp.  The warp pattern repeat and denting  must be equal in

length as  the weave size in  the horizontal  direction.  If  the weave is  84 points  wide, and you have

alternating one thread color A, one thread color B, you should write pattern as  42(1a1b). Same is

with denting: if you have 2 threads per dent, you should write denting as 42(2).

In the Edit warp and weft pattern window, select a yarn, that you want to insert. Hold down the Shift

key while you draw with a mouse the warp pattern in the thread pattern editing row. The program will

add an empty space in the weave area to the right of the clicked area, and insert the currently selected

warp thread, and increase the number of threads in dent, all at once, with a single click. So it is very

easy  to add threads to  the ground fabric.  New threads are added to the right  so  that the ground

threads stay at the beginning of the dent. This may be handy, if you later divide the warp pattern or the

weave according to the number of threads in  a dent. To delete a thread in this coordinated way, you

can also press the shift and the right mouse button. This deletes the thread that you click, not the one

to the right.

Figure 111: Inserting warp in weave and thread pattern simultaneously with mouse
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5.14.4.3 REPEATING PART OF THE WEAVE

You can repeat a part of the weave. Mark the Repeat button, and select part of the weave, which you

want to repeat by setting From and Size number. Program draws two lines to show the area which will

be repeated. If they are in green color, it means that size of the area is not divisible by denting repeat;

if  the size is  divisible by denting repeat lines are in magenta color. Then set the number of repeats

(Times). In Figure 112, we repeat three threads four times, so we increased the size of repeat for twelve

threads.

Figure 112: Repeating part of the weave  

5.14.4.4 MULTIPLYING PART OF THE WEAVE

Sometimes you need to multiply part of the weave. In Figure 113, we choose 6 threads, which should

be multiplied 3 times. 

Figure 113: Multiplying part of the weave  

5.14.5 DELETING WARP/WEFT BY YARN

Sometimes we want to delete both treads and the area in the weave, covered by these threads.  This

can be achieved by using  a  function from  the  previous chapter (Inserting/deleting warps/wefts),  but

this one has a simpler and cleaner user interface, and allows faster, one-click solution. To use it, select

Tools > Delete warp/weft by yarn.

Figure 114 shows the extra weft design. We want to remove a green part of the design (weft thread c).

Click the Weft radio button in the Delete warp/weft by yarn window, enter c in the Yarns field, and click

OK.  Program  deletes  the green yarn  from the thread pattern  and  removes  the area of  the weave

covered by yarn c from the weave.
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Figure 114: Deleting warp/weft by yarn
 

5.14.6 GENERATING CREPE (SABLE) WEAVES

Weave editor has a tool for generating crepe (sable) weaves. To use it, in

the Edit  weave window choose  Change >  Make  crepe  weave.  The tool

works both on selection, as on the full weave, but it has more options if it

works over a full weave. The tool is more appropriate for jacquard, since

it does not handle shafts in any way. If it works on selection, then long

float controls  are not applied.  The value in the  Effect field  may be any

integer between 1 and 254.  If  it is closer  to 1, the resulting weave will

produce the warp effect  on the face side of the fabric, if  it is closer to

254, it will be more of weft effect. The value of 128 will make a balanced

effect.  You can enable/disable the long floats correction with the  Long

floats check-box. Set the maximum float for the warp and for the weft in

the  Warp and  Weft fields.  If you check the Fix floats face and back check-box, then the program will

shorten the floats to the declared values automatically. Otherwise you have to open the Flo at dialog

(Edit > Float), and correct floats from there.

The program is fully interactive, so you can use the wheel mouse and observe the effects.

The  images  in  Figure  116 shows  the  two  generated  weaves—the  only  difference  is  the  Effect  1

parameter (15 and 135) in the setting.

Figure 116: Making crepe weave

Figure 115: Make crepe
weave dialog
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5.14.6.1 SHADED CREPE WEAVE

On the top of  the  Make  crepe  weave window,  you can

enable  the  Shaded toggle  button,  which  allows  you  to

specify  two  values  for  effect.  Program  will  make  a

horizontal shade from one effect to the other.

Figure 117: Shaded crepe weave

5.14.6.2 BIDIRECTIONAL SHADED CREPE WEAVE

If  you  turn  on  the  Bidirectional  button,  the  program

makes a smooth transition between dark and light (warp

and weft effect) areas.

Figure 118: Bidirectional shaded crepe
weave

5.14.6.3 SHADED CREPE WEAVE WITH ANGLE

You can set the angle of the shaded effect through the

Angle option. It works both for normal and bidirectional

shading.

Figure 119: Setting the angle of crepe
shading
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5.14.6.4 USING IMAGE FOR CREATING CREPE WEAVE

You can use image as a base for crepe fabric. Both Shaded and Image check boxes should be on. Then

load the image into Jacquard conversion window (Weave > Jacquard conversion). Click the OK button,

and the program creates a crepe weave based on the image.

Figure 120: Using image as a base for crepe

5.14.7 ADDING REGULATOR OR FRINGE FUNCTION TO A THREAD

The Add to yarn Regulator/Fringe  function enables you to modify a regulator pattern in a fast way. It

adds a regulator or fringe to defined weft, and automatically generates new regulator pattern, so you

don't need to draw it or write it. It is very useful if  you already have regulator pattern (for instance

extra weft design), and you want to add regulator to some of the ground wefts.

To use this function, choose Tools > Add to yarn, and select either you want to use regulator or fringe.

In the Yarns field enter the yarn, to which you want to add the regulator.

Figure 121: Adding regulator to yarn

5.15 WARP CONSUMPTION AND LIFTING INFORMATION (JACQUARD)
The weave information window, available from the View menu, will display  the owner of the weave,

when it was last saved, and some other interesting statistics.

Lifting gives you a graphical view of how many hooks are lifted on the average. On jacquard, you would

choose to reverse the fabric and weave it with back on top, so that fewer hooks would be lifted on

average, thus prolonging machine life by reducing its wear and tear.
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Figure 122: Weave information - lifting

Consumption will display the relative consumption of each thread according to the weave: it will count

the number of passages from back to forward for each warp thread. If the fabric will have warp threads

with very different consumption, the ones that consume more will begin to pull after a few meters are

woven. They will  cause warp to break or errors will  be formed on the fabric (so called nests),  since

jacquard will not be able to pull up the hook due to high tension of the thread. In such cases, you can

either  use  two separate  warp  beams,  or  change  the  weaves,  so  that  they  will  have  more  similar

consumption, or change the design, so that it will not contain vertical stripes of a single weave.

Figure 123: Weave information - Consumption

Both Lifting and Consumption display a warning when the values are out of bounds, but the limits are

not really strict, so it is up to you to decide, if you want to resolve the problem or you leave as it is. The

warning for lifting is above 50%, and the warning for consumption is above 30%. You can display these

reports in black and white or in color; press Shift+c to switch color display on or off.



64    C hap t er  5   
 E di t in g t he  w eave

www.arahne.si  

5.16 PRINTING THE WEAVE

To print a weave, choose File >  Print weave. Figure 124

shows the Print weave window, where you set different

printing properties.

Figure 124: Print weave window

5.16.1 PRINTER SETUP

If you have not saved printer settings in  Save setup,

or you want to print to a different printer or file, you

should select Printer setup to change printer settings.

In this window (Figure  125), you have to choose the

desired  printer  or  graphics  file  format,  print  mode

and density (in dpi—dots per inch). For higher quality

printouts use 1440 dpi, but in most cases 720 dpi is

sufficient.

5.16.2 PRINT SIZE

To control  size and position of the printout size enter fields in the  Print size area. The borders are

measured from left and top including the non-printable white space. To check the maximum printable

area, press the Full page button. If you insert an area out of range it will be trimmed and you will be

warned with a beep.

5.16.3 GRID

Here you set the grid size (mesh). Default value is 1.5 millimeter.

5.16.4 PRINTING OPTIONS

The printing option toggle buttons are below the Print size text fields. Simply, by marking the check box

in front of the option, you include that in the printout.

• Title;  the program extends the title  with  date,  user  name,  customer name (your company)  and

version of the program at the top of the page.

• Denting 

• Selvedges;  program  prints  selvedges  on  the  left  of  the weave,  if  you  have  load  the  weave for

selvedge in the Save cards for production window.

• One repeat; program prints only the weave, even if there is space for printing more weave repeats 

• Yarns; you get the warp and weft pattern on the top and right side of the weave.

• Compress; if the weave consists of many repeating elements, you can use this function to reduce

printout size.

Figure 125: Printer set-up
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Figure 126: The same weave in "normal", and compressed mode

• Card; normally, you want to print the dobby card, but if you don't, there is the option to skip it.

• 123;  Program will  print  the number of  shaft

instead of black square in the drafting pattern,

and in the dobby card. Mesh size should be at

least 3, so there will be enough space for the

number to be readable.

5.16.5 PRINT PREVIEW

When the settings are correct, check the Print

preview. It displays weave exactly as it will be

placed  on  a  paper  (left  and  top  offset).  If

everything is  in the proper place, close print

preview, and click OK.

5.17 EXTRACTING THE WEAVE FROM CARDS

ArahWeave enables you to adapt / change / correct designs, which you get in the form of a Jacquard

card file and you don’t have ArahWeave’s fabric file of it. When you load such a file in ArahWeave’s

weave editor, it is displayed as a regular weave (you know, black and white points). But somehow, this

kind of a weave looks strange, because there are some empty columns, and usually there are some

random black points at the beginning of the card. These points control the sequence of weft yarns (we

call it weft change) and empty columns represent inactive (empty) hooks. There may be some other

information, like regulator, density, a weave for selvedges, beside the weft change sequence.  To cut

just a weave out of it, you will have to remove the loom control information from a card file, but before

that, we can use this information to reconstruct  a fabric  design. In the Jacquard menu of the weave

editor you can find a function for guessing a weft change from a specified weave point and the length

of weave area that presumably contains this information, and for guessing the regulator (stop motion)

from a specified weave point. The following paragraphs explain the functions needed to extract this

information.

Figure 127: Weave draft marked with numbers

Figure 128: Print preview of the weave; the compress
option is on.
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5.17.1 LOADING A CARD FILE INTO WEAVE EDITOR

Use Weave > Load cards… to open the Cards browser,

and load a card into Weave Editor (if you are loading a

card from  a  floppy,  choose  Weave >  Read  Jacquard

floppy,  and wait until the program reads the floppy,

and then load the desired file.)

Figure 129: Opening the card browser

To work within the logic of  ArahWeave,  you must extract only the weave information, deleting the

fields for empty hooks, selvedges, control information, etc. Once you have only the weave, you can

correct the long floats, if  any, and save the jacquard file in a different format or  for a different loom

setup. 

Figure 130: Cards in weave editor

5.17.2 GUESSING THE WEFT CHANGE

Choose Jacquard > Guess weft change in the main Weave editor’s menu. 

You have to tell the program, where the weft selection information is positioned (the  From position

field), and how many hooks are used for the weft change (Length). Move the mouse in the Edit weave

window to find the position and number of hooks, which are used to control the weft pattern. In the

Guess weft change window, type in the starting position (the position of the first hook which controls

weft), and the number of hooks, which are used to control the weft pattern.
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The jacquard file displayed in  Figure  131 contains  the weft change information which starts at the

beginning of the file, so enter 1 in the From position field. We can see that the regulator is on the ninth

hook, so eight hooks before the ninth hook are used for the weft selection. 

Figure 131: The guess weft change dialog

When you click on the  OK button the program writes the weft pattern into the  Edit  warp and weft

pattern window.

Figure 132: ArahWeave reads a weft pattern from the file, and writes it into Edit
warp and weft pattern window.  

5.17.3 GUESSING THE REGULATOR

Choose Jacquard > Guess Regulator in the main Weave editor’s menu. Similar to weft change, you have

to find a position of the regulator. Usually it is a single hook.
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Figure 133: Guessing the regulator
 

When you click on the OK button the program writes (and draws it on the right side of the weave) the

regulator pattern into the Edit weave window.

Figure 134: The regulator pattern written in the Edit weave window.  

Regulator cannot start with active regulator (black point) on the first weft in ArahWeave. If it is on the

first weft in your card file, move the weave (card) vertically until it starts with a white point. 
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5.17.4 REMOVING SELVEDGES FROM WEAVE

The Jacquard menu of weave editor also contains function Remove selvedges and Remove extra warps /

wefts. The first function removes selvedges—it tries to find out if there is a complete vertical repeat in

the weave, identifies it as selvedge, and removes it. It will search for repeats with length of up to 40

points. The second function is useful for removing empty spaces (areas of complete float in either warp

or weft). The aim of both functions is getting the weave out of a jacquard design prepared for weaving.

If  there are some warps that cannot be removed automatically  with  the above functions,  you can

remove them manually by deleting them: right mouse button click in the weave on the gray area below

the warp removes the clicked warp end.

In the case of a simple jacquard file, like the one used in previous figures, Jacquard > Remove selvedges

deletes all except the weave information from a Jacquard file. You can make a fabric simulation, after

you set the colors, yarns and density.

Figure 135: The simulation based on the data extracted from the jacquard file.  

6 YARNS

To edit yarns, choose Fabric > Yarns.

On top of the Yarns window, you will see warp (A...Y) and weft (a...y) colors. To edit a particular yarn,

click to the desired entry. The selected yarn color and code will be displayed below.
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Figure 136: The yarns editor; selected is the “B” yarn in warp.

 

6.1 YARN COUNT

The most important property of yarn is its count. The count is

entered into the Count field and can be expressed in any of the

common units; you select the unit with the unit toggle button.

Supported yarn count units are:

• Tex The ISO standard (gram/kilometer)

• Nm Metric (meter/gram)

• NeC Cotton (English); 840 yards per lb 

• NeW Worsted

• Np Woolen (Prato)

• Ny Woolen (Yorkshire)

• NeL Linen

• NeS Silk

• Td Denier (grams/9000 meters)

• Run American woolen unit

• dTex equals 0.1 tex

• YPP yards per pound

Figure 137: Choosing the yarn-count
unit.

6.2 YARN DIAMETER (DIMENSION FACTOR)
The yarn diameter is the basis for fabric simulation in the Simulation view. You can’t enter it directly, as

it is calculated from yarn count and dimension factor, according to the following formula:
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Diameter=
√counttex

Dimension Factor
 

Every time you create a new yarn,  the default  value of  the dimension factor,  which is  18,  is  used.

Different  factors  are  suggested  for  different  yarn  types  (carded  cotton  18.7,  combed cotton  22.5,

combed wool 25.3, wool 16.7, linen 27.1, etc.). Usually we change the dimension factor rather than a

yarn  count  to  modify  the  yarn  diameter.  When  changing  the  dimension  factor,  either  by  directly

entering the value or by using the plus and minus icons, you can observe the change in the theoretical

diameter of the yarn in the yarns property table; to apply a change to the fabric simulation, press the

OK button in the Yarns window.

Figure 138: Instead of typing in the dimension factor value, you can
increase or decrease the yarn diameter by pressing the plus or minus

icons next to the input field (yarn thickness).  

6.3 LUSTER

Luster determines luminosity value of contrast between the light shading and dark shading color in

yarn simulation. Default value is 10. You can vary this value from 0 to 30, where higher value means

stronger shading effect. Figure 139 shows the same yarn at three different luster settings. Yarn images

are taken from the yarn preview part of the Yarns window; preview works only for the Simulation view.

Figure 139: Same yarn color at Luster 5, Luster 10, Luster20, and Luster 30
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6.4 VARIATION

The Variation% parameter (located in the upper right corner of

the Yarns window) allows you to vary yarn diameter to make a

simulation look more fabric-like. For wool-like fabrics, use 10 to

20%, and for regular yarns, use less (default  is  0). Variation of

up to +-50% is  possible.  The yarn  variation is  random within

given limits,  but each yarn has only one diameter, unlike real

yarns, which change diameter after, say, 50 cm, depending on

the yarn properties.

Figure 140: Variation set to 15%

6.5 TWISTS

Yarn  twist  is  used  to  bind  together  fibers  in  spun  yarns.  The  number  of  twists  per  length  unit

determines the yarn twist angle, which affects the yarn appearance. Twist sense has S (left) or Z (right)

directions. You can disable the twist simulation in yarn by choosing 0 (zero) as twist sense.

Twist contraction is  inserted as %, and it increases the weight of yarn and yarn diameter by a given

percentage.

Figure 141: Choosing twist sense and setting the number of twists per
meter.

 

Figure 142 shows the effect of twist on yarn appearance.

Figure 142: Yarn with twist sense S, Z, and without twist

 

6.6 TRANSPARENCY

If you use semi transparent yarns, you can adjust the level of Transparency from 0 to 9, where 9 means

that 90% of pixels in yarn are transparent.
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6.7 NAME, CODE, PRICE

You can enter the code and name of  the yarn according to a weaving

mill’s  or  producer’s  naming  scheme in  the text  boxes  labeled,  as  you

would expect,  code and name. Same goes with  the price  of  the yarn,

enter it in the Price text box. This yarn price is used then in the fabric cost

calculation.

The  currency  is  set  in  the  ArahWeave configuration  file  (Help >  Save

setup).

Figure 143: Yarn's input
fields

6.8 YARN COMPOSITION

You can set the fiber composition for every yarn. First enter the number of Components, then enter the

relative part of every fiber, and select the fiber code from the drop down list.

The codes are taken from the ArahneFiberImport.[lang].xml file from the folder named “common”. The

[lang] stands for the language code. For instance, when English is the selected language in ArahWeave,

the fiber codes from ArahneFiberImport.eng.xml are used.

Figure 144: Choosing the fiber code from the drop-down
list.

 

If  you like, you can  use your own fiber codes table.  Copy one of the Fiber import files,  for instance

common/ArahneFiberImport.eng.xml  file  into your default  XML folder (usually  it  is  data/xml).  Then

delete the language code from its  file  name (.eng  from ArahneFiberImport.eng.xml).  This  file  now

becomes the fiber codes import file read by ArahWeave at startup. You can open it and edit it in a text

editor program (notepad, kwrite, kate…), like deleting fibers you don’t use, adding new fiber codes or

modifying the existing ones. To remove a fiber code from a list, find it, and delete the whole line, which

contains this code, starting with <Value> and ending with </Value>.
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Figure 145: ArahneFiberImport.eng.xml file displayed in a text editor.
 

ArahWeave calculates the fabric composition in the Calculation of thread consumption window, if  the

composition of every yarn in the fabric is set (Figure 146).

Figure 146: The yarn composition in the Yarns dialog, and the calculated
composition of the fabric in the Calculation of thread consumption window.  

6.9 YARN MODEL

You can choose  the  type of  yarn from the  Model option menu (Figure  147).

Simple  is  the default model. It means a regular, solid color yarn. Other models

are Mouliné, Mélange, Multicolor, and Custom.

Figure 147: Yarn
model menu

6.9.1 COMPLEX YARNS (MOULINÉ, MÉLANGE, MULTICOLOR)
When you choose one of the complex yarns (mouliné, mélange, multicolor), the number of colors in

yarn changes to two. You can change it to have up to six component colors.

The right part of yarn color display window contains the yarn sub-colors.

Click the color to select it. In the Edit color window, you can then copy,

exchange or modify colors as you do if you have a single color yarn. In

the Integer view, only the first yarn color is used to simulate the whole

yarn. In the Simulation view, the yarn is correctly simulated with all the

components.  For each yarn color,  you can enter the relative size  of  a

component yarn in the final yarn.

Yarn color values are relative to the total of all yarn colors. As you enter

them, and press Enter, the computer will  automatically recalculate the

relative percentage of each yarn color. You can also enter values as %, if you like, but since values are

relative, there is no checking to make a sum of all colors 100%.

Figure 148: Setting the
number of colors in yarn
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The  Correlation parameter (Figure  149) is  used for  mouliné and mélange yarns. As you increase the

correlation parameter from 0 to 8, the program will introduce stronger and longer variations in relative

sizes of the two (or more) mouliné yarns. If correlation is 0 (default), then each point is random within

given proportions, as before. But if you increase the value of correlation, the mélange will look as if it

was not mixed very well. You can set the intensity according to your pleasure up to a maximum of 8.

Figure 149: Mélange yarn at Correlation 0, 3, and 8

 

Multicolor model  simulates  a yarn composed  of  different  stripes  of  a  single  color.  They appear as

“random” color stripes, while the probability of their appearance is controlled by the value you enter

for  each color.  Use  the  Length field  to  control  the length  of  color  segments.  To  create  a  smooth

transition between colors,  set the  Smooth option.  It  can be any value from 0 (no transition)  to 30

(highest dither). Figure 150 shows the multicolor yarn.

Figure 150: Multicolor yarn without smooth (top), and with the smooth option set to
15

 

When you have just one color per yarn, the boxes and arrows for entering relative size of component

color are not mapped; they appear as you increase the number of colors. The yarn Model buttons are

also not mapped on single color yarns.

Chenille  yarns:  for  each  yarn,  you  can  specify  the  hair  length and  hair  probability.  Hair  length is

expressed as tenth of yarn diameter. So length of 10 means a hair as long as yarn diameter. Maximum

hair length is 50, that is 5 times the yarn width. The hairs will go in all directions randomly with equal

probability. 16 directions are supported. You must also specify hair probability. Maximum probability is

20. You can use any value between 0 and 20 (inclusive) for your desired effect. The nice thing about

simulation of chenille yarns is that you can use it on all yarn types supported within ArahWeave: single

color,  mouliné, mélange, multicolor, and drawn yarns. Chenille is fundamentally different from other

yarns, since its hair will cover other yarns close to it, in spite of the fact that those other yarns would be

on the top according to the weave. For this reason, it is not possible to simulate chenille simply by

increasing yarn count (thickness). It is also good to know that chenille yarns are very open, so the yarn

count with respect to diameter as calculated by default dimension factor of 18.0 will probably not be

correct. You will need to adjust it to a higher or lower value.

6.9.2 MAKING CHENILLE YARN 
Some yarns, especially chenille types, appear like they are made from many light shades of one color. If

you want to make a realistic looking chenille yarn, you have to make a multicolored yarn with sections

of different, but similar colors. There is a function in the Yarns editor, which helps you to create this

type of yarn in a quick way.

First, choose a color for yarn in the Edit colors window. In the Yarns window choose Multicolor as a type

of yarn, select a number of shades in yarn (up to six), and choose Tools > Make yarn color shades. You
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can also increase the Length and Smoothen parameters. In the Make color shades window you set the

Luminosity parameter, which determines the  L (luminosity) differences between color shades. If you

have 5 colors, and luminosity difference should be -+5, the program will keep the base color, and then

make a different variation of it which will be +5, -5, +10, -10 as Luminosity in Lab values. Usually 3-5

gives good results.

Figure 151: Making yarn color shades for chenille.  

6.9.3 CUSTOM MODE (DRAWING YARNS)
You can draw your own yarns using paint tools. The initial yarn will always be based on the previously

selected yarn. So if you want to save some time, it is a good idea to set all the yarn parameters (count)

for the yarn which is most similar to the yarn you want to draw (like for example, melange), and then

switch to the Custom yarn model. Then increase the number of colors (if you want to have more than

one), click on the Draw yarn button, and the Draw yarn window pops up (Figure 152).



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  77

Figure 152: The Draw yarn window

 

The  Draw yarn editor is composed of several areas. On top, you have the drawing area. The yarn is

drawn in  a  grid,  and you can change the zoom level  by  pressing  + and – on the keyboard,  or  by

Ctrl+mouse wheel.  The top of the yarn also displays the ruler, so you know in real size how long a

certain effect will be. Below the yarn draw area you have the same yarn repeated 5 times, so you have

some idea how the yarn  will look when it  is  repeated several times. Each yarn has its own random

starting offset.

The colors used in the yarn are displayed at the bottom, together with the actual yarn dimensions, both

in pixels (points) as in real length. If you want longer yarn, you can increase the  Length value  in  the

lower right corner. Note that you will not get new empty space, since the program will automatically

copy the existing yarn to the new area. The length of yarn is not arbitrary—it must always be a power

of two.  For instance, a length of 11 means length of 2 to the power of 11, that is 2048. The  Stretch

value gives you the possibility to match the desired length of the yarn repeat. 

It can be painful to draw very long yarns, so we have some tools which make it easier: you can scroll

across the yarn with a wheel mouse, and the program supports auto-scrolling for drawing long areas.

This means that, if you draw out of the window area horizontally, the program will scroll the yarn until

you return back into the drawing area.

The available colors for drawing are below the yarn. Each yarn color allows 5

variations of the basic color. The basic color is in the middle, labeled 0. Then

you have two lighter colors labeled -1 and -2, and two darker colors with labels

+1 and +2 (Figure 153).

You have an option menu to choose the thickness of your draw pen—it can go from 1

to 9.

There are several icons or menus to choose from at the bottom of the Draw yarn window. The first one

on the left  allows you to apply the yarn to the fabric, to observe the yarn changes in the real fabric

simulation.

Figure 154:
Yarn pen size

Figure 153: Yarn colors

Menu bar

Ruler

Drawing area

Preview

Color in five shades

Yarn size

Tool bar
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Next comes the Draw tool – freehand , rectangle  , spray  , mix  .  The left

mouse button draws with the selected color, the right mouse button draws with the

background color (that is a hole in the yarn).

After that you have the choice of the Draw mode: first is normal, indicated by a pen .

Then you have the Recolor tool  which keeps the shades of the yarn image, and just

recolors it into a different yarn color. In this way, it will be easy to keep the yarn twists

in the image, and make a complex printed yarn with colors changing across the yarn.

The last mode is  lighten/darken  . It allows you to draw the area into a darker color

(left mouse button) or lighter color (right mouse button). It does this without affecting

the actual color. So if you draw across a yellow, it makes a yellow darker, but if you draw across green,

it  makes  a  darker  green.  In  this  way,  it  should  be  easier  to  draw  yarn  twist,  or  shade  the  yarn

illumination from top to bottom.

After these main operations, you also have other tools, most of these should be easy to understand, if

you know  ArahPaint  or weave editor.  There are two icons  to mirror  the yarn horizontally   and

vertically  . The scissors   will  move the beginning of the yarn to the middle (so you can fix the

repeat at the beginning and the end).

The next tool   is intended for yarn thinning. It will  thin the yarn for the number of points of the

currently selected pen size. If pen size is 3, it will take 3 pixels from the top and from the bottom. This

function serves for making space for the bouclé or flammé yarn. You first need to thin the yarn, so you

can later draw the thick effects.

After that you have two icons for tilting the yarn to the left  and right . You can use it to adjust the

twist angle.

You also have one level undo  for your drawing operations.

To adjust the zoom level of the yarn editor, change the zoom factor, or roll  the mouse wheel up or

down while holding down the Ctrl key.

6.9.3.1 EDIT MENU

The Edit menu of the Draw yarn window contains additional tools / functions for faster yarn drawing.

Clear shades changes the five-shades color into one solid color (middle tone), which makes drawing

much easier and faster. To revert the shades, use  Edit >  Add top/bottom shades, and then Edit >  Add

twist. Program draws twists automatically.

Figure 157: Add shades and twist

Once you have finished drawing your yarn, you can save it, so you can use it in a different fabric. The

yarn colors are saved in the yarn file; you can change colors as for any other “normal” yarn in the Edit

Figure 156:
Draw yarn

mode

Figure 155: Draw
yarn tool
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colors window. So you don’t need a couple of flame yarns, you can use one for all the different colors

and yarn counts.

6.9.3.2 LOADING YARN SHAPE

Load yarn shape overdraws the shape and twists of the existing yarn in the Draw yarn window with the

shape and twist of a loaded yarn, but preserves the colors. It is useful, if you want to change mélange,

multicolor, or mouliné template yarn into already prepared bouclé, flammé (slub), or similar yarn.

Figure 158: Mélange yarn before and after loading boucle yarn shape

 

6.10 SAVING AND LOADING YARNS

Saving and loading of a single yarn is supported from the File menu on top of  Yarns window. Yarn is

loaded to, or saved from the currently selected yarn. Colors are also saved in the yarn definition. If you

do not want to load the color of the yarn, load it to an unused yarn and then copy the yarn definition

across the desired yarns with the right mouse button in the Yarns window.

6.11 YARN BROWSER

To open the Yarn browser, select  File >  Browse yarns from the Yarns dialog. The window is split into

two parts. The left part displays all yarns from the default yarn directory. On the right side there is a list

of colors associated with currently selected yarn.

Figure 159: Yarn browser

 

It shows all the yarns, and you can order the list by yarn code, count, ply, twist, composition or name.

To change the sort key, click on the title of the list. Once you click on the yarn, the program will show

all the yarn colors of that yarn, together with stock quantity and price. If you double click on the yarn, it

will load these values into the yarn. In most cases, you only want to transfer the codes, yarn count and

composition. So the Load only codes toggle button is enabled by default. If it would not be enabled, the
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program would load all yarn’s properties, like the actual color values (not just color codes), yarn image,

mélange / mouliné settings etc. When you load a yarn using  File >  Load yarn,  the program loads all

yarn’s properties.

The yarn color section can also be sorted by code, name, weight and price. This can be useful, when a

single yarn is available in many colors.

The browser has some tools for yarn selection, for example you have a filter to select only yarns which

match certain code, name, or were defined in a certain season. The yarn season cannot be defined in

ArahWeave; it is specified in the XML import file. More on that in Chapter 19.2. 

If you want to refresh the yarn availability, select Tools > Import yarn availability from the Yarn window.

This reloads the yarn stock XML file and refreshes the data.

6.12 USING SCANNED YARNS IN ARAHWEAVE

6.12.1 SCANNING A YARN

Most consumer grade flatbed scanners are designed for Letter and A4 paper. So the usable length of

scan is not more than 30 cm. This is a major shortcoming of yarn scanning because a repeat size of

many novelty yarns exceeds this length. So we don't get full repeat, or we have to use rather complex

image manipulation to get our final yarn image.

A yarn image should meet three requirements in order to allow ArahWeave to use it:

1. The image width: the yarn image should be exactly 15 pixels. 

2. The  image  height:  it  should  be any power of  two;  in  practice it  means numbers  like  512,

1024... but since the width of the yarn is relatively small compared to the length of yarn, the

number would be more likely 8196 or 16384.

3. The  number  of  colors in  the image should not exceeds 31.  The first  color in  the palette is

determined as a color of background. It will be invisible (transparent) in the Yarn editor, and

also in a fabric. You can use  ArahPaint to determine, which color will be the first one in the

palette.

6.12.2 GETTING A YARN SCAN

The  yarn  should  be  as  straight  as  possible  during

scanning. The image in Figure  160 is almost useless,

because you would spend too much time editing yarn

images.

Figure 160: Various fancy yarns scan

In our example, we have fixed a yarn to a paperboard. We choose a paperboard shade based on a yarn

color. Obviously, lighter or mid-tone yarns require dark paperboard, and darker yarns are better visible

on white paperboard.



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  81

Figure 161: To prepare a yarn for scanning, cut a notch at each side of a paperboard, and
anchor a thread in the notches.

6.12.3 EDITING A YARN IMAGE IN ARAHPAINT5
Load an image into  ArahPaint.  Check whether a yarn is aligned horizontally  (or vertically).  If not, you

should rotate the whole image to achieve alignment. To do this, choose  Edit >  Rotate Image.  Draw a

line along the edge of a yarn that should have been straight.

Figure 162: Aligning a yarn after scanning

ArahPaint will automatically rotate the image by the right amount, resize the image, and show you a

live preview of what the final image will look like.

Figure 163: Applying rotation

Then create a selection around yarn in the image, and crop to selection (Image  > Crop to selection), and

save the file.

Figure 164: Selecting a yarn in the image

You can get more color variations from one yarn, if you modify it in some photo editing software. We

are using black-and-white fancy yarn in the example below.

Before loading it  into ArahWeave, change (scale) the size of the yarn in pixels,  so that  it  will  meet

ArahWeave's requirements. At this stage the size should be 15 pixels by  2n.  pixels (or  2n x 15 if you

work on a horizontal image like we do).

In our example, the image size is 3461 by 29 pixels.
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Figure 165: The resize image dialog 

 

We are working on horizontal oriented yarn; first change the Height to 15. The Width will  auto adjust

according to the aspect ratio (proportion).

Figure 166: Setting the yarn size

 

Now break the chain by clicking on it ( ). It changes to the broken chain icon ( ). Now you can set the

width independently from Height. The closest power-of-two number to 1790 is 2048, so set the width

to 2048. Before clicking the OK button to apply the changes, set the scaling filter (algorithm) to Bicubic.
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Figure 167: Setting the yarn width

The yarn is stretched a little bit now, but you can control this later in ArahWeave's yarn editor.

Figure 168: The yarn image after resizing

Now we have to reduce the number of used colors in the yarn image.  Choose Colors >  Set number of

colors, and set the number of colors, that you want to have in the image. You can start with higher

number than the actual number would be.

Figure 169: Reducing the number of colors

We have reduced the number of colors to 35. You can see that many of them are almost identical. You

can merge these colors into one color in the ArahPaint's color palette. First select one of the colors from

the almost-identical group (left-click  selects  a color); then paste it into other colors from the group

(right-click pastes  selected color into clicked color). After that, you just need to merge equal colors  –

click the merge identical colors icon .
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Figure 170: Merging colors in the Color palette

Obviously the white, color No. 6, is the background color in the yarn image. To enable ArahWeave to

recognize it as a background color, it should be on the position 1 in the Color palette. To change the

position in the palette, first click it to select it, and then click the color on the position 1, while holding

the CTRL key on the keyboard.

Figure 171: Positioning the background color to No. 1

You can change the color

of  the  background  to

something  which  will  be

more distinguishable from

other  parts  of  the  yarn.

This background color will

be invisible  in  ArahWeave

anyway.

Figure 172: Changing the color No. 1
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And  now  the  final  step:  if  you  work  with

horizontally oriented image, you should put it in

vertical position.

Figure 173: Rotating the image

6.12.4 LOADING A SCANNED YARN IMAGE IN ARAHWEAVE

Open  ArahWeave,  Fabric >  Yarns.

Choose Scanned as the yarn model, and

click  the  Draw  yarn  button.  This  will

open the Draw yarn dialog.

Figure 174: Opening the Draw yarn dialog
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Choose  File >  Load yarn  image from the

Draw yarn window's  menu,  and load an

image  from  the  file  selection  box.  Click

the OK icon ( ) to confirm the new yarn.

Figure 175: Loading a yarn image

Set the yarn count in in the main Yarns window.

From here, you can also save a yarn, and use it

in other fabrics, or just use its shape (File > Load

yarn shape…) while constructing different fancy

yarns.

Figure 176: Preview of the yarn in the Yarns window

After you have saved a scan-based yarn, you can use it in any ArahWeave fabric file.
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Figure 177: Using scan-based yarn in a fabric

 

7 EDITING WARP AND WEFT PATTERN

Figure 178 shows a window for entering the warp and weft patter. The main parts are :

1. The menu bar.

2. The option menu for choosing  between entry as threads  or as length in  millimeters,  and option

menu containing the preferred type of parenthesis in warp and weft description, either ( ) or [ ].

3. The option button to choose Warp pattern mode (asymmetrical, symmetrical, pivot1, pivot2).

4. The option button to choose 2 warp beams.

5. The icon bar for warp pattern.

6. The multi-line warp entry field.

7. A color box with warps on top and wefts below. The last color is the background color. Color  Y is

mark for fringe – weaving without weft. On the left there are arrows to copy warp to weft, and weft

to warp, and arrow on the right for exchanging warp and weft pattern.

8. The multi-line weft entry field.

9. The option button to choose Weft pattern mode (asymmetrical, symmetrical, pivot1, pivot2).

10. The option button to choose Double weft insertion.

11. The icon bar for weft pattern.

12. OK, Exit, Help buttons.

ArahWeave uses a very simple way for entry of warp and weft pattern. You just enter the number of

equal threads followed by identifier of the thread. In this way, warp pattern 2A 3B 1C will expand to

AABBBC|AABBBC|AA...The vertical bar ( | ) is meant just to indicate the end of repeat.

Figure 178: Warp and weft pattern editor

 

The list of things to consider when editing warp and weft pattern:

• You must use thread identifiers from  A to  Y;  you can see the actual thread colors below warp or

above weft pattern entry field.
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• Warp ends are identified by capital letters in the yarn bar; as you type in the warp pattern, the letters

are written in capital form whatever the status of the Caps Lock key on the keyboard is.

• You can enter space characters to format your entry. You can add spaces later to divide yarn entries

for easier reading by clicking on  icon. You can remove spaces from pattern to reduce the space

required on printed form by clicking on  icon.

• The actual size of the warp and weft repeat is displayed in the window title bar.

• The letters of warps / wefts, which are used in the pattern, are marked by an asterisk (*).

• The letters of warp, which are used in the  selvedges,  are marked by a  vertical bar (|)  (letter A in

Figure 178).

• The last color in the yarn bar (in Figure 178 it is white, labeled with #) is the background color. If the

fabric it is transparent, like a curtain, you can see the background color through the fabric.

• Currently selected yarn (d in weft in Figure 178) is highlighted in the pattern, so you can easily find it.

• There are special provisions intended to help you in the entry of complicated and repeating patterns.

Round parenthesis will repeat the whole sequence for the number of written before the parenthesis,

while  square  parenthesis  will  repeat  the  sequence  until  the  number  of  threads  before  the

parenthesis is consumed. Sequence 2a 3(1b 1c) 2d will expand to aabcbcbcdd. Sequence 2a
5[1b 1c] 2d will expand to aabcbcbdd.

• Nesting of parenthesis like 5(1a 20(1b1c)) is permitted.

• You may mix square and round parenthesis in your pattern entry, while computer will use just one of

the two, depending on the state of the option button in the upper right angle of the entry window.

• The program will also check for syntax errors like parenthesis mismatch and other forms of errors. It

will warn you about the error refusing to process the illegal sequence, and position you to the field

and character, where it finds the error.

7.1 WARP AND WEFT PATTERN MODES

ArahWeave also  implements special  symmetry tools.  The patterns we have explained so far are all

asymmetrical, but if you select the option menu labeled asymmetrical in warp or weft pattern, you will

also see options symmetrical, pivot1, and pivot2.

A symmetrical pattern 1a1b1f2c3d will expand to abfccddddddccfba|abfccddddddcc...

Note that first and last entries in the pattern are effectively doubled in the expanded sequence. This is

correct, but may not be desired.

To  avoid  this  you  can  use  pivot1 type  of  symmetry.  This  symmetry  mirrors  the  pattern  without

repeating the first and last entry in sequence. It is used in almost all Scottish tartans. The same pattern

from above would expand to:

abfccdddccfb|abfccdddccfb|ab...
Symmetry pivot2 does the same as pivot1, just that it does not mirror first two and last two entries. 

Therefore the above sequence would expand to:

abfccdddf|abfccdddf|abfcc...

7.2 LOADING AND SAVING THREAD PATTERNS

Loading and saving thread patterns is possible through the File menu of the Edit warp and weft pattern

window.

To save warp pattern choose File > Save warp pattern.

To load warp pattern choose File > Load warp pattern.

To save weft pattern choose File > Save weft pattern.

To load weft pattern choose File > Load weft pattern.
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7.3 BROWSING WARP/WEFT PATTERNS

To  open  the  warp  browser,  choose

File >  Browse warp patterns.  Browser

displays  warp  pattern  name  (code),

pattern,  repeat,  the number  of  used

yarns,  and date of  creation.  You can

sort the warps order by any of these

criteria.  Below  list  of  warps  is

graphical  presentation  of  warp  in

current fabric’s colors.

Figure 179: Browse warp pattern

The  weft  pattern  browser  is

similar to warp browser, but it

displays  a  weft pattern

vertically.

Figure 180: Browse weft patterns

7.4 TOOLBAR

The Edit warp and weft pattern window has its own toolbar—actually there are two, one for warp and

one for weft.

 move warp to the left by 8 threads

 move warp to the left by 1 thread

 mirror warp pattern

 move warp to the right by 1 thread

 move warp to the right by 8 threads

 match warp pattern to weave size (if the weave size is already equal to the warp size,  then the icon

is grayed out )

 undo for thread pattern operations

 redo for thread pattern operations

 clear warp/weft pattern

To copy warp to weft,  or weft to warp,  or exchanging them use arrows next to the color bar.  The

operations copy (exchange) both pattern and the yarns.

 Copy warp to weft

 Copy weft to warp
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 Exchange warp and weft

There are three more icons which are not strictly related to changing the appearance of fabric:

 Remove or add spaces in pattern (instead of 1a1b1c1d it writes 1a 1b 1c 1d, which is easier for

reading).

 Sort pattern rewrites the pattern so that it starts with yarn A, followed by B, C...

7.5 DRAWING WARP AND WEFT PATTERN IN FABRIC WITH MOUSE

Beside the numeric way of entering the warp and weft pattern, you can draw it by mouse.

First, set the size of repeat, either as number of threads, or as length in mm, depending on your current

settings. Select the yarn (warp or weft), that you want to use. You can do it in yarn editor, color editor

or warp and weft entry window. As  you click it,  you will  see that the pointer color and shape will

change (to either cone  for warp, or shuttle  for weft yarn selection), and currently selected yarn

will be outlined in with a black and white rectangle.

To enable drawing warp / weft pattern with mouse, the Edit warp and weft pattern window, or Edit

colors window, or Yarns window should be opened, and the warp or weft pattern repeat should be at

least 10. On very short patterns, drawing by mouse does not make much sense, and we prefer to have

the pan (hand) tool.

There are two different modes of drawing warp and weft pattern with mouse: replacing and inserting /

deleting yarns.

7.5.1 REPLACING YARNS IN THREAD PATTERN

Click in the fabric on the yarn, that you want to replace. If you keep it pressed, it continues to draw. The

fabric changes in real time and the “complicated” warp or weft pattern is written automatically. You

can use it to draw completely new patterns, or just to change yarns in existing patterns.

The function also works on symmetrical patterns.

Figure 181: Drawing warp and weft pattern with mouse

 

7.5.2 INSERTING OR DELETING YARNS FROM THREAD PATTERN

To insert yarn into thread pattern with mouse use  Shift + left click. It will insert a thread left of the

clicked thread.

To delete yarn from thread pattern press Shift + right click on a thread, which you want to delete.

7.5.3 PROTECTED YARNS

In drawing warp or weft pattern with mouse, you can now protect yarn colors for easier editing of

complex patterns. In the warp/weft pattern bar, where you usually select the yarn color with which to

draw, you can double click a yarn, and it will become protected (shown by crossing out the yarn letter).

Then you can draw thread pattern in the design with a different yarn, and the protected yarns will

remain unchanged. This is most useful if you have an extra weft or fil coupé design, and you want to

modify the ground pattern to make it  more interesting.  Simply protect the yarns which you use as

“extra wefts”, and freely draw the weft pattern and only the ground yarns will be changed. The settings
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of protected yarns is purely for editing purposes, and it is not saved in the fabric file. Yarn protection is

cleared upon every loading of  a new design.  Yarn protection only  affects drawing the pattern with

mouse; you can still type a different pattern in the warp/weft editor.

In Figure  182 we want to change weft  c with weft  d just in one short segment. Normally we should

select weft d, and then click with mouse on every weft c, that we want to change.

Figure 182: Before drawing over protected yarns

 

But with protected yarns the task is much easier. Just double click wefts  a and b, select weft d, and

drag a mouse on the part, where you want to change weft c to weft d. It will change, protected a and b
will remain unchanged.

Figure 183: After drawing over protected yarns

 

Protected yarns have another useful function: they protect area in weave editor also – so you can draw,

copy, weave in the Weave editor, but weaving points “under” protected yarns remain unchanged. In

case that you have selection in the weave, protected yarns actually create a protected area (mask) in

selection.  If  you  load  another  weave  into  selection,  area  covered  by  protected  yarns  remains

unchanged.

7.6 ENTERING THREAD PATTERN AS SERIES OF LENGTHS OF DIFFERENT THREAD COLORS

Usually,  you  enter  a  colorful  thread  pattern  as  series  of  numbers  and  yarn  letters,  each  number

representing the number of repeating threads of particular color, like 3 threads of color a, 5 threads of

color  b,  and  so  on.  But  instead  of  number  of  threads,  you  can  use  the  length  of  particular  color

(millimeters or inches), followed by another length of different color and so on. When you finish, you

can change the “pattern unit” from millimeters back to threads by choosing  Threads from the option

menu (see Figure 184).
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Figure 184: Warp pattern, expressed in the number of threads per each color section, and same pattern
written in lengths of each color section in millimeters 

 

7.7 SPLITTING OR MERGING WEFT THREADS

This function can help against streaking, if you have uneven yarn in weft,

and you want to split one weft yarn across several cones. Choose Tools >

Split/merge  warp/weft from  menu  in  the  Edit  warp  and  weft  pattern

window. If you enter aef and only the yarn a is used in the pattern, then

weft pattern is rewritten, so that yarn a is split evenly among yarns a, e, f.

If,  on the contrary,  yarns  a,  e,  and  f are all  used in  the pattern,  they

merge into yarn a.

Figure 185: Split/merge
warp/weft window

7.7.1 RANDOM

It is more advanced method to prevent streaking because of irregularity weft yarn then normal split

method. First you need to enter the whole weft repeat, which you want to split ( 120a in Figure 186).

Then choose Tools > Split/merge warp/wefts. In new window enter wefts, which you will use instead of

single weft a (wefts abcd in Figure 186). Click on the OK button. Program randomly splits  the weft a
among wefts a, b, c, d and changes yarns b, c, d into yarn a; the repeat of the pattern is 120. However,

you can use same function in design purpose—just check the Keep yarns button, and program doesn’t

change the color of used yarns—you get random stripe design with repeat of 120 threads.
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Figure 186: Split weft in the Random mode with the Keep yarns option off and on  

7.8 SORTING

The  Sort option will  rewrite the pattern so that it  starts with yarn  A,  followed by  B,  etc.,  as this  is

required by production department of many mills. To use it, click  icon.

Figure 187: Using Sort function  

7.9 REMAPPING YARNS

The yarn remapping function assists  in  changing yarn letters  in  complex  patterns  (if  the pattern is

simple, simply retype it). For example, if you want to change yarn a to yarn c but there are 100 entries

with the letter a, retyping would be time consuming. However, with Remap yarns, you can do it in a

single step. To use the yarn remapping feature, navigate to Tools >  Remap yarns. Select whether you

want to remap warp or weft yarns in the Remap yarns window. Change the position of the yarn letter

with a mouse click.

Figure 188 shows an example of weft yarn remapping. Yarn a will be remapped to c, b will be remapped

to a, c will be remapped to e, d will be remapped to e, and e will be remapped to b.
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Figure 188: Remap yarn table

7.10 TWO WARP BEAMS

In the entry of warp and weft pattern window, you can specify two warp beams, and the way in which

the warp is split:

• By number of shafts.

• By thread in dent.

• By yarn.

• In half.

Some of the choices have a corresponding parameter, for example the thread in dent which goes into

second warp beam, or number of shaft which goes to second warp beam.

Figure 189: Two warp beams

7.11 ADJUSTING WARP SYMMETRY

It is  desirable to have warp symmetric with respect to fabric width, since this  gives more freedom,

when one wants to cut the fabric. The leftover in cutting can be much smaller if the warp is symmetric.

To achieve warp symmetry, you must first enter warp and weft sequence, and the number of threads in

fabric width in the Fabric > Consumption window. Then choose Fabric > Center (keyboard shortcut F7).

On the top of the window, there are four buttons (Warp, Weft, Warp blanket, Weft blanket) to select

which pattern will you center. Usually it is a warp; the other three are rarely used.

The fabric preview in the Center window consist from three sections: the left side of the fabric, the

right side of the fabric, and a gray jagged mark in the middle, which delineates both areas.

The slider serves as a tool for manual shifting of the pattern: as you slide it, you see what happens on

the fabric’s edges.
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The automatic mode works  in  two ways:  a simple  Automatic shifts  the pattern without taking care

about the weave, while Automatic without moving the weave shifts the pattern only for a multiple of

the weave width (it means that the weave is not shifted).

The warp repeat of a fabric sample displayed in Figure 190 is 224 ends, so this is the maximal number

for  which we can shift the warp. The numbers on extreme edge on left and right tell you how much

equal threads do we have on left or right. 

Figure 190: Adjusting the warp symmetry

When you press the Automatic button, program finds symmetry on its own, if it exists, moves the 

slider, and redraws a fabric preview, using new shift number. If you don’t like the result, you can 

modify it with slider.

Figure 191: Automatic centering of warp pattern 

When you click the OK button, the pattern is rewritten and fabric simulation refreshed. 

Symmetry can also be adjusted for warp blanket or weft blanket, so that the pattern motif is  nicely

centered in the space available within the blanket. Centering using weft blanket can also be useful for

shawls and bed covers (blankets in normal sense of the word), when your design needs to be vertically

centered on certain number of wefts. Just set the desired number of threads in the blanket’s weft, and

proceed with centering as described above. 

7.12 EDITING DECOMPOSED

The purpose of this function is to enable designers to easily enter complex warp and weft patterns with

one pattern on the face, and another on the back of the fabric, or to enter complex ground patterns in

the extra warp/weft fabric. In the Edit warp and weft pattern window, choose Tools > Edit decomposed.
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In the Edit decomposed window you need to select whether you want to edit warp or weft, and the type

of dividing. You can choose Custom (default), Denting (warp), Two warp beams (warp), Regulator (weft).

7.12.1 CUSTOM

The principle of editing in the Custom mode is the same for both warp and weft, so we will describe it

only for warp.

You have to specify the layout in the same way as in decomposed weave editor: enter 112 (it is not

number one hundred twelve; it is  first, first, second) to have first two threads in first warp, and third

warp in second warp. Or enter 3 to have three warps evenly divided (that would be the same as 123).

The program will take the existing warp pattern and will decompose it, using the given division, and

display you the editable divided warps. Up to 9 warps/wefts are supported.

Figure 192 shows warp pattern, consist of 96 threads. For two threads on the face we want to have one

on the back. In the Edit warp and weft pattern window enter 96a as a warp pattern. Then choose Tools

> Edit decomposed in the Edit decomposed window. Type the warp layout, which should be 112. The

program divides 96 threads into two layers: 64 threads in the first one, and 32 in the second one.

Now you can modify both layers. The pattern in the Edit warp and weft pattern window is written as the

combination of both layers.

Figure 192: Warp pattern decomposed

Once the program writes  the decomposed warp,  it  also  adds  the number of  threads  in  that warp

besides the number of warp. If you choose to modify the warp pattern, and press return, the program

will write two numbers - first is the number of threads, which this warp has at disposal, using current

layout and number of warp threads, and the second will be the warp length of current divided warp. If

the two numbers will not be divisible, the program will warn you with an exclamation mark besides the

two numbers. If you want to change the length of warp pattern, you may edit the total number of warp

threads.

7.12.2 DENTING

The second way of warp pattern division is by the number of thread in dent. Click the Custom button in

the Edit decomposed window, and select Denting from the list.

7.12.3 TWO WARP BEAMS

If you have the warp pattern split over two warp beams, you can use the Two warp beams option in

the Edit decomposed window.

7.12.4 REGULATOR

Dividing  by  the  regulator  as  a  criterion is  one  of  the most  used  function in  the  Edit  decomposed

window.  It  allows  you  to  edit  the  ground  weft  pattern  (which  is  in  a  solid  color  after  Jacquard

conversion in ArahWeave) separated from extra weft pattern.

Figure 193 shows the extra weft design with two extra wefts. We want to change the ground pattern

from solid color to 2a1d repeat. Instead of color b in the first extra weft we want to have color b and

e; in the second one we want to have colors c and f instead of c only. In the Edit decomposed window,
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click the Weft button, and select Regulator as a dividing factor. The program divides weft pattern into

three wefts: the ground is 300a, the first extra is 159b, and the second extra is 22c.

Figure 193: Weft pattern divided by regulator

 

Now  to  the  modifying  of  weft  pattern:  instead  of  300a type  300[2a1d],  instead  of  159b type

159[1b1e],  and instead of  22c write  22[1c1f].  After clicking  OK,  the new weft pattern is  also

displayed in  the  Edit  warp  and weft  pattern window. It  would be quite time consuming to write it

without the Edit decomposed tool.

Figure 194: “Complicated” extra weft pattern

 

7.13 DOUBLE WEFT INSERTION

If you need to insert two wefts at a same time

through  the  shed,  mark  the  Double  weft

insertion box in the Edit warp and weft pattern

window. It  should  be supported by the CAM

format  (dobby  and  Jacquard)  and  the  loom.

The weft pattern has to be written in different

way:  the  number  of  repeats  should  be

followed by two weft letters. In Figure 195 the

pattern  4ab  3cd means,  that  the  loom  will

insert 4 times a and b wefts, and then 3 times

c and d wefts. 

Figure 195: Double weft insertion
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7.14 FRINGE (WEAVING WITHOUT WEFT)
To  achieve  similar  effect  in  weft  as  it  is  empty

dentin  a  warp  pattern,  use  Fringe (weaving

without thread insertion).  It  is  used as  a design

tool, or to mark the end of “one piece design”, or

for  easier  cutting between two fabric,  or  to  get

fringes in blanket etc. To specify “weaving without

weft”, use yarn letter y in the weft pattern.

Figure 196: Yarn letter “y” marks weaving without
weft

To get a proper fabric simulation of fabric with fringe, you need to set technical data ( Threads in fabric

width,  Reed  width,  Finished  width,  Denting,  Weft  density)  in  the  Calculation of  thread  consumption

window (Fabric >  Consumption), and mark the Density from technical data button.  See Chapter 14 for

detailed explanation about Consumption and the fabrics’ technical data.

Figure 197: Fabric simulation with fringe

 

7.15 RESIZING WARP OR WEFT PATTERN

To scale warp or weft pattern to a new pattern size, choose  Tools >  Resize warp/weft pattern. In the

Resize warp/weft pattern window select either you want to resize warp pattern or weft pattern. In the

Repeat  (threads) field  enter  a  new  pattern  size  (number  of  threads).  Program  scales  pattern

proportionally.

If  you roll  the mouse wheel up or down, and the mouse cursor is  in the  Repeat (threads) field. the

repeat number is changing as you roll the mouse wheel. Program displays the fabric is interactively.

Figure 198 shows fabric before (warp repeat is 94 threads) and after warp pattern resizing (new repeat

is 32 threads).
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Figure 198: Resizing warp pattern

 

7.16 PATTERN GENERATOR

Pattern  generator creates  random  (or  partially  random,  partially  controlled)  patterns,  usually  very

complex, from the given set of parameters. To use parametric creation of warp/weft pattern choose

Tools >  Pattern  Generator in  the  Edit  thread  pattern window. The window has  several  buttons and

fields, many of which are exclusive. The fields, which do not have any effect in the current setting, are

grayed out. The window may appear to have many settings, but only about half can be active at a time,

so it is not so complicated as it looks. But we can combine them in various ways, so it is quite powerful.

In  the  Pattern  generator  window  select

whether you want to create warp or weft

pattern.  Program  takes  the  size  of  the

repeat  from  the  Edit  warp  and  weft

pattern window,  so  you  should  set  the

repeat to something which is big enough,

that  it  makes  sense  for  parametric

creation,  instead  of  numeric  writing.  In

the  most  simple  way  of  using  this

function,  you  combine  two  things:  the

yarns  to  be  inserted  (yarns  a,b,c,d  in

Figure  199),  and  the  lengths  to  be

inserted.  You  can  specify  the  Minimum

and  Maximum length,  and  program will

randomly  insert  yarns  sections  with  the

number  of  repeat  threads  among  the

limits, until it fills up the repeat.
Figure 199: Pattern Generator

When you set the parameters, click the OK button, and the program generates a pattern. If you click OK

again, it will generate a new one.
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Figure 200: Random weft pattern  

You can control the amount of each yarn inserted: if you enter  aaaabc (or  4abc) in the Yarn field,

then program will insert the yarn a four times more likely than b or c.

Figure 201: Random warp pattern

 

The  Yarns parameter has two options.  Allow equal consecutive means that is possible that one color

sequence is followed by the same color sequence based on the statistic probability. If this option is off,

then the program prevents following of one color sequence by same color sequence. So the lengths will

never be prolonged, since two consecutive yarn sequences will never merge in the same yarn letter. 

If the Follow yarn sequence option is on, then the program writes the pattern always following the yarn

order, which you have entered in the field, regardless the statistic probability. 

Instead of  setting the Minimum /  Maximum length range,  you can enable  Specify  lengths and the

program will allow you to specify the lengths of repeat of a single yarn which will be inserted. In Figure

202, the allowed lengths are 2, 4 and 6.
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Figure 202: Follow yarn sequence and Specify lengths options

 

As with yarn order, you can also enable Follow length sequence. It means that the numbers of yarns in

the pattern will be ordered as written in the Specify lengths field.

7.16.1 COMPLEX SHADING PATTERNS—OMBRÉ PATTERNS

If  you  enable  both  Follow  yarn  sequence and  Follow  length  sequence,  then  the  pattern  becomes

completely deterministic. It is very useful for long and complex shading patterns, where you repeat the

same numeric pattern over a sequence of different yarns. In this case, it can be difficult to find out the

final repeat length, so you have the Fix repeat option, which allows ArahWeave to overwrite previous

repeat size with the new one. You can use parenthesis in both the Yarns and Specify lengths fields. 

Suggested order of steps is: 

Mark both Specify lengths and Follow yarn sequence. Enter the length sequences. The sample in Figure

203 below starts with length 15 threads, then 1 thread, followed by 4 times 5 threads and 1 thread, and

so on (the whole length pattern is 15 1 4(5 1) 6(3 1) 8(2 1)  12 (1 1)  8(1 2) 6(1
3) 4(1 5) ). Then click the OK button, so the program calculates the number of color sequences -

there are  98 sequences,  and the number of  threads is  184.  If  we need more or less  threads,  just

change some numbers of the lengths, and press OK again. 

Then  go  to  the  Yarns section.  Since  there  are  98  sequences,  which  should  be  split  between two

neighboring colors, just type 49(ab), and continue depending on the number of colors which you want

to use. In this example we use four yarn colors, so we enter:  49(ab) 49(bc) 49(cd) 49(da).

The end result is quite a complex repeat of 736 threads.
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Figure 203: Completely controlled pattern

 

7.16.2 STRETCH PATTERN FUNCTION

If  you enter yarns  in  the  Yarns field (in  Figure  204:  aabcb),  and enable  Follow yarn sequence and

Stretch pattern, you are free to set the length of the repeat to whatever you want (on the sample we

use value of 500). The Stretch function will cause the program to stretch the pattern in the full width of

the specified repeat. This makes a pattern of 200A 100B 100C 100B.

Figure 204: Stretch the pattern

 

Obviously, this is not the purpose of this function. But you can set the length to 1, and Randomize to,

let’s say 150, and program will not only predictably choose the next thread, but will make a random

shading transition  between the two color  segments.  The higher the value of  Randomize,  the more

random the transition.
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Figure 205: Stretch with the Randomize option

7.16.2.1 RESIZING A PATTERN WITH THE STRETCH FUNCTION

We can also use the Stretch function to resize an existing pattern to a new repeat size. For example,

you can have the pattern of 356 threads, which you want to proportionally resize to 220 threads. You

should enable  Follow yarn sequence first, then  Stretch,  then use the  Copy pattern button, which will

copy the existing pattern of 356 threads in the Yarns field.

Figure 206: Fabric before stretching the pattern

 

Then set the Repeat number to 220 and click OK. This will proportionally resize the pattern. If you wish,

you may still  use  the  Randomize option with  this  function,  or  instruct  the program to rewrite the

pattern with specific lengths, for example by two threads, instead of one thread.
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Figure 207: Fabric after stretching the pattern

7.16.3 PATTERN GENERATOR AND PROTECTED YARNS 
An important feature of the Pattern generator is, that it doesn’t overwrite the protected yarns, if you

have them in the pattern. Figure  208 shows a fabric with extra wefts, where we want to modify the

ground weft. Normally, this is quite difficult, since ground pattern is all interlaced with the extra weft,

in an irregular way, depending whether the extra wefts are present at certain area or not.

Figure 208: Extra weft fabric with solid ground weft

 

Use double mouse click in the Edit warp and weft pattern window to protect the extra weft yarns (these

are: b, c, d, e, f). Once protected, they will be marked with an X.

Figure 209: Protected yarns

 

In the Pattern generator window you may now set the toggle button Skip protected yarns, which will

continue the sequence as if the protected yarns were not there. This will cause the ground pattern to
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have the same statistic properties in areas with and without extra wefts. Otherwise, the ground will

look different on areas with extra wefts.

Figure 210: Skip protected yarns option

 

After clicking OK, you get a new extra weft fabric...

Figure 211: New ground weft pattern

  

...with a complex weft pattern (Figure 212).

Figure 212: A complex pattern after splitting the ground weft
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7.17 GETTING WARP/WEFT PATTERN FROM IMAGE

ArahWeave has a function to get the warp/weft pattern from an image. ArahPaint has some great tools

for drawing random line patterns, so maybe it is easier for some designers to draw the image than to

write parametric pattern in ArahWeave. The number of used yarns in the pattern is equal to number of

used colors in the image. The program takes the first pixel column from the left to generate  a  weft

pattern, and first pixel row from the top of the image to generate a warp pattern.

To use the function, load the image in  the  jacquard conversion (Weave >  Jacquard conversion),  and

then choose Tools > Get warp/weft pattern from image. Select warp or weft, and the length of the final

repeat (number of threads in the repeat). If you enable toggle button Yarn colors, the colors from the

image will also be copied into yarn colors, for easier orientation.

Figure 213: Getting warp/weft pattern from image
 

After clicking OK, the thread pattern is applied to the fabric.

Figure 214: After applying Get warp/weft pattern from image – the yarn colors
are taken from the image

 

You can use same image to generate warp pattern. Click   icon from the  Images menu to flip the

image for 90 degrees. Select Warp, set the repeat size, and click OK.
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Figure 215: Getting warp pattern from same image as weft pattern

 

7.18 SQUARE DESIGNS WITH DIFFERENT WARP AND WEFT DENSITIES

First  enter the warp pattern in  any way you like.  Then set the warp and weft density.  Convert  the

pattern from Threads to millimeters (mm), and click  icon to copy warp to weft. Then convert mm

back to Threads.

7.19 EXCHANGING WARP AND WEFT (ROTATION BY 90°)
In the Fabric menu, there is a function Warp<->weft which swaps warp and weft. It also exchanges all

colors, yarn parameters, densities, denting / regulator pattern and rotates the weave by 90 degrees.

The function is reversible, which means that applying it twice will give you the initial position. You will

not lose any data if you apply it. Unfortunately, for fabrics with denting / regulator, it is not possible to

exchange densities for warp and weft in automatic way, since we have weft density on one side, and

raw width, final width, reed number, etc. on the other side. So in these cases, some manual editing is

necessary to put things in a sensible relationship, if you would really want to exchange warp and weft.

8 COLORS

ArahWeave® uses three different color models for displaying fabrics: RGB (red, green, blue), HSL (hue,

saturation, and lightness), and CIE Lab.

CIE  L*a*b* (CIELAB)  is  the most  complete  color  space

specified  by  the  International  Commission  on

Illumination  (French  Commission  internationale  de

l'éclairage, hence its  CIE initialism).  It  describes  all  the

colors visible to the human eye and was created to serve

as  a  device  independent  model  to  be  used  as  a

reference. Unlike the RGB and CMYK color models,  Lab

color  is  designed  to  approximate  human  vision.  Its  L

component  closely  matches  human  perception  of

lightness. A large portion of the CIELAB coordinate space

cannot  be  generated  by  spectral  distributions.  These

coordinates therefore fall  outside of human vision and

are not truly "colors". Figure 216: CIE Lab color model

In ArahWeave, screen RGB colors and print RGB values are matched for a particular printer / screen

based on CIE Lab values that provide device independent color matching. The word “match” which is
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used later in the text, always means match within the limits of a particular color generation technology

and the parameters / capabilities of the device where the color is being rendered (monitor, printer),

not  a perfect  match against  either  PANTONE®-identified solid  color  standards  or  a  particular  color

specified in the CIE Lab color space.

8.1 THE COLOR EDITOR

Chose Fabric > Colors to open the Color editor. It consist of five sections:

• the title bar information (the name of color palette and the number of colors in it)

• the color palette

• the color palette preview area showing all colors from the palette

• warp and weft colors

• the color editing area

8.1.1 LOADING/SAVING A COLOR PALETTE

When you open the Edit colors window, the default color palette is already loaded in the window. To

load a different palette in the Edit colors window, just choose  File >  Load colors,  and select a color

palette file from the Load colors dialog. Alternatively,  you can use  Choose,  which lists  all  files from

current directory, and you just click a file from the drop down list to load it into Edit color window.

If you make changes in the color palette, you can save it under new (or old) name with File >Save colors.

Warp and weft colors

Color palette

Color palette preview 

Color editing area

Color palette's name

Number of colors in the palette
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8.1.2 CHANGING THE NUMBER OF COLORS IN THE PALETTE

The number of colors in the palette is displayed in the window’s title bar. You

can change the number of colors in palette with  Number of colors from the

Change menu in the Edit colors window. If you increase the number of colors,

new colors will be added at the end of palette. If you decrease the number of

colors, colors will be deleted from the end of palette.

Figure 218: Changing
number of colors

8.1.3 ADDING OR DELETING COLOR FROM THE PALETTE

You can add new color next to the selected color in the palette by

clicking  button in the Edit colors window. To delete selected

color, click  or press the Delete key on keyboard.

Figure 219: + and – for adding or
deleting color from the palette

8.1.4 CHANGING THE NUMBER OF COLORS IN THE PALETTE DISPLAY AREA

In the Number of colors dialog you can also change the appearance of the color palette—the number of

color tabs in the row, and number of rows in the palette display area. 

8.1.5 COPYING COLORS FROM THE PALETTE TO THE PATTERN COLOR BAR

If you want to copy currently selected color to

another entry (warp, weft or palette color) just

point to it and press right mouse button. If you

want  to  swap them,  do  the same;  just  press

middle mouse button.

Figure 220: Copying color from palette to the yarn color
bar with right button click

8.1.6 CREATING A CUSTOM COLOR PALETTE FROM THE EXISTING PALETTE

You can create a custom color palette with a help of the Variants dialog window.

Open ArahWeave. Load a fabric which has at least six different colors in weft, or simply change the weft

pattern to something like 1a1b1c1d1e1f. Choose Blanket > Variants to open the Variants dialog window.



11 0    C hap t er  8   
 Col or s

www.arahne.si  

Figure 221: Opening the Variants dialog

 

The number of variants is set to 1 by default. Make some room for the color palette you will create by

increasing the number of variants. We got 48 boxes for colors in the Variants dialog in Figure  222. If

you need more colors, just increase the number of variants.

Figure 222: Setting the number of variants

Open the Edit colors dialog window (Fabric > Colors..). If it is not already there, load a color palette you

want to choose colors from. Click the Variants tab. Select the color with left mouse click; paste it into

the Variants with the right mouse click.
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Figure 223: Pasting colors from the color palette to the variants

 

Continue until all color fields are filled with your selection. Then choose Change > Make color atlas from

variants. 

Figure 224: Creating a new color palette

 

Before you save it, be sure that it doesn’t contain properties (especially the name which is displayed in

the Palette title-bar) from the previous palette. Open the Color properties dialog window ( Change >
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Properties),  and enter new data in the properties window. The Name will be displayed in the window

title bar.

Figure 225: Editing the color palette properties

Save the color palette for future use (File > Save colors…). Type in the new filename and click OK.

Figure 226: Saving the color palette
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8.2 EDITING A COLOR

Select the color that you want to edit (warp, weft, or a palette color) by pointing to it and pressing the

left mouse button. The currently selected color is displayed in the lower right angle of the Edit colors

window. 

ArahWeave uses two fundamentally different color models: the CIE Lab model and the RGB model. 

Whatever model you prefer, the editing of color is the same: entering the values in the text fields or 

changing them with sliders.

1. The CIELab model: select it and enter Lab values

or  set  values  with  sliders  for  the desired color.

Press Enter after entering the value (or just click

into  another  field).  When  the  CIE  Lab  value  is

entered, the most appropriate color is generated

automatically  based  on  the  currently  selected

printer and screen profile.

If you want to switch back to the RGB model, you must put all three values (L, a, and b) to zero,

then switch to the RGB model and edit the RGB values.

2. The RGB model: color can be entered in either RGB

(Red,  Green,  Blue)  or  HSL  (Hue,  Saturation,

Luminosity)  model.  The  RGB  model  is  natural  for

monitors and all three values can be varied from 0 to

255. The HSL model is just another view at the same

color, where Hue is the angle of the color on the color

wheel from 0 to 359, while Saturation and Luminosity

vary from 0 to 1000.

Besides  changing  the  RGB  values  with  a

slider or typing them manually, you can use

the Color Picker dialog  to choose a color.

Click the Color picker icon   to open the

Color  picker  window.  You  can  modify  a

color using one of the following ways:

• Choose a color from Basic colors, which

becomes your selected color.

• Drag a cursor in  and  to define the

color in the color space.

• Getting a  color  from any  pixel  on  your

screen: click the Eyedropper icon   in

the  Edit  colors  window  or  the  color

picker window. By clicking a point on a

screen,  you  change  the  color  to  that

which is  located under the pointer. It is

useful  if  you  have  a  scan  of  fabric  or

yarn,  and  you  want  to  use  the  same

colors in ArahWeave.

Figure 229: The color picker dialog

Figure 228: Editing RGB values

Figure 227: Editing Lab values
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8.3 MATCHING YARNS TO THE COLOR ATLAS

Use it (Change > Match yarns to color atlas) when you want to replace colors of the yarns used in the

currently loaded fabric with the closest matching colors from the color library. It is useful when you

have set the colors in RGB,  for instance with the  Eyedropper tool  ,and you want to replace them

with colors  from your production color library,  or your customer’s  color library or with PANTONE®

colors.

8.4 COLOR DIFFERENCE (dE)
One of the unique features of ArahWeave is that the program gives you feedback on the screen and

print accuracy of the selected color. This is indicated by the dE values on the right side of the color edit

window. If it displays a value of dE smaller than 2, it means that you are within the color gamut and

that color is reasonably accurate. If you have a dE of 15, you know that you will not get the desired

color. In this way, you can at least warn your customer that this particular color is  not correct, and

attach a yarn sample  to the printed fabric  simulation.  Note that the predicted dE is  usually  overly

optimistic  since it  represents  the difference of  the desired  color  and the color  found by  the color

matching engine of ArahWeave. We did an experiment and printed out our simulation of all PANTONE®

colors, remeasured them, and compared the predicted color with the actual simulated color. The dE

was smaller than 2 for 92% of colors and smaller than 3 for 99.5% of colors. There were no prediction

errors bigger than dE 4. So you can be reasonably confident in the program’s prediction.

8.5 FINDING CLOSEST COLOR

We suggest using the Lab model for your color libraries. But sometimes it is easier to set the color in

RGB mode, or for instance, you find an interesting color on your Desktop or in some other application

and you have just RGB values of that color. Enter those values in ArahWeave and use the Find closest

color function from the Change menu.  The program will find the closest color in the currently loaded

color database. It  will  also display  the dE value if  both colors  are CIE Lab based.  Otherwise,  it  will

perform the comparison only based on screen RGB values.

8.6 BACKGROUND COLOR

The last color at the right end of the warp / weft color bar, labeled

#, represents the color of the background, and is used to render

empty space on transparent fabrics in simulation view. It is saved

along with fabric data.

8.7 SORTING COLORS IN A PALETTE

You can sort colors in the Color file by the following criteria: Code, Name, CIE L (Luminosity), CIE a-

redness, CIE b-yellowness, CIE H-hue, CIE C-chroma, CIE dE-the color matching error in print). 

You can also sort colors manually by drag-and-drop.

Figure 230: The color of the
background
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8.8 FINDING COLORS

If you have got a color name or code and you

have loaded the color atlas that contains the

color with that code / name, you can use the

Find color  function.  You  can  activate  it  by

pressing the lens icon   at  the  right of the

color  name  entry  box  (middle  right  of  the

color edit window), or from the menu. Type in

the window text of the code or name (or just

some part of it),  and press Enter. It will  find

the  first  occurrence  for  that  color  and

highlight (select) it. You can then click on the

OK button again  to  find  other  colors.  Use  a

forward or backward arrow to search forward

and backward. Capital and small letters do not

make a difference in search.

The Color bar at the right side of the Edit colors window is additional help for fast finding a color in a

color file. The Color bar shows all the colors from the currently opened file. If you click on a color in the

Color bar, it becomes the selected color in the color display area.

8.9 PRINTING COLOR DATABASES

You  can  print  the  Color  databases  by  selecting  the

function  Print  colors from the  File menu in  the  Edit

colors window.  You  will  be  prompted  by  the  print

window, where you will  be able to select  the  printer

type and size  of  your  print,  as  well  as  a  number of

lines that you want to print. The number of colors per

line will be equal to your screen settings (Figure 232),

and the starting line (row) of your color database print

will also correspond to your position on the screen. To

simplify  your orientation in a big color database, the

line  number  of  the  currently  selected  color  is

displayed at the top right position of  the  Edit colors

window.

Figure 232: Setting number of colors (rows)

By enabling the Title toggle button in the Print colors window you get a color name and code printed

below each color. Then you must decide about the number of printed rows: in Figure 233 the number

of printed rows is 15.

Figure 231: Finding color in the color library
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Figure 233: Print color window and Print preview
 

PANTONE  Textile  Color  System®  palette  is  a  standard  part  of  ArahWeave  distribution.  PANTONE®

Computer Video simulations or printed simulations may not match PANTONE®-identified solid  color

standards. Use current PANTONE® Color Reference Manuals for accurate color. Same applies for the

printed simulation of  PANTONE®-identified solid  color standards.  The suffix CVT is  used to indicate

screen simulation, while CHT indicates printed simulation, of the PANTONE Textile Color System©.

8.9.1 UNDERSTANDING COLOR GAMUT

To avoid any misunderstanding regarding color accuracy, you should understand the notion of color

gamut.

One common mistake is to link the actual number of displayable colors with color accuracy. When we

were making the transition from 8-bits graphics cards with 256 colors to 24 bits per pixel graphics card,

we said we now have 16 million colors at our disposal—in a sense—we can do any color we like. Surely,

it  was a big step forward, but it  has nothing to do with color accuracy. Actually,  we could have 16

million levels of gray between black and white. We need much more for color accuracy—primary colors

that have the most extreme values in CIELab space, then a method of color mixing which makes them

as predictable and linear as possible. And finally, a method of finding the desired color out of those we

can generate.

ArahWeave will find the best possible color, but it cannot make a color, which is not within the device’s

color gamut. In the following pictures, you can observe the gamut of two commercial color atlases and

one ink-jet printer. Notice how the areas which they cover are quite different. First group of colors

represents a projection of L versus a, second is L versus b and third is a versus b. Since we want to

reproduce them on the ink-jet printer, we can indicate out of gamut colors (dE  > 5) with a small point.

All measurements were executed using GretagMacbeth Spectrolino, D65 light, 2 degrees angle.
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If you observe the color gamut of all PANTONE Textile Color System®

colors, you will note that PANTONE colors are really a collection of

colors without strict ordering in a mathematical sense. In fact, some

colors have very extreme out-of-gamut values,  which makes them

impossible to reproduce on any ink-jet printer.

Figure 234: PANTONE Textile
Color System®

The color gamut of all RAL©  colors demonstrates that most of its

colors are within the gamut of the ink-jet printer. Note that RAL's

method  is  really  based  on  CIE  Lab,  since  you  can  see  the

geometrical  distribution  of  colors,  which  enables  you  to specify

intermediate colors with RAL.

Figure 235: RAL Design System©
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Figure 236 shows the color gamut of Epson Stylus Photo 750/1200,

a 6-color ink-jet printer, represented by 5832 colors, which are the

basis  for our printer’s  color profile. Note that the color gamut of

ink-jet  printers  depends  a  lot  on  the  printer  driver.  We  have

developed our own printer drivers, which aim for large color gamut

and linearity in color reproduction. The supplied drivers, which we

have examined, mainly aim for reasonable reproduction of screen

RGB to printed output, and score poorly both on linearity and color

gamut.

Figure 236: Epson Stylus Photo
750/1200

8.10 SAVING COLORS FROM LIBRARY AS IMAGES

To  enable  this  function,  you  have  to  switch  to  Expert mode  (Mode >  Expert in  main  ArahWeave

window). Then open the Edit colors window (Fabric > Colors), and choose File > Save colors as images.

When you open the Textures browser, there will be a folder with the same name as the color library file

and all  the colors  from  the library will  be in  graphics format,  so you can load them as textures in

ArahDrape.

Figure 237: Saving colors as images

8.11 IMPORTING COLORS FROM A TEXT FILE

If you have a¸ spectrophotometer, which can write measured colors as CIE Lab values to a text file, you

can import color measurements to create ArahWeave's color library file.  The text file must have the

following format (you can edit it with any common text editor):

#COLOR_SAMPLES=4

34.25 -17.32 -3.25 Code1 Name1

64.87 37.01 -14.15 Code2 Long_name2

55.01 12.67 23.55 Long_code3 Name3

42.68 -6.81 -13.87 Code4 Name4
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The first line contains the indicator on how many colors are in this file. Then we have one color in each

line. The first three numbers are CIE L, a, and b values, then there is optional color code and name. If

you want spaces in color name or code, use underscore  _. It will be transformed to space character

when the file is read. You can have up to 250000 colors in one file, which should be sufficient for most

cases.  The  file  name  must  have  the  .cm suffix,  so  the  program  will  know  that  this  is  color

measurements.

You  must  copy  the  text  file  with  CIELab  values  to  the  colors  folder,  where  the  colors  are  held.

Typically, this would be: 

/home/user_name/data/colors/myYarns.cm
Once you make such a file, you can load it with the function Load color measurements  from  the File

menu in the Edit colors window. Before you do this, you should increase the number of colors in  the

Change menu, so you will have enough space for these newly loaded colors. Colors will be loaded to the

position of  the selected color in  the color database.  In this  way, you can easily  add new colors  to

existing databases. Colors will be matched for screen and printer automatically as you load them, based

on current screen and print profile.

To use the newly constructed color database in another work session,  save it by selecting Save colors

from the File menu.

8.12 RANDOM COLORS

You can use this function, if you want to discover new color combinations of your existing design. Load

the color database that contains the yarn colors of your current collection. If you have too many colors,

copy the ones you want to use to the few first places of the color palette, and reduce the number of

colors in the palette to the desired value. If you then call the Random colors function from the Change

menu, the colors from the palette will be copied at random to the warps / wefts which are used in the

pattern. When you find something that you like, just save the fabric.

8.13 COLOR CROSS-REFERENCE

Sometimes it is useful to compare two color databases and map one to another. You might want to find

the  closest  colors  from  a  commercial  atlas  for  your  yarns,  so  you  could  communicate  them  to  a

business partner, who does not have your yarn database. Just load your yarn color database, select the

Cross reference to function from the  File menu in the  Edit colors window, and select the other color

database. Program will find the closest colors and replace the names of your colors with the codes of

the other database. The original codes will stay in place, and color values will not change.

9 CONVERTING IMAGE INTO JACQUARD WEAVE

9.1 ABOUT JACQUARD CONVERSION

The Jacquard image conversion enables the user to convert an image into Jacquard weave. To open the

Jacquard conversion window choose Weave > Jacquard conversion from the main ArahWeave window.

If there is already an image saved in a fabric file, then the image, its corresponding weaves and settings

are displayed in the Jacquard conversion. If there is no image saved in the fabric file, then the image

and weave sections in the dialog window are empty (Figure 238).
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Figure 238: Default Jacquard conversion dialog
  

The Jacquard conversion window has its own menu bar. To load a picture choose Images > Load image

or Images > Browse. 

ArahWeave differs from some other CAD programs, since the image does not contain weft control fields,

such as weft selector information, in the image. ArahWeave takes this information from  a fabric file:

regulator from the Weave editor, weft change from the Edit warp and weft pattern window, variable

weft density from the Set weaving density window.

There  are  four  ways  to  change  zoom  level  in  the  Jacquard  conversion window  (similar  to  main

ArahWeave window, and Weave editor):

• Press the plus key + to zoom in, or press the minus key – to zoom out

• Press Ctrl on the keyboard and roll the mouse wheel up or down

• Use the Zoom menu

• If you press any number from 0-9 on the keyboard you will  change zoom directly to that level (1

means 100%, 6 means 600%, 0 means 1000%).

As usual in ArahWeave, mouse coordinates in the image are displayed on the right edge of the menu-

bar. Window title displays image filename, number of colors, dimensions and current level of zoom.

Beside Normal Jacquard conversion  (default type—you have to select a weave for every color), there

are five  additional ArahWeave types of jacquard conversion: shading, extra weft, fil coupé, and weave

blanket.

9.2 LOADING AN IMAGE INTO THE JACQUARD CONVERSION WINDOW

To load an image into the Jacquard conversion window, use the Image browser. Open it by Images >

Browse from the Jacquard conversion window. Thumbnails (reduced-size versions of pictures, used to

help in recognizing and organizing them) of image files are displayed to identify each image. Do one of

the following to load the image into the Jacquard conversion window:

• double click in the thumbnail of the image.

• select the thumbnail of the image and then click OK or press Enter.
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Figure 239: Browsing images

The text labels below the image icons have different background colors. Currently selected image has a

text label  in  yellow,  so you can quickly  find it.  Bi  level  (black and white) images have a light  gray

background of the filename area, and true color images have a background in light pink. Color palette

(8-bit)  images have it  in  white. So you can quickly distinguish jacquard cards or weaves (black and

white), scanned images (true color) and cleaned up palette images.

The meaning of icons in the toolbar is described in the table below.

one directory up

back

forward

reload

default directory

switch to detailed view, switch to icon view

sort order

find image

create new directory

rename image

delete image

open selected image with ArahPaint4 (same as middle mouse button click on image

icon)

Filter option allows you to search for particular images by size x, size y, size xy, number of colors, date of

creation, and file name. If you use the file name filter, the program will interactively change the display

to show you only the pictures, which match the search filter. In this way you will find your image very

quickly.

To preview an image, position the pointer over a thumbnail and click with the right mouse button. The

Preview window in a full screen mode will appear.
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Figure 240: Full screen preview of selected image
 

The arrow keys (← ↑ → ↓) move the image in the window in the desired direction. Default view size is

set to 100%, the repeat view is on. Press F on the keyboard to fit the image in the window. Use + and –
or Ctrl+mouse wheel  to zoom in or zoom out (or  1,2,3,... for zoom 100%, 200%, 300%...).  R toggles

between  the single image view and the repeating image view. The  Page Down key loads the next

image, the Page Up key loads the previous one. The Home key loads the first image in the directory,

the End key loads the last one. 

To close the Preview window press the Esc key, or click with the right mouse button in the window.

When you navigate to the image directory for the first time, the image browser has to recognize images

and create image thumbnails from the images. When you scroll up or down, it instantly creates icons for

files which appear in the visible area. If the files are big, the thumbnails’ creation time may increase.

That might cause some lag while scrolling. To avoid a lag—press  Alt+Q.  The  browser will  create all

thumbnails at once, even for files, which are not in the related display area. Note, if you have a lot of

files in that folder, you may have to wait some time for  the program to finish creation of thumbnails.

The next time, when you enter that image directory, the image browsing will be much faster, because

the thumbnails were already created.

9.2.1 THE DETAILS VIEW

The image browser also supports the details view, which displays each file in a separate line, as a file

name followed by information about the image: Name, Date, File type, Size x, Size y, Colors, dpi X, dpi Y,

File size. You can sort images by any of these criteria. To change the sort key, click in the title of the list.

A column of this property is highlighted in yellow. To switch from icon view to detailed view click 

icon, to go back click  icon.
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Figure 241: Detailed list view of images

9.2.2 BROWSING SUBDIRECTORIES

Arahweave’s browsers have a capability of showing files in sub-directories. This is very useful, when you

search for a file, and you don’t know in which directory you have saved it. If there are sub-directories in

your parent directory, then the Image browser displays the “leafless tree” icon  in the upper right

corner of the window (in  the same line as a directory path). To display all files from  sub-directories,

click the tree icon. It changes to the “tree with leaves and fruits” icon  , which means that the Image

browser shows all  files from the parent directory and its  sub-directories. If  the image is  in the  sub-

directory, then the name of the sub-directory appears in the image icon.

You should be careful when using this option, since it may take a very long time to finish and display the

images.  Especially if you enable it at the start of your disk (/).  The program will not crash, but it  will

read all the files on your hard disk, and this  can take a lot of  time.  You should only use  sub-directory

browsing of directories which actually contain the images.

9.3 INSERTING WEAVES IN JACQUARD CONVERSION

Each color of the image gets a tab in the color bar below the i mage area. By default, the color tabs are

sorted by the relative percentage of a color in the image. If you want, that ArahWeave sorts colors like

they are written (saved) in the image file, disable the Sort Jacquard image colors by the popularity option in

the Weaving section of the Save setup window.

The  Normal conversion  is  the  default  setting  of  the  Jacquard  conversion  dialog.  In  that  type  of

conversion you should load a weave for every color. There are two ways to choose a color, in which you

load a weave:

• click a color in the palette bar below the image

• click a color pixel in the image in the Jacquard conversion window
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Figure 242: Jacquard conversion window prior loading the weaves

 

To load a weave into the selected color,  use Choose weaves >  Load weaves. You can also  Browse the

weaves graphically,  as in  weave editor.  The weave browser is  accessible  through  Choose weaves >

Browse or you just double click on the weave area in jacquard conversion, and the program pops up the

weave browser. If you double click the weave, it loads into the currently selected image color. If the

size of the weave doesn’t divide the size of the final jacquard image, its name is displayed in red. So you

should choose only weaves whose names are drawn in black, or be really sure of what you are doing.

Weaves, which will replace the particular color in the image, is graphically displayed below the color

tab. In the color tab, there is the number of the color and the percentage of this color in the image.

Below that, you have the weave name, weave repeat and maximum floats of the weave.

Figure 243: Weaves in the Jacquard conversion

 

You can copy or exchange the weave as in other parts of the program: copy with right mouse button,

exchange with the middle button. 

You have a choice of grid size, so they can be displayed bigger or smaller. Weave repeat is marked as a

red-gray points combination. If you click on the Color toggle button (Figure 244), you can see the weave

in the colors of warp / weft pattern in the view mode and the zoom level of the current fabric in the

main Arahweave’s window.
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Figure 244: Color option in jacquard conversion 

 

The OK button in the lower left corner of the window serves for applying the weaves and generating

the full jacquard weave.

Figure 245: Fabric simulation of the Jacquard fabric after conversion

 

9.3.1 MODIFYING WEAVES IN JACQUARD CONVERSION (TOOLBOX)
On the right edge of the weave selection window, you have the usual weave modifying tools: negative,

shift up, down, left, right, rotate 90 degrees, mirror horizontal, mirror vertical, clear. These functions

are the same as in the weave editor. When you use them, you modify selected weave in the Jacquard

conversion window.

If you need to apply  the same type of change to all weaves in the Jacquard

conversion window, enable the All option. For example, you have a selection

of 200 weaves in jacquard conversion, but your weaves need to be shifted by

one, because of  a  different warp sequence. Now you can simply enable  All

and shift them by one thread using a single mouse click.

9.3.2 EDITING WEAVE FROM JACQUARD CONVERSION IN WEAVE EDITOR

Sometimes you want to modify the weave which is already loaded in the Jacquard conversion window

with the powerful  tools  of the Weave editor, like copying, editing decomposed etc. So you need to

move the weave into the weave editor, and to do this, click the Weave-to-editor icon . Your selected

weave is copied to the weave editor which pops up. After you finish with editing, click the Weave-from-

editor icon  to put A weave back into selected weave position in jacquard weave selection. In this

way, you can quickly change the weave without needing to save it under a new name, and loading it

again in weave selection.

Figure 246: The All
option 
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9.4 OPTIONS AND SETTINGS IN JACQUARD CONVERSION

9.4.1 TYPE OF JACQUARD CONVERSION

Besides common conversion (Normal),  where you replace one color with one weave, there are five

additional conversion modes,  accessible through the drop down list: Shading,  Extra wefts,  Fil coupe,

and Weave blanket. 

Figure 247: Choosing type of conversion

 

9.4.2 JACQUARD WEAVE SIZE

Two text  fields  below the weave area,  one  for  warp and one for  weft,  determine the size  of  the

Jacquard weave.  Usually, the weave size is equal to the size of the image, loaded into the  Jacquard

conversion window (Figure 248). 

Figure 248: Jacquard weave size is same as image size

 

9.4.3 CHANGING THE JACQUARD WEAVE SIZE

You can change the Jacquard weave size in a two ways:

• Choose the multiplication factor of the original image size from the drop down menu . You

have a possibility to select any multiplication from 1 to 16. In Figure 249, multiplying by two (x2) is

used for warp, and multiplying by three (x3) is used for weft. Blue color of the multiplier factor

indicates that it was used to determine the weave size. If we change the number manually (Figure

250), then its color turns to black.
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Figure 249: Jacquard weave size changed by multiplying
 

• Type desired size in the fields.

Figure 250: Jacquard weave size changed manually

9.4.4 DENSITY (CHANGING THE WEFT SIZE)
If  you  click  the  Density button,  the  number  of  wefts  (image  dimension  in  vertical  directions)  is

calculated from the fabric density, which is set in the Set weaving density window (Fabric > Density).

9.4.5 DIVISOR OPTION

This option allows easy multiplication of a single design, when we want to repeat it several times into a

defined area. The divisor option menu is available on the button  besides the final weave size field

in the Jacquard conversion window. By default, it contains the value /1, which means you only repeat

one picture motif in a defined area. But you can change it to /2, or /3, or /4... to force several repeats (2

or 3, or 4, ...) of the picture in a defined area.

This can be handy, when you want to repeat the motif several times by a value, which is not divisible by

the hook number. Figure 251 shows an example, where we want to repeat a motif with size of 200 by

200 pixels  across  the width of  1200 hook jacquard 7  times.  Since 7  does not divide 1200 without

remainder, you would again have to go in ArahPaint, repeat the motif 7 times, scale the resulting image

to 1200, save it, load it in ArahWeave, and only then do the jacquard conversion. But, ArahWeave gives

a direct solution: set the divisor factor to /7. Program will repeat a motif 7 times in the defined area

(1200 by 200).
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Figure 251: Using divisor

 

This  feature is  also useful,  when you are inserting weaves larger than the original  motif. It  is  quite

common to have a motif, which you want to repeat several times across the full jacquard width, for

example 2400 hooks. It is very easy to do, since the program does this automatically. But if the weave,

which you are inserting, has itself a larger repeat, for example the whole 2400, then it will be cut off at

the end of each smaller repeat, although the small repeats will be repeated correctly. Up to now, you

had to go in the paint program, repeat the image there as many times as you needed it, load it back in

ArahWeave, and load the weaves there. It works both in warp and in weft, and is also saved in a fabric

file.

The design multiplication works both on normal conversion, as on extra weft/fil coupe conversion.

9.4.6 SYSTEM OPTION

Some multi-layer fabric construction requires multiplying of image pixels to get nice contours between

different weave effects on both sides of the fabric. Normally you have to take care about image size

before transforming  it  into Jacquard weave,  but if  you have not,  here is  the  System option in  the

Jacquard conversion window. Actually, it is some kind of image resizing.

For example, you want to create a design with two layers in the warp, and three layers in the weft.

Design repeat is 1200 by 900 threads—so the image size should be 600 by 300 pixels, and you get the

final size by multiplying the width of image by 2 to get 1200, and height of image by 3 to get 900. 

If the image size is not 600×300 pixels, but you still want to have a 1200×900 design, there is another

way: In the System section enter 2 for warp, and 3 for weft. Enter 1200 in the Warp field, and 900 in the

Weft field. Click  OK. Program first scales the image to  600×300 pixels,  and then multiplies it by 2 in

warp directions, and by 3 in weft directions to achieve a final size of 1200×900 pixels.
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Figure 252: System option

 

9.4.7 INSTANT CONVERSION

If  the Instant conversion toggle button is on, then the program calculates and redraws the Jacquard

weave after every single change of the weaves in the weave selection area, so you don't have to click

on the OK button. You mostly need this feature when you shift weaves for one point for getting nicer or

more regular boundaries between warp and weft satin weaves.

9.4.8 KEEP WEAVE SIZE

If you enable the Keep weave size  toggle button, then the size of the jacquard weave (written in the

Warp text box and the Weft text box in the Jacquard conversion window) stays the same after loading a

new image. Otherwise, the size is reset to the size of the loaded image.

9.4.9 POINT TIE SIMULATION

Instead of simply repeating the pattern side by side, you can, using a special harness on a loom, mirror

a design to create a symmetrical design, which appears twice as wide. The image is just a half of design,

because mirroring is done on a loom.

If you want to see the simulation of a fabric, as it will be woven, switch the Point tie simulation toggle

button on, and enter the hooks (threads) order in the Point tie simulation field. In Figure 253, we have

300 hooks, which are mirrored into  the repeat size of 598 hooks. The point tie simulation should be

written as 1-300 299-2. You can also have more complicated settings.
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Figure 253: Setting the Point tie simulation

 

Figure 254: Point tie fabric simulation

 

9.4.10 FIX SATIN

Sometimes, using two opposite satin weaves (warp and weft effect)  doesn’t give  the  desired result:

boundaries between two weaves are jagged or uneven. You may try the Fix satin option, maybe you will

get a better result.

9.5 GRAYSCALE SHADING

When you are using grayscale shading, you only need to load one weave, even if you have many shades

in the image. Image should be in grayscale mode, which uses up to 256 shades of gray. You can convert

both indexed-mode (8-bits per pixel) and true color (RGB) images to grayscale, either in ArahPaint or in

Jacquard conversion (Images > Mode > Grayscale).
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Figure 255: Converting image to grayscale mode
 

Then load one weave, which must have exactly one black point on each weft and at least on black point

on each warp. Any weft satin weave will do the job. Choose Shading as a type of conversion, choose the

direction of adding points ( ), you can modify a brightness,  and click OK. Program transforms

the image into Jacquard weave.

Figure 256: Grayscale image to weave conversion
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You can adapt the level of brightness in the generated weave with modifying the

line  in  the brightness  tool.  To alter the brightness  line,  click one of  the little

squares that indicate control points of the line, and drag it to the desired location.

Please note,  that the brightness  change will  not  affect the image itself,  it  will

manifest  in  the generated weave. Every time you change the brightness, apply

the conversion  by  clicking  the OK button (or  just  have  the Instant  conversion

enabled – the program will recalculate the weave every time you move the control

point of the brightness line).

9.5.1 COMBINING GRAYSCALE AND NORMAL JACQUARD CONVERSIONS

You can use grayscale shading in some parts of the image, and normal weave insertion on other areas.

Type of conversion should be  Shading. For “gray part” of the image,  ArahWeave constructs a weave,

based on loaded weft weave, but for the rest non-gray colors, you have to load a weave for every color.

Figure 257: Grayscale shading, combined with "normal" Jacquard conversion

 

9.5.2 DOUBLE OPTION

The Double  option enables  creation of  two color  shading  effects  on fabrics,  which  have only  weft

threads on the surface. Generally it means blanket fabrics with two weft systems. Warp is completely

hidden in  the middle  of  two wefts,  and is  usually  quite  thin  with respect to the weft; it  does not

contribute to the color effect at all.

The first step is to set a warp and weft pattern, with one color in warp, and two colors in weft, using

alternating weft change  1a 1b.  The two weft colors  should  be contrasting,  usually  light and dark,

while the warp color is unimportant, since it will be invisible in the finished fabric.

Then select Random shading as the type of conversion and enable the Double toggle button. Load a one

layer  weave,  which  fulfills  the criteria  for  grayscale  shading  (one  point  in  each line;  satin  weave).

ArahWeave will construct a double layer Jacquard weave from this input weave. You can set the Offset

parameter, which determines the number of threads, for which program shifts the backside weave in

respect to face weave.
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Figure 258: Random shading for blankets
 

Figure 259: The detail of double shaded fabric
 

Figure 260: Face and back of the shaded fabric
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9.6 COLOR SHADING

During training of designers with experience in textile printing and with little weaving background, we

often get requests like: “I draw a red flower and a green leaf on a blue sky, so how do I get these colors

in fabric?” Then we know we have a bumpy road ahead. We start all  the talk about warp and weft

colors, density, multi-layer weaves, how you can only have colors which are present in the warp or in

the weft,  assuming you have constructed the weave in  the correct way. We were haunted by  this

problem for a long time, but there was always something more important to do. And after 7 years in

business,  several  lucky  factors  met  (a  little  break  from  customers’  requests,  a  programmer  who

understood weaving and a weaver who twisted the weaves until his head was spinning) and we came

up with a solution.

9.6.1 HOW DOES IT WORK? 
ArahWeave calculates the color effect of  every weave, currently  loaded in  the jacquard conversion

window. The color depends on weave, warp and weft pattern, and yarn colors.  Then it  shifts  every

weave in all directions to generate new weaves (or we may say colors). When ArahWeave calculates all

possible weave combinations, it examines the image, and replaces color pixels in the image with most

appropriate weaves, based on color similarity.

Example in Figure  261 presents the most simple case –  just  one weave in  the Jacquard conversion

window.

Figure 261: Color shading conversion

 

Fabric has 4 different yarns in warp, and four different yarns in weft. Weave structure will force only

one warp and one weft thread at a time (out of four) is on the fabric surface. Thus sixteen different

weaves  /  color  combinations  are  possible  (warp1-weft1,  warp1-weft2,  warp1-weft3...warp4-weft3,

warp4-weft4)).

Table shows the basic weave (bordered with red line) and its derivatives. Weave derivatives are created

internally by ArahWeave—program shifts them left to right, and up and down to get all possible color

combinations—and you don’t need to load them into the Jacquard conversion window. Then save the

fabric, which now becomes your template fabric for color shading.
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warp1-weft4 warp2-weft4 warp3-weft4 warp4-weft4

warp1-weft3 warp2-weft3 warp3-weft3 warp4-weft3

warp1-weft2 warp2-weft2 warp3-weft2 warp4-weft2

warp1-weft1 warp2-weft1 warp3-weft1 warp4-weft1

Then load the picture, which you want to weave, in the Jacquard conversion window. The picture must

be in full color – 24 bits per pixel, for example in JPEG image format. If you load a palette image in the

jacquard conversion window (also called indexed image or color-mapped image), you lose the weaves

which are intended to do color shading. If you load an indexed image by mistake, just reload the fabric

template again.

The next step is to specify the desired weave size, which usually depends on the number of hooks of

your jacquard. Enter the number in the Warp field, and click the Density button. The number of wefts is

calculated from the fabric density,  which has to be set in the  Set weaving density window (Fabric >

Density and control).

Different options are on the right side of the image. They determine the transformation of the image

into fabric.

First  you  have  to  choose  whether  the  program  should  use  the Dithering technique  to  reduce  the

number of colors in the image to match the number of weaves, or not. Dithering is a technique used in

computer graphics to create the illusion of color depth in images with a limited color palette (color

quantization). In a dithered image, colors not available in the palette are approximated by a diffusion of

colored pixels from within the available palette. In Arahweave’s color shading, the number of colors is

equal to the number of weaves.

If you decide not to use dithering, there is the Noise option, which makes a smoother color transition

between shades. The value goes from 0 to 99 (Figure  262). There is no rule, which technique works

better (dithering or non-dithering), you can try both, check the fabric simulation, and choose which one

will go into production.
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Figure 262: Fabric on the left was made with noise option set to 0, on the right noise was set to 40

  

The other options are:

• Reinforce: with reinforce turned on, the program makes additional weaves from the base ones to

achieve even more color accuracy. This option will only work on some weaves, not all weaves are

suitable for use with this option.

• Flat to flat: sometimes you want the text labels or borders in color shading to remain unaffected by

the noise,  which is  usually  added to the picture to achieve a smooth shading.  If  the  Flat to flat

button is turned on, the program will search for areas of flat color in the true color image and will

not apply any dithering noise in that area. The flat color areas must have perfectly equal color, not

just  visually  equal  with  small  differences  inside  (as  it  would  result  from  a  JPEG  image).  This

parameter is  also  saved in  conversion  and fabric  file.  Note that this  option does not yet  work

together with the Dithering option.

• Warp / weft  color ratio:  you can specify the relative importance of warp and weft effect in the

calculation of color shading weaves,  expressed as %. Default value is  50,  which means that the

importance of warp is equivalent to that of the weft. If you have colored yarns in warp, and black

and white yarns in weft (as you would in a tapestry), by putting the parameter to 60, the program

will calculate more colorful (saturated) weave colors, and a normal image with largely mid tones

will be desaturated in the final shading rendering. Inversely, if you put the parameter to 40, weft

will become more important, the program will calculate duller (less saturated) weave colors, and in

the color  shading  conversion,  the program will  pick stronger weave colors,  resulting in  a more

saturated final rendering.

• ,   If you don't want to use shifted weaves in your color shading fabric, uncheck these

options. If you are using tapestry weaves, you normally don't want to shift the weaves vertically

(because of the binder thread), only horizontally (where all warps have the same yarn count).

Then click the OK button to start the transformation. You can save a fabric file and use it later as a color

shading template.

The only remaining task is to remove the float errors and save the Jacquard file. Figure 263 shows the

input image, and the resulting fabric. Normally we use more than one basic weave, so the result should

be even better.
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Figure 263: Image and fabric simulation

 

The algorithm itself is flexible, and is not limited to 4 warp 4 weft systems, or to one particular weave

system, nor to these particular warp and weft colors. In fact, it is a good practice to change warp or

weft colors into colors which are actually present in the image, and you get even more accurate color

rendering. To check which RGB colors are present in the image, move the mouse over the picture and

look in the upper right corner of the window, where they are displayed. Write down the colors you

think are most significant for your image, and change your yarn colors into these colors, and click on

the OK in the conversion window one more time. Of course, for a weaver, it is much easier to change

the weft colors.

9.6.2 COLOR SHADING WITH TAPESTRY WEAVES

Figure  264 shows color shading with tapestry weaves. We expect better results,  since we use more

weaves in the Jacquard conversion. Warp tapestry weaves should be shifted just in horizontal direction

(  ), because normally you have yarns with different yarn counts in weft, so shifting them vertically

would produce wrong weaves. 

Figure 264: Image for color shading and the resulting color shaded fabric simulation

   

9.6.3 LOADING / SAVING ALL WEAVES

Sometimes you need to load more than one hundred weaves in the Jacquard conversion. There is a tool

to load them all  at once. Use  Load all from the  Choose weaves menu, and  the program will  load all



13 8    C hap t er  9   
 Conv er ti ng image in to Jac q uar d  w e ave

www.arahne.si  

weaves from the current weave directory into Jacquard conversion. This means you must navigate the

weave browser to the desired directory, before calling this function.

From the same menu, you can use  Save all, in order to save all weaves from Jacquard conversion to

current directory.

9.6.4 REVERSE SHADING

The Reverse shading function enables you to check the internal picture of the color shading conversion.

Choose  Tools >  Reverse  shading,  and  the  program changes the initial  true color image into palette

image,  which  consists  of  colors,  defined  by  currently  loaded  weaves  in  the  jacquard  conversion

window. The size of the palette image is the size of the jacquard weave, divided by warp repeat and

weft repeat. In Figure 265, the jacquard weave size is 2400 by 1188 points. Program will internally use

an image of 400 by 396 pixels, because the weave system is six threads in warp, and three threads in

weft (400 x 6=2400; 396 x 3=1188). One pixel in the image represents six warp threads, and three weft

threads,  and  its  color  is  calculated  based  on  these  threads.  A  reverse  shaded  image  is  easier  to

understand than fabric simulation, so it is easier to notice any irregularity or wrong colors. If you find a

color pixel in the image, whose color effect you don't like, or you think is wrong, just click it. It will

select the corresponding color (and weave) in the weave selection area of the window. You can then

modify the weave, or even delete it  from Jacquard conversion.  If  color shading uses  less  than 256

weaves, the reverse image is an 8-bit palette image, otherwise it will be a true color image (but it will

use a palette of more than 256 colors). 

Figure 265: Reverse shading – a tool to check correctness of color shading
 

To go back to the true color image in the Jacquard conversion, click the undo icon  in the window’s

toolbox.

9.6.5 SHOW COLOR GAMUT

The Show color gamut function helps to predict the result of color shading. It has three viewing modes:

it shows colors of the image, colors of the weaves, and overlap one over another to easier see how

colors from weaves match (or usually mismatch) colors of the image.
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9.6.6 MODIFYING WEAVES IN JACQUARD CONVERSION BY REMAPPING YARNS

The Remap yarns function from the Tools menu of the Edit warp and weft pattern window enables you

to change all weaves in the jacquard conversion by shifting the treads. It is useful if you have a set of

weaves made for a particular colored yarns sequence like 6-color warp, but then for some reason the

warp you want to use has different color order.  So you would need to change all  weaves to follow

thread pattern, but it is faster if you do this in the Jacquard conversion window by using the Remap

yarns function.

Figure 266: Weaving points of warp 3 (green) will change the position with warp 4 (red)

9.7 EXTRA WEFTS (FIGURING WEFT)
In an extra weft fabric one weft yarn is used to weave a ground fabric and additional wefts are inserted

at intervals to create a decorative pattern on the fabric surface.

The higher weft density on the figuring portion than on the ground fabric may be achieved by two

means:

• Stopping  the  regulator  (fabric  take-up)  on  extra  weft  pick.  When  the  regulator  motion  is

deactivated, the cloth beam does not advance, and we effectively double the weft density on that

point of the fabric.

• Weaving at different (variable) densities.

The weaves must be appropriate – we must “force” the picks to go on top of  each other by using

appropriate weaves. For example, weft satin for the pick that needs to be at the top, and warp satin for

the pick that needs to be on the back. 

ArahWeave’s Jacquard conversion dialog has a special mode, which helps you to create an extra weft

design. To activate this mode, set the Extra wefts as a type of conversion, using a button on the lower

left area of the window. 
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Figure 267: Jacquard conversion; extra weft mode; system set to 3

 

9.7.1 SETTING THE NUMBER OF EXTRA WEFTS

You need to set the number of weft systems in the fabric. For instance, a ground weft plus two extra

wefts means a system of three. The system field is in the upper right corner of the Jacquard conversion

window (see Figure 267). 

9.7.2 LOADING WEAVES INTO EXTRA WEFT JACQUARD CONVERSION

After you have set  the System number, you have to load weaves. Every color in the picture requires

System’s number of weaves. The weave area of the Jacquard conversion window is divided into Number

of colors by Number of wefts (system) fields. There is also one additional weave row, which shows the

combination weave for every color. Figure 268 shows the weave display area from Figure 267; you have

to load three weaves (because we set System (number of layers to 3) for every color in the image – one

weave for every weft.

To load a weave into weave area, select it with left mouse click, and load a weave from the file dialog,

or from the Browse window.
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Figure 268: Extra weft weaves

 

After you load all the weaves, click OK and you will get the full jacquard weave.

9.7.3 WEFT PATTERN OF EXTRA WEFT DESIGN

The  program automatically  writes  the weft pattern  according  to  the arrangement  of  colors  in  the

jacquard design image. The ground weft gets the letter a, the first extra gets the letter b, and so on.

Figure 269: Automatically generated weft pattern
 

If  you want to use other yarns  instead of  those determined by the program, follow the procedure

described in Chapter 9.8.1.

Sometimes you change the weft pattern after  Jacquard conversion. If you repeat conversion for some

reason,  for  instance you want to change one of  the weaves,  the program overwrites your  old weft

pattern. To get it back just click two times the undo icon  in the weft section of the Edit warp and

weft pattern window. Or use a function explained in Chapter 9.7.6.

colors  from  the

image

ground weft 

weaves: weft yarn a

first extra weft 

weaves: weft yarn b

second extra weft 

weaves: weft yarn c

resulting weave:  

combination of all 

three weaves
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9.7.4 DENSITY OF THE EXTRA WEFT FABRIC

The program automatically puts the  stop-regulator  points on the

appropriate  wefts  or—if  you  decide  so—writes  a  variable  weft

density  pattern. By  default,  the  program  writes  the  regulator

pattern.  If  you want to use the loom variable weft density  as a

method of creation of different densities across the fabric length,

uncheck  the  Regulator check  box  in  the  Jacquard  conversion

window.
Figure 270: The regulator check
box in the Jacquard conversion

window

The following two figures show the same design, but we have used a regulator to vary the density of

the figuring weft area in the first figure, and the Variable weft density in the second figure. The woven

design should be the same in both cases regardless of technology we have used to produce it.

Figure 271: The regulator pattern, generated by Jacquard conversion
  

When  we  use  the  variable  weft  density,  we

need  to  enter  the  density  in  threads/cm  (or

inch) for each density we use. There are three

densities  in  sample  in  Figure  272:  the  first

density is  for weaving with ground weft only,

the second one is used for weaving of ground

weft and one extra weft, and the third one is

used when all three wefts are used.

Figure 272: The variable weft density, generated by
Jacquard conversion



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  14 3

To display simulation of extra weft design, the Density from technical data in the Density window or in

the  Consumption window should be  enabled (number of threads in fabric width, reed number, reed

width, and denting should be correct, otherwise the simulation will be wrong!).

Figure 273: Simulation on face and back of the fabric

  

9.7.5 PARAMETERS OF EXTRA WEFT CONVERSION

There are ten new parameters on the right side of the window, which enable you to control and get

desired result:

1. System: means the number of layers – in most cases it is a ground plus number of extra wefts.

2. Always: this parameter tells the program how many wefts you want to have in a ground fabric. For

instance, if you set the Always parameter to 3, the program takes the first, second and third weft to

form a ground. So the second and third weft (which are extra wefts by their function) are used also

to  form  a  ground  fabric.  If  the  Always parameter  is  set  to  the  same  number  as  the  System

parameter, then the program sets the regulator to 1 (it means no regulator at all).

3. Minimum works a little different than  Always;  while Always means the number of wefts used in

ground fabric, the Minimum option declares number of wefts (ground +extra) in one insertion, so

the number of ground wefts may vary (depends on the number of extra wefts in one insertion).

4. Ground layout is a powerful feature for setting different densities (number) of wefts in each layer. If

the field is empty, than program takes simple order of wefts,  like  ground weft, 1st extra weft, 2nd

extra weft, ground weft, 1st extra weft, 2nd extra weft and so on (as it is a default, you don’t need to

write it in the Ground layout field; empty field simply means the layout of 1234..). Figure 274 shows

ground and two extra wefts in simple order 123  (ground weft, 1st extra weft, 2nd extra weft), and

more complex ground layout, written as 1213, where 1 means ground, 2 and 3 are extra wefts (so

order is ground weft, 1st extra weft, ground weft,2nd extra weft).

Figure 274: Simple ground layer, and two ground wefts per layer (ground weft is yellow)
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Ground layout can also be written with repeats and parenthesis (similar as thread pattern), to allow

extremely complex irregular extra weft insertion.

5. Ground pattern: by default, the program puts the weft yarn a in the weft pattern as a ground weft.

But if you write a custom ground pattern, then the program will use it instead of the default one.

Figure 275: Fabric on the left uses default ground pattern, repeating yellow weft a; fabric on the
right uses a pattern of 2a2b for the ground weft; in both cases the extra weft is the blue one.

6. Skip face: to achieve smooth borders, define the shortest distance between the closest binding point

and the border of the extra weft effect. If Skip face is set to 3, the closest binding point will be three

points away from the border.

By default, this feature works also on the ground weft on areas, where it is on the face of the fabric. If

this is undesirable, mark the weft-effect weave of the ground weft with a letter "Z", which  leaves the

weave as it is, without applying any of the smart extra weft parameters (skip face, skip ground, …). For

detailed description with images, see Chapter 9.8.2.

7. Skip ground: same as skip face, just it works on ground weft. It has the additional option Always (it is

a button next to the Skip ground field)– if it is enabled, then the function works between all wefts; if

it is disabled, it works just between extra wefts.

8. Skip back: same as skip face, just that it works on extra weft backside weaves.

Figure 276: Rectangular motif, made by extra weft conversion; the image at the left shows motif made
with all parameters set to 0; “errors” at the edge are circled in red; the image in the middle uses Skip

face set to 2, and one at the right was made with Skip face 2, Skip back 2

   

9. Clear face: It doesn’t put any binding point if the length of weft passage on the face is shorter than

the declared Clear face value. If it is longer than the value number, then the program does nothing. 

10.Clear back: It doesn’t put any binding point if the length of weft passage on the back is shorter than

the declared Clear back value. If it is longer than the value number, then the program does nothing. 

11.Attach at length:  to prevent long floats at the back of the fabric,  which sometimes occur due to

summing up floats, you can set, what is the maximum long float of extra weft.
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12.Protect: sometimes it is necessary to continue with a few extra threads, even if they are not needed

in the motif formation; they just hold the last threads in the design firmly in their place. Figure 277

shows the same design, made without protection threads, and with three protection threads.

Figure 277: Protect function in extra wefts

 

9.7.6 GETTING A GROUND PATTERN FROM A MODIFIED WEFT PATTERN

When you apply an extra weft jacquard conversion, ArahWeave writes a weft pattern automatically. If

you later modify a weft pattern  manually,  this change may be lost,  if  you for some reason, apply a

jacquard conversion again. So it is a good practice to store a modified ground weft pattern for future

use in the fabric in case you would apply a jacquard conversion again. To do this, click the bulb icon 

next to the  Ground pattern title,  which extracts a ground pattern from a complex weft pattern, and

writes it into the Ground pattern field. When you apply a jacquard conversion on that fabric next time,

it will use a stored ground pattern, and you will not need to modify it again.

Figure  278 shows  a  fabric  that  we got  after  converting  an image  into

jacquard weave. The weft pattern consists  of  two weft threads,  a light

green yarn a, and an extra weft – a dark green yarn b. The pattern is quite

simple and was written automatically by jacquard conversion.

Figure 278: After
converting an image into

jacquard weave
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Now we manually, or by drawing or typing, modify the pattern. We got

the fabric, displayed on Figure 279. In some areas, the ground weft a was

replaced with weft c and weft d.

If we need to change a weave for a particular color in the image and apply

the jacquard conversion again,  we will  lose the thread pattern that we

have  just  edited,  because  the  jacquard  conversion’s  automatically

generated pattern will  overwrite it.  But there is  a tool,  which prevents

this.  After you have modified the weft pattern, store it  in the jacquard

conversion window: click  the bulb  icon   next to the  Ground pattern

title, which extracts a ground pattern from a complex weft pattern, and

writes  it  into  the  Ground  pattern field.  When  you  apply  a  jacquard

conversion on that fabric next time, it will use a stored ground pattern,

and you will not need to modify it again. Figure 279: After manual
modification of the weft

pattern

9.8 ADVANCED EXTRA WEFT CONVERSION CONTROL WITH YARN LETTERS

9.8.1 DEFINE YARNS IN JACQUARD CONVERSION WINDOW

By default ArahWeave takes the first weft yarns from Edit warp and weft pattern to write weft pattern;

if your System is 3, it will use yarns a,  b, and c. If you want to use different yarn, just select the extra

weft weave field in the Jacquard conversion window, and press the desired yarn letter on a keyboard. A

small rectangle in that particular yarn color and yarn letter will be drawn in the upper right corner of

the extra weft weave. The program will use that yarn instead of  the default one.  To remove the yarn

color letter from the weave selection area, select that area and press the Escape key on the keyboard.

This function has a powerful extension. Let’s say that you want to have a second line of roses in Figure

273 in different colors, and want to achieve this without time consuming editing. You just need to paint

those roses in different colors  in the image, and define yarns for these new colors. Figure 280 shows

the sample, where the ground weft will be in default color a, weft for green color will be b, for red color

c, and for two new colors, orange and blue, will be wefts d and e.
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Figure 280: Defining yarn colors in Jacquard conversion window

 

Figure 281: Simulation with two extra wefts in four colors

 

Figure 282: Same jacquard conversion as on Figure 280 but without yarn letters produces fabric with
only two colors in extra weft.
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9.8.2 DISABLING EXTRA WEFT CONVERSION PARAMETERS (LETTER Z)
Program  applies  parameters,  which  you  set  for

extra  wefts  (Skip  face,  Skip  ground...)  to  all  weft

effect  weaves  that  you  use  in  the  jacquard

conversion.  But sometimes this  is  undesirable.  To

disable  the  extra  weft  conversion  parameters  for

particular weft weave, put a letter  Z in that weave

(select  a  weave  area,  and  press  a  Z  key  on  the

keyboard;  to  remove  the  letter  from  the  weave

area,  select  it,  and  press  the  Escape  key  on  the

keyboard). ArahWeave will leave the weave as it is,

without applying any of the extra weft parameters. Figure 283: Letter Z in the ground weft disables
the extra weft conversion parameters for that

weft in white color region of the image

9.8.3 EXTRA WEFT AS A WARP EFFECT WEAVE

ArahWeave writes extra weft pattern based on the weaves, that you define in the Jacquard conversion

window: the weft effect weave (it has more than 2/3 of “white” points) on the particular color of the

image means that you want to have extra weft on that color area. If you need to insert an extra weft,

which has only warp effect weave across the whole weft,  you have to “tell” to the program that you

want to have it even if it doesn’t meet Arahweave’s standard for extra weft. To do so, specify the weft

yarn letter on the warp effect weave, and in this way the weave will be treated as a weave which you

want to be present in the jacquard weave as an extra weft. Areas with that weft will not be removed

from the final weave. This  works both in fil coupe as in extra weft, and is  mostly useful for curtain

fabrics.

9.8.4 STITCHING WEAVE AS A WEFT WEAVE (LETTER Z)
The extra weft is stitched to the ground of fabric in places where it is not required for forming a figure.

Normally the stitching weaves are woven in a warp effect (ends up) so that extra weft appears on the

back of the fabric. If you use a weft effect weave for stitching weave, the program treats it as an extra

weft in that color area, and puts the weft across the whole area, usually the ground of the fabric. But if

you want to have it  only where it  is  needed for  a  designing  purpose, mark the stitching extra weft

weave in the ground with the letter Z. Now the program knows that you want to have it only where it is

needed for designing purpose.

9.9 FIL COUPÉ

Literally translated from the French, it means “cut threads”. The technique is similar to extra threads,

except that extra threads in fil coupe fabric, where they are not in the function of design, are cut off

with a special  machine. Generally  it  is  a design with extra wefts and some modifications,  and back

attachment weave is all floats. The main modification is the weave border around the fil coupe weft

effect (normally plain weave), which prevents pulling the threads out of the fabric during the cutting

process.

Parameters  System,  Always,  Ground  layout,  Skip  face,  Skip  back,  Attach  at  length have  the  same

meaning as in the Extra weft chapter. Beside Protection, which has different meaning than in Extra weft

conversion, there is new numerical field  Coupe length, and three option toggle buttons:  Fil coupe on

face, Protection always, and Double.
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Figure 284: Fil coupé jacquard conversion

 

9.9.1 PROTECTION

Protection has a different meaning here than in the Extra weft conversion: it is the number of points of

the border weave, which the program will insert on the left and right side of the extra weft fil coupe

effect. Border weave can be specified individually for every weft.  The program automatically adds  a

new color (gray) for protection weave. In  the weave display area of the Jacquard conversion window

the border weave color tab is on the rightmost position (fifth color in Figure 284).
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When you use the weft letters in Jacquard conversion to define the weft yarn for each fil coupe weft, the

program adds the protection weave inside the motif if you enter the lowercase letter and outside the

motif if you enter the uppercase letter.

If  you don't want protection on a particular  color-weft combination, enter a lower case z  into that

weave tab in the Jacquard conversion window. 

9.9.2 FIL COUPÉ AND EXTRA WEFT IN SAME FABRIC

If you want fil coupe fabric with some fil coupe threads and others normal extra wefts, put an empty

(full  weft) weave on protection, and that weft will  be treated as a normal, to the ground fabric tied

extra weft thread, not as a fil coupe weft. 

9.9.3 COUPÉ LENGTH

Coupé length means that areas shorter than this length will be attached to the ground, and longer ones

will be left floating and later cut off.

9.9.4 FIL COUPÉ ON FACE

Fil  coupé  on  face enables  you  to  have  the  long  float  of  the  coupé  thread  on  top  after  jacquard

conversion. In this way, the cut-off threads effect will be on the top, together with the weft effect. This

is sometimes used for the curtains, or when some funky designers like fil coupé effect and want it on

top. The side effect of fil  coupé on top is  that the  Attach at length parameter is  ignored, since  the

program would otherwise stitch the fil coupé threads to the fabric at the middle of the float.

9.9.5 PROTECTION ALWAYS

It  means that the program will  put protection weave on all  borders,  even there, where technically

speaking it is not necessary (on threads, which will not be cut due they are too short and are attached

to the ground), but design will look more regular.

Figure 285: The green outline indicates the protection weave



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  15 1

Figure 286: Fil coupé Protection always – off and on

   

9.9.6 DOUBLE

In  the areas,  which are too short  for  cutting,  the program automatically  inserts  attachment weave

instead of the full float (Figure 287). But on some fabrics, which need to be extra light, or are partially

transparent, this is not desirable, as threads, which are too short to cut, shine through the fabric. In this

case, use the Double option (to enable this option, the Protection always button should be set to on).

Program will divide this weft into two wefts, putting some parts of the fabric on one weft, and other

parts on another. As a result, all areas are long enough for cutting, so there is no need to attach weft to

the back.  Obviously,  you  need even more wefts  than on  normal  fil  coupé,  so  your  fabric  is  more

expensive.

Figure  287 shows a fil  coupe fabric with normal settings.  Inside the circle, where the floats are too

short, the program stitched the weft threads to the ground weave. But with the  Double option, the

program divides each weft thread into two threads—one for the left side of the circle, and one for the

right side.

Figure 287: “Normal” fil coupe, and fabric created with the Double option

 

The simulation shows that there is no difference in the shape of motif in finished design, except that all

the unnecessary threads were cut in the, made with the Double option on.
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Figure 288: Fabric simulations of “Normal” fil coupe fabric, and fabric created with the Double option

  

9.9.7 FIL COUPÉ SIMULATION

ArahWeave  can  simulate  fil-coupé

fabric. In the main ArahWeave window

choose  Fabric >  Simulation.  Select the

Fil coupe tab, and enable the Fil coupe

toggle  button.  The  Pullout  parameter

determines  length  of  the  thread,

which  stands  out  of  fabric,  after  the

thread has been cut. You can vary this

value  between 0  to  60;  the unit  is  a

weave  point.  The  Cutoff parameter

sets the length (from 0 to 30) of hairs

coming out of the fil coupé yarn’s end.

The Angle parameters declare at which

angle the hairs are coming out of the

yarn’s  end. The Probability  option (0-

100) sets the amount of hairs; the higher the value is, the hairier look on the edges will be.

In  the Consumption window you can check the difference in  weight  of  the finished (cut-off)  fabric with

respect to uncut.

9.10 WEAVE BLANKET

9.10.1 OVERVIEW

Sometimes  even  experience  doesn’t  help  to  predict

what the color, or texture effect of a particular weave

on  a  particular  fabric  will  be.  It’s  been  a  long  time

weavers  practice to weave a sample fabric,  made of

different  weaves,  as  a  decision  making  weave

selection  tool.  Each  weave  section  has  a  name  or

number woven for a reference.

Figure 290: Weave blanket

Figure 289: Fil coupé simulation
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9.10.2 CREATING WEAVE BLANKET

To  create  a  Jacquard  weave  blanket,  load  any  indexed  (8-bits  per  pixel)  image  into  the  Jacquard

conversion window, and choose Weave blanket as a type of conversion.

There are five general settings in the Weave blanket conversion:

• Filename weaves Program automatically includes weave file names in each weave section. So, you

need to choose a  weave for  filename letters,  and a  weave for  the file  name background.  Both

weaves should be the same type as the weaves, which will be included in the weave blanket. To load

weaves,  open  Browse from the  Choose weaves menu of the  Jacquard conversion window. In the

Browse window navigate to a directory, where the weaves you want to weave are located. Load a

weave for background in the first color tab, and a weave for letters in the second one.

• Number of weaves You have to decide how many weaves will be included in the Weave blanket. This

is done by setting the number of columns in the  Horizontal field, and the number of rows in the

Vertical field.  Program takes weaves from the current directory displayed in the  Browse  weaves

window. If the weaves, which you want to weave, are in separate directories, you have to put them

in one directory.

• Title size Choose the number of wefts, which will be used for filename in the Title height field. 

• Top edge Enabling  it,  you add some wefts (doubled title height size),  woven with the weave for

filename background, creating space for cutting the woven piece off the loom. You can customize

this extra space by company name, batch number, whatever, which you type in the field below the

Top edge box. 

• Weave blanket size You need to set the number of warp ends (hooks) in the Warp field, and the weft

threads in the Weft field. 

Figure 291 shows the example, which has 2400 warps, and 2160 wefts. The weave blanket will have six

columns, and twelve rows, so there will  be 72 weaves woven in the weave blanket. The size of one

weave will be 400 warps (2400:6), and 270 wefts (2160:12). There will be 36 wefts used for filename

titles. At the top, there will be the “Made by ArahWeave” title.

Figure 291: Weave blanket conversion

 

Then you need to select the weave in the Browse window, which will be the first weave in the weave

blanket fabric (in the bottom left corner). 
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Figure 292: Weave browser - color view mode

 

Then just click  OK in the Jacquard conversion  window, and the program will  generate the Jacquard

weave  according  to  your  specifications.  Figure  293 shows  the  weave  blanket  simulation.  All  that

remains to be done is to make a Jacquard file for the loom and actually weave it.

Figure 293: Weave blanket simulation  

9.11 IMAGES MENU

The Jacquard conversion window has several tools for handling images. They are accessible through the

Images menu in the Jacquard conversion window.



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  15 5

9.11.1 FREE IMAGE

If you do not want to save an image in the fabric file, release the image and weaves from the Jacquard

conversion window by choosing Free image.

9.11.2 PRINTING IMAGE WITH JACQUARD WEAVE SELECTION

You  can  print  image  with  weaves  and  colors  from  Jacquard  conversion  window  (usually  for

documentation purpose). Choose Images > Print picture. In the print picture dialog box (Figure 294) you

have to set the borders and the size of the printout. If you choose the One repeat option, the program

will fit the image into determined space. Figure 294 shows the Print preview of  the image with color

and weave selection.

Figure 294: Print preview from Jacquard conversion

 

9.12 TOOLS MENU

9.12.1 COPY / PASTE

You  can  use  copy/paste  of  images inside  one  instance  of  the  ArahWeave,  or  between  multiple

programs,  including ArahPaint.  You can also past a weave from the weave editor as an image into

Jacquard conversion, and use it as two-color image.

9.12.2 GETTING WARP/WEFT PATTERN FROM IMAGE

See chapter 7.17, which describes this feature under warp/weft pattern section.

9.12.3 MULTI-IMAGE CONVERT

As the name suggests, the Multi image convert enables conversion of several images into jacquard files

within one batch.

Load a template fabric, which has jacquard conversion (image and weaves) already saved in a file. You

can use Multi image convert with a Normal conversion or  Color shading conversion. If you do Normal

conversion (palette images – 8-bit per pixel), we advise you to use the same color palette (same colors)

in all images, and you should turn on the  Reload jacquard weaves only to equal colors option in the

Weaving tab of the Save setup window. This option forces the program to load the same weave into the

same color, so unwanted weave mapping to similar colors will be avoided. The number of colors in the

palette images should not be bigger than the number of colors in the image of initial fabric. Otherwise,

the program doesn’t know which weave to use for the extra colors, so you receive the error message,

and conversion is canceled.

You also need to load the loom layout in the Save cards for production window, for the loom on which

you plan  to  weave the jacquard  files.  Then  choose  Tools >  Multi  image  covert from  the Jacquard

conversion window.
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Figure 295: Jacquard conversion with Multi image convert dialog box
 

There are four possibilities of fixing jacquard weave size with respect to image size:

• None: program uses image size for jacquard weave size

• Density: program sets the weave width to the number of the hooks in the Warp field of the Jacquard

conversion window, and calculates the number of wefts based on the density of the initial fabric

• Keep weave size:  program resizes  images to match both  Warp and  Weft number in the Jacquard

conversion window.

• Multiply:  program will  multiply image size with the  System parameter from

the  jacquard  conversion.  This  will  enable  you  to  use  multiple  image

conversion  on different image sizes,  as long as  they fit  on the same loom

layout.

The other options are:

• HTML report: program creates HTML report with images and fabric simulations, so you can check the

result before real production. You can also use it to document your production schedule.

• Weaving program:  if  you use Stäubli  JC4, JC5, or JC6,  ArahWeave can create a weaving program,

which specifies the order of weaving, and how many repeats of each design should be woven.

• Fix floats face and back fixes long floats based on margins set in the initial fabric before it creates

Jacquard files. If the option is on, but the float margins are not set in the Float window, the program

will cancel the conversion. You can either set the float limits, or to turn off the Fix floats face and

back option.

• Create new directory:  ArahWeave creates  a  new directory for storing Jacquard card files, with the

name specified in the above field. By default, the program fills this in with the current date.

• Date will write today’s date in the upper right edge of HTML report

• Use Browse or Load image to load images into the Multi image convert window. You can load up to

50 images. Image loader prevents loading of images, which are not suitable for currently chosen type

of conversion – if you use the Normal conversion, then you can load only indexed images (8-bits), if

you use  Color shading,  you can load true color images. Image filenames are on the left side. The

middle text field contains the Jacquard filename. It is automatically filled in from the image name,

but you can change it, since sometimes looms do not accept long filenames. If you weave one-piece

designs, you can tell the program how many pieces you want to weave, and type this information on

the right side of the window. If the image filename is of the form xyz_4.jpg, then the program will

automatically fill in a weaving of 4 repeats. To change the number of pieces for weaving you can also

point the mouse to the numeric field, and use the wheel of the mouse to change the number. Then

click OK, and conversion will start.

Figure 296: Setting
the Multiply
parameter
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Figure 297: Images loaded into the Multi image
convert dialog box

 

• If everything is correct, the program writes OK after every filename, and closes the window. You can

observe the progress,  as the program is  processing  the files.  The Jacquard files  are saved at the

location defined in the Save cards for production window.

If the HTML report option is on, the default browser opens and displays the report (Figure 298).

Figure 298: HTML report of multi image conversion in Firefox browser  

9.12.4 GETTING IMAGE FROM WEAVE (REVERSE JACQUARD)
The Get  image from weave function is  an extension to Weave  editor’s Replace selected weave (see

chapter 4.9). It helps you to get the color image from the Jacquard weave (card image), if you want to

use the image for assigning different weaves,  or to resize it  to different fabric  quality.  In  the  main

Arahweave’s window open Weave editor, use the middle mouse button to draw selection in the weave

(or use parametric mode Change > Select/copy area), which you want to replace. Selection must include

at least one complete weave repeat. Then choose  Jacquard >  Replace selected weave.  If your weave

replacement mask is  satisfactory, click on the  Get image from weave button in the  Replace selected

weave window. This opens the Jacquard conversion window, and puts in the image of the same size as
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the Jacquard weave. The mask is replaced by a solid color, while the other weaves remain in black and

white.

If you wish, you can select another weave in the weave editor, make a replacement mask by clicking the

OK button in the Replace selected weave window, and then use Get image from weave again. Each time

you extract a weave into color in this way, the weave is also copied in the weave selection window of

the Jacquard conversion window.

From the Jacquard conversion window, you can save the color image (Images > Save image as). To get

rid of the black and white points from areas, which could not be correctly attributed to one of the

weaves (due to complexity of the image, or long float correction), edit the image in ArahPaint, and then

save it again. It is a good practice to keep the same colors as the one which ArahWeave has created in

the generation of jacquard color image, so you can reuse the original color to weave assignment s. You

are, of  course,  free to change the jacquard image colors,  but you will  have to reassign  the weave

afterwards.

Figure 299: Get image from weave

 

Note that this function must not be confused with Guess image from weave in the Images menu of the

Jacquard conversion. Guess image from weave is a function which tries to guess everything in one step

– all the weaves, even if they do not have the complete repeat. Probably it tries to accomplish too much,

so it  does not work well  in many cases. Using the combination of  Replace selected weave and  Get

image from weave, you help the computer identify the individual weave areas and number of weaves,

so it gives more accurate results than Guess image from weave, but it needs a repeat of all the weaves

to work properly. Additional advantage of the Replace selected weave approach is that it also correctly

handles different weaves, which give the same fabric appearance. Guess image from weave works back

from the simulation, and is unable to distinguish between those weaves.

9.13 WEAVE PEN IN JACQUARD CONVERSION

If you middle-click on the fabric in the main ArahWeave window, then the warp (black) point is changed

into  a  weft (white)  point  and vice  versa. But if  the Jacquard conversion window is  open,  then the

middle mouse button draws in the fabric with the currently selected weave in the Jacquard conversion

window. The size of the drawing area is 3 by 3 points. If you keep the Shift key pressed during drawing,

the drawing area size is 5 by 5 points. So you can sign the jacquard fabric, or do fine tuning on weave

junctions. But remember that those changes will be lost if you re-apply the jacquard conversion.
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You can also use the weave pen to draw with selected weave color directly in the image. You can also

do this with the middle mouse button. This is intended only for minor corrections, when you discover

some stray spots at the last moment, and do not want to go back to ArahPaint to correct them. So you

can do this directly in ArahWeave. These changes will be permanent, as they will be saved within the

image in the fabric file. So you can re-apply jacquard conversion without losing data.

9.14 LOADING AND SAVING JACQUARD CONVERSION

This  function  from  the  Conversions menu  in  the  Jacquard  conversion  window  enables  saving  the

parameters of jacquard conversion – association of weave to color, and the type of conversion .

If you keep one color palette, you can draw many pictures and use the same jacquard conversion on

them. During  loading of  jacquard conversion,  the program loads the weaves into the places of  the

corresponding colors. It can work in two different ways:

1. Default mode: program loads the weaves into the equal colors, or if there are not exactly the same

colors, the program maps the weaves to the similar colors.

2. Program loads weaves only to exactly the same colors. If you load the image, which has a different

palette (different colors) than the currently loaded Jacquard conversion, then the weave tabs will

remain empty (without weaves). To enable this mode, you have to switch on the Reload jacquard

weaves only to equal colors option (Save setup > Weaving).

The  loading  and  saving  of  the  parameters  of  jacquard  conversion  lost  some  importance,  since

ArahWeave saves the conversion data and image, from which the jacquard weave is  created, in the

ArahWeave fabric file.

10 WEFT BLANKET

10.1 INTRODUCTION

The weft blanket is  a  unique ArahWeave's tool, which enables the combining of different fabrics into

one weaving file. From input fabrics it creates a new fabric by generating variants from yarns and in the

fabric length you specify. You can use it as a tool for:

• Designing; you can use the Weft blanket tool for creating new designs, since you can quickly and

easily combine parts of different fabrics into a new design.

• Sample production; joining more fabrics into one fabric (weaving) file means that you can produce

them all in one step, without stopping a loom to change a weaving file.
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Figure 300: Weft blanket from three different fabrics; seven variants are generated and woven as a
single fabric. Program can add woven title between variants.

 

10.2 EDITING THE WEFT BLANKET

To open the weft blanket editor, choose Blanket > Weft blanket.

Figure 301: Weft blanket editor (no fabrics loaded yet; default settings)  
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10.2.1 GENERAL SETTINGS

General settings in the Weft blanket editor are:

• In the Fabrics field, enter the number of fabrics that you want to use for weft blanket creation.  To

load a fabric into the Weft blanket editor, choose Fabrics > Browse (or Load). Editor displays fabrics,

which will form the weft blanket, in the first column of the icon display area; the first fabric is at the

bottom of the window. Figure 303 shows three fabrics in the Weft blanket editor.

• Weave X: by default, the value is set to 0 (zero). It means that the weft blanket's weave width will

have  the same  width as the wider fabrics  in  the selection.  But if  this  width is  not  wide  enough

(usually if the title writing is too long), you have the possibility to manually declare the width of the

blanket weave by setting the number of ends, used for weft blanket creation.

•  The Double option enables splitting  of each  weft  in the weft pattern on two wefts during

loading of the fabric. In this way, you can create richer color variations without modifying the fabric

you have loaded for weft blanket creation. 

•  It enables the 90-degrees rotation of the fabric during loading in a weft blanket. In this way,

you  can  exchange  warp  and  weft  in  sampling,  to  avoid  preparing  complicated  warps  just  for

sampling.

•  If enabled, the selected fabric input field jumps to the next one, as you load a fabric into the

currently selected field. By default it is on, but you can change it and save the setup according to

your desires.

•  To apply the changes without clicking the OK button, mark the Instant conversion

box.

• In the Yarns field, enter the number of yarns that you will use in the blanket. We use 4 different weft

yarns in the blanket in Figure 302.

• In the Separating yarn field, enter the yarn pattern (usually only one color) of the border between

versions (leave it empty, if you don’t want to have a border). Twill is the default weave for a border,

but you can change it – choose Weaves > Browse from the menu bar, and load a new weave into the

Separation field.

• Name – mark the toggle button, if you want to have a woven title – file name or custom text and

used weft yarns – in the border between sections. For this, you would need at least 2 centimeters or

1 inch of the separating area. You can also change the weave for  fabric’s file name letters; load it

into  the  Title  weave area  (double  click  opens  the weave browser;  you  can also  use  ArahWeave

keyboard shortcuts for entering weaves).

•  You choose the position of the woven name with the top/bottom button.

Figure 302: General settings and the fabric specific settings in the Weft blanket editor

 

10.2.2 FABRIC SPECIFIC SETTINGS

Fabric specific settings are:

• In the Variants field, enter the number of variants that you will weave for specific fabric. Each fabric

may have its own number of variants. In Figure 303, the first fabric has three versions,  the second

has four variants, and the third one has two variants. Variants’ icons are created automatically. The

first variant of the first fabric is marked 1A, next is  1B, and 1C. The starting weft of each variant is
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written next to  thename (2C @3441 means the third variant of  the  second fabric starts  at weft

3461).

To change yarn, left-click the yarn tab, and copy it by right-clicking to the desired place.

Figure 303: Weft blanket editor with loaded fabrics and variants, which are generated from the input
fabrics and specified weft yarns. The fabrics icons are displayed in the first column and the variants’ icons

are placed next to them.

• In the Length field set the woven length for each version. The length unit can be: inch, centimeter,

meters, number of picks, number of repeats. Variants of the same fabric have the same length.

• You can change the starting point of  the version by changing  First warp, or  First weft. This is very

handy for shawls, if you have several shawls which you want to compose in a new one, where you

pick different areas of different designs to be put together in a new design.

• Switch on the Continue toggle button, if you would like to continue weaving of the next color variant

from the last woven weft of the previous variant. In this way, if the design is a large jacquard motif,

you can show both the complete motif and all the color variations, all in one small sample.

• If  you  want to  mirror  the original  fabric,  click   to  mirror  horizontally,  or   to  mirror  it

vertically.  It  is  very  useful  for  creation  of  symmetric  shawls,  using  the previously  saved  partial

fabrics.

• If you want to  invert the fabric  to weave it with a face down (usually fil coupe fabrics) , there you

have the Invert button . Program remembers the state of invert and mirror buttons, and it is saved

in the blanket file.

• If you enable the Custom text button, you can enter text in the text field below the setting area. This

text will be woven in the separating area between two variants. There are few additional functions,

which add naming and numbering to the title:
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$G:  It adds the filename of main fabric (a fabric, which is used as a “template” on which the weft

blanket is created.

$F: It adds the filename of a component fabric.

$N:  Type $N001 to the custom text to have the auto-incremented number for variants  inside one

component fabric. For example, if you enter $N01, the program will insert 01 for the first variant, 02

for second, and so on.

$M: Type $M001 to the custom text to have the auto-incremented number for all variants.

Figure 304: Automatically generated text from the fabric filename, the component fabric filename, the
variant number, the general variant number and used yarns: $G $F $N01 $M01. In this way, the samples

passed to the customers do not need a written tag, which may detach or get mixed up. Customer can read
the woven header and you know exactly which design and color variant they have ordered.

10.2.3 WEFT BLANKET AS A DESIGN TOOL

Weft blanket editor is also a distinct and powerful design tool, and some of its settings make combining

multiple designs into a single new design a quick and easy process. This tool is typically used when you

need  to  combine  several  fabrics  that  are  quite  different  in  nature,  such  as  terry  border,  terry

top/bottom selvedge, and terry ground design. The main advantage of the weft blanket tool is the ease

with which sections can be changed after the design has been created. Because of complex weaves,

yarns,  and  finishing,  it  is  common  to  create  a  complex  fabric  whose  final  length  cannot  be  fully

predicted during the design phase. So you must weave a sample, finish it, and then decide whether to

lengthen or shorten specific areas based on the customer's desired length.

• You can change the starting point of  the version by changing  First warp, or  First weft. This is very

handy for shawls, if you have several shawls which you want to compose in a new one, where you

pick different areas of different designs to be put together in a new design.
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• Switch on the Continue toggle button, if you would like to continue weaving of the next color variant

from the last woven weft of the previous variant. In this way, if the design is a large jacquard motif,

you can show both the complete motif and all the color variations, all in one small sample.

• If  you  want to  mirror  the original  fabric,  click   to  mirror  horizontally,  or   to  mirror  it

vertically.  It  is  very  useful  for  creation  of  symmetric  shawls,  using  the previously  saved  partial

fabrics.

• The  Pattern option lets you write the weft blanket as a weft pattern, of two or more fabrics. It is

useful, when you have  the  same fabric, repeated at different places in the weft blanket, and you

would need to load it into the weft blanket editor as many times as fabric occurs in the weft blanket.

Figure 305 shows a weft blanket, which is made of two fabrics. In the “normal” editing mode, you

would need to load two fabrics in the correct order, the violet fabric 5 times, and the green fabric 4

times, of course in the correct order. But if you switch to the Pattern mode, you need to load each

fabric only once. In the Pattern field you have to write a weft blanket as a pattern: 90a 102b 90a
102b 194a 102b 90a 102b 90a,  where a means first  fabric,  and b means second fabric.

Numbers  beside letters  mean the number of  wefts from each fabric.  If  you need to change the

height of a  particular fabric band, just change the number of wefts, click  OK, and you have a new

design.

Figure 305: The pattern option in the weft blanket editor: from two input fabrics we have created new
design.

10.2.4 KEYBOARD NAVIGATION AND SHORTCUTS IN WEFT BLANKET EDITOR

• Alt + click in the weft blanket fabric opens the weft blanket editor (if it is not already opened), and

selects the icon of the version in the weft blanket editor, from which the clicked section was made.

This  feature is  very useful,  when we want to modify an old weft blanket, composed from many

fabrics, and we can't find the right variant in the weft blanket editor.

• Double mouse click on the variant icon changes the position of the scroll-bar in the main window, so

that variant becomes the first one at the bottom of the window, so you can easily find it.

• Alt  +  mouse  wheel  roll  over  blanket  fabric  in  the main  window adds  or  removes  (depends  on

direction of rolling) threads from that particular variation, where the mouse pointer is. It also works,

if the weft blanket editor is not opened. Data in the weft blanket editor is updated, as you roll the

wheel. If the Instant conversion is enabled in the Weft blanket editor, the fabric is changing as you

roll the mouse. If not, then you have to click the OK button to apply the changes. 
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• Pressing the Insert key adds a new fabric in the Weft blanket editor, if one of the fabrics (leftmost

icon)  is  selected (you can achieve the same with  Tools >  Fabrics >  Add).  If  a  variant is  selected

(second, third,...  icon in horizontal),  then the variant is  duplicated and you can edit it  as a new

variant (Tools > Variants > Add).

• Pressing the Delete key removes selected fabric or selected variant from the Weft blanket editor (

Tools > Fabrics > Remove or Tools > Variants > Remove).

• You can navigate variant icons, fabric icons or yarns using the arrow keys.

• Instead of copying yarn from the yarn bar to the variant yarn, you can position a cursor to that

particular variant yarn, and change it by pressing a corresponding letter key on the keyboard. For

instance, if you want to replace the yarn a with yarn c, select the yarn a, and press the c key.

10.2.5 SAVING THE WEFT BLANKET FABRIC

When you click the OK button, the program merges all variants into one fabric, writes new weft pattern,

regulator,  and other variables (weft density,  warp tension,  loom speed,  selvedges,  terry  variables)  if

they exist in the input fabric files. You can save it as a new fabric. 

10.2.6 EXTRACTING A VARIANT FROM THE WEFT BLANKET FABRIC

If you need to get a specific variant from the weft blanket fabric, select the variant in the weft blanket

editor, and choose Tools > Extract fabric. The program pulls out the weave, weft pattern and regulator

of that fabric, with proper weft color remapping. Save it with a new file name.

11 VARIANTS

ArahWeave enables you to create variants of the same fabric design, and save them into a single fabric

file.  Variants differ from each other only by yarns and colors.  To open the Variants dialog window,

choose Blanket > Variants…

Figure 306: The Variants dialog window

11.1 SETTING THE TYPE AND NUMBER OF VARIANTS

There are four different types of variants: 

• Weft – you edit just the weft yarns.

• Warp – you edit just warp yarns.

• Warp & Weft – you edit both warp and weft yarns independently.

• Warp = Weft – warp and weft yarns are the same; as you edit warp yarns, the 

same applies to weft yarns.
Figure 307:

Choosing the type
of variants

As you increase the number of variants, the last variant is copied to the new one. If you later (during

editing) decide that you need more (or less) variants, you can simply change the number.

Figure  308 shows the Variants dialog, where we have changed the number from 1 to 4. We got four

equal variants. Now we can edit them one by one.
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Figure 308: Setting the number of variants in the fabric

11.2 EDITING VARIANTS

You can modify  variants  by  pasting  colors  from color  libraries,  or  by  loading  yarns  from the yarn

browser.  The  ArahWeave's copy/paste  method  with  mouse  (left  click  to  select,  middle  click  to

exchange, right click to paste) also works inside the Variants dialog.

11.2.1 PASTING COLORS FROM COLORS DIALOG

If you want to modify only colors and not yarns in

the Variants, use the Colors editor. Set the number

of  variants  and  type,  and  open  the  Color  dialog

(Fabric >  Colors).  Click  the  Variants tab,  which

displays all  colors used in the fabric variants.  You

can start copying colors from the currently opened

color library to variants.

As you  click  (select)  color  in  the variant,  that variant  becomes selected and displayed in  the main

window.  ArahWeave's  title  bar  also  shows  the  number  of  the  selected  variant.  Please  note  that

ArahWeave displays only one variant (selected one) at the time in the main window. If you want to

review all variants at once, use the Print preview (more about this later in Chapter 11.3).

Figure 309: Editing variants in the Color editor
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Figure 310: Displaying selected variant

11.2.2 LOADING YARNS FROM THE YARN BROWSER

By double clicking on a variant yarn, you can open the yarn browser and load the yarn into the variant. 

The window is split into two parts. The left part lists all yarns from the default yarn directory. On the

right side, there is a list of colors associated with currently selected yarn.

Figure 311: Loading yarns from the yarn browser
 

If  you want to have displayed all  colors from your library In the Browse yarns window, you need to

export colors  to XML format  (from the Edit colors window choose  File >  Export colors  in XML).  The

exported color file is available next time when you restart ArahWeave.
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Figure 312: Exporting colors in XML 

11.2.3 PROTECTION - PREVENTING ACCIDENTAL MODIFICATION OF VARIANTS

When  you  add  new  variants  to  already  designed  variants  you  may  want  to  prevent  them  from

accidental modification. To do this, just enter the number of variants which should be protected in the

Protection field in the Variants menu bar.

11.3 PRINTING VARIANTS

Choose File > Print fabric to printer… to open the Print dialog. Mark the Variants check-button to access

the  Print  fabric  to printer:  Variants window. Here you decide the  form of printout (number of rows

(Fabrics Y)and columns (Fabric X)) and position of titles (for details about titles and positioning of them,

please see Chapter 17.8 about multi-fabric printing).

If you want to print just some of the variants, select them by double-clicking the variant's number. The

number gets the asterisk mark *, which means that it is in a selection. We have selected four out of six

variants in Figure 313.
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Figure 313: Printing variants

Check the print preview before printing. Or you can use the print preview just to display the variants

side by side and review them.

Figure 314: Preview of the variants printout

 

12 OVERPRINT, CHINÉ, IKAT, SEERSUCKER SIMULATION

12.1 OVERPRINT

You can simulate printing over a woven fabric in  ArahWeave. Open ArahWeave and load (or create) a

fabric, in which you want to use the overprint function. Choose  Fabric >Simulation. In the Simulation

window click the Overprint tab.
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To load the image (usually the image that is used for screen printing), click the Browse button, and load

the image into the Simulation window. In most cases, you load just one image into the Warp field. In

the very  rare  case  of  double  or  compound  ikat  fabrics  (both  warp  and  weft  yarns  are  dyed  prior

weaving with different patterns) you also load an image, which represents the used weft dye pattern, in

the weft field.

The image for overprint is usually in the indexed (8 bits per pixel) mode, so that you have the option to

control which color is transparent (the background color of the image).  

Figure 315: Loading image into simulation window
 

The program draws the image over fabric, as if it was printed. With Zoom you can control the size of the

overprint image. Strength controls the color strength (transparency) of the overprint (at 100% it covers

the fabric completely). In the Transparency field you specify the number of the color, which will not be

displayed (printed) over the fabric (you can see the color palette and color numbers if you load the

image into ArahPaint). The transparent color of the sample in Figure 316 is  the white color (note that

the counting is started with 0 and not 1—the first color in the image is marked as 0).

Figure 316: Overprint simulation

 

Figure 317 demonstrates the same image printed at different Strength levels.
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Figure 317: Overprint strength levels: 100%, 80%, 60% and 40%

The  option  Overprint  fabric  transparency is

useful  for  simulation  of  printing  over

transparent  fabrics,  like  curtains  for  example.

The holes between the threads are covered or

left empty depending on the type of dyes. If the

option is  switched on,  the program draws the

overprint image on the space between yarns.

12.1.1 PRINTED WARP, IKAT, CHINÉ SIMULATION

The overprint  simulation window has some other options,  which allow you to simulate even more

exotic stuff. First of the three advanced functions in the overprint window gives you the possibility to

specify which yarns  in  the fabric  are  print-protected.  This  allows simulation of  fabrics  with printed

warp, ikat fabrics (warp, weft, or both), and even fabrics, which are made from yarns with different

fiber composition and thus different dye affinity. 

Figure  319 shows  the input  fabric,  consisting  of  white  and  blue  yarn,  and  the output  fabric  after

printing. A dye which is used for printing, has no affinity to fibers in blue yarn, so you have to state

them as Unprintable in the Simulation window (letter b in Warp and Weft). 

Figure 319: Print-protected yarns

 

The  Ikat option for warp and weft allows you to simulate the overprint image distortion (feathered

edges of the pattern), which is characteristic of techniques, where the warp, weft or both are tie-dyed

or printed with a pattern before weaving, to create a design on the finished fabric.

Figure 318: Overprint fabric transparency: off and on



17 2    C hap t er  1 2   
 Ove rp rint ,  Chin é,  Ik at,  Se er suc ke r s imul at ion

www.arahne.si  

Figure 320: Chiné simulation

 

In  ArahWeave's simulation, the value of ikat effect is specified as the number of pixels of the printed

image. The higher the value, the bigger the distortion.

A closer look at the previous simulation shows you how ArahWeave makes the chiné simulation. On the

sample the ikat value is set to 12 in the warp direction – it means that the borders of print will vary

randomly from 0 to 12 pixels.

Figure 321: Zoom in chiné simulation
 

The Ikat simulation works  best in  combination with the  Dye absorption function.  It  determines the

absorption of dye over the edges of the printed motifs. This depends on the yarn material (fiber), type

of dyes and printing technique. It can be set independently for warp or weft, and it is  expressed in

tenth of a millimeter.
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Figure  322 shows a simulation with  Dye absorption set to 0,  while the simulation on the right was

generated with Dye absorption set to 35.

Figure 322: Dye absorption

12.1.2 SIMPLE WARP IKAT PLAID

The following image shows the setup for warp ikat, where only the warp yarn with letter d was printed

(or dyed / painted) prior to weaving. So all the other yarns (a, b and c, which form the border design on

the left) are set to be non-printed. 

Figure 323: Warp ikat

12.1.3 SIMPLE WEFT IKAT PLAID

Weft ikat is more difficult to make, since the start of each pick (weft yarn) must be aligned to the edge

of the fabric. Usually, this is impossible in industrial weaving, due to the nature of weft insertion. But a

skilled hand-weaver can do it.

Figure 324 shows a fabric and the settings for weft ikat. Only the weft letter d is left printable.
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Figure 324: Ikat weft plaid

12.1.4 CHANGING COLORS OF THE OVERPRINT PICTURE

To change colors in the overprint picture, open the Edit colors dialog ( Fabric >  Colors),  and click the

Overprint tab. There is a color palette of the overprint image. From the ArahWeave palette select a

color, and copy it with the right mouse button over the overprint image color.

In the same way you can copy or exchange color chips of the overprint image.

Figure 325: Changing the overprint colors

12.1.4.1 PRINTING COLOR CHIPS OF OVERPRINT IMAGE

If you enable the Overprint button  in the Print fabric to printer dialog, the colors from the overprint

image will be printed in the lower-left corner of the simulation.
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Figure 326: Color chips of overprint image  

12.2 SIMULATION OF WRINKLES

Wrinkle is another fabric finishing feature, available in the Simulation window. It allows you to load any

image and use it as a gray wrinkle map. If the image is not gray-scale, it will be automatically converted

to  gray-scale.  As  in  overprint,  you  can  also  specify  the  zoom  and  intensity  levels.  Wrinkle  works

differently  from  the  overprint,  as  it  takes  the color  of underlying  fabric,  and modifies  its  lightness

according to the wrinkle picture/texture. To load the texture, click the browse button, and from the

image browser load the texture.  The program will automatically figure out the base gray level of the

loaded picture and will  make the fabric both lighter and darker. The program's finishing simulation

works  in  sequence,  so  you  can  have  both  overprint  and  wrinkles.  You  can  also  specify  the  non-

wrinkable yarns, which allows you to make realistic seersucker simulations.

Figure 327: Simulating the seersucker fabric
 

To make a simulation even more realistic, you can set the Displacement function, which will curve the

threads according to the wrinkle texture and the value of the displacement parameter. 
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Figure 328: Simulating the seersucker fabric with Displacement function
 

13 FABRIC PROPERTIES

The  Properties window  allows  you  to  enter  lots  of

different  information  for  the  fabric.  You  can  access

this  window from the  ArahWeave menu bar through

Fabric >  Properties or by using the keyboard shortcut

Ctrl+I.

There  are  two types  of  text  fields  in  the Properties

window:

• Ordinary text fields—you enter the data.

• Drop-down menu text fields—you enter the data or

choose  it  from  the  drop  down  list.  The  list  is

configured  with  custom  codes  and  values,  using

external  XML  files,  which  you  add  to  your  XML

directory.

Figure 329: The Properties dialog

You can specify (among other things):

• For which customer the design was made (a list is taken from ArahneCustomerImport.xml).

• Which  finishing  was  applied  (you  can  choose  it  from  the  drop-down  menu;  a  list  in

ArahneFinishingImport.xml, or as set of toggle buttons) 

• Type of the fabric (as free text description or a set of toggle buttons)

• Which designer did it (ArahneDesigners).xml

• From which design was the actual design derived 

• Status of the fabric (is it just a trial or real production) 

• Division (when a company is divided into different plants or market/product groups)

• Name,  quality,  design,  version,  season—these  entries  are  also  used  for  automatic  fabric  name

generation for saving fabric data in HTML format and for title of printed fabric simulation.

• The product availability—the scissors sign   can be also printed on the fabric simulation to

show that fabric is already in stock.
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14 FABRIC TECHNICAL DATA CALCULATION

The technical data and calculation of yarn consumption is accessible as the Consumption menu entry

from the Fabric menu. You should have previously set the yarn counts in the Yarns section.

The Calculation of thread consumption window is divided into two parts:

• gray with entry fields for fabric technical data

• white, where the calculated and data from other windows (colors, thread pattern) are displayed

You must enter the requested parameters and click OK to see the results of the calculation.

14.1 NUMBER OF THREADS, REED NUMBER, REED WIDTH

The number of threads in fabric width is the most important fabric production parameter, besides weft

density.  You can enter the number of  Threads in fabric width by yourself,  or better,  enable button

Density from technical data (you can also enable this button in the Density window), and the program

calculates it for you from Reed width and Reed number (and Denting—ends per dent), which you set in

the Edit weave window). The Number of threads field changes from the entry field into grayed-out field,

so you know you can no longer enter this number. The number is rounded to an integer number of

dents because it is nonsense to have dents “half full”. If there are 3 threads per dent, then number of

threads will be a multiple of 3.

Figure 330: Calculation of number of threads from reed number and reed
width with Density from technical data option on

 

If  you disable  Density from technical data you can use another way to calculate the  Total number of

threads, Reed width and Reed number (as you know these values are interrelated). You can change any

of these fields (the Threads in fabric width field becomes red to indicate that one of the values should

be recalculated – it is up to you which one).

Figure 331: Calculation of number of threads, reed number and reed
width

 

Then click the bulb icon  next to the field which you want to calculate. The value will be calculated

from the other two. In Figure  332 we calculated the  Reed number. It is changed from 10 to 8,5. The

Threads in fabric width field changes from red to default color which indicates that all three values are

correct.
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Figure 332: Pressing the Bulb icon at the right side of the Reed number
field calculates the Reed number from the number of threads and the

reed width  

14.1.1 CALCULATING THE NUMBER OF THREADS AND REED NUMBER FROM DENSITY

You can calculate  Threads  in fabric  width and  Reed number from the  Set  weaving  density window.

Finished width and Reed width should be set to desired values. Then choose Fabric >  Density. Set the

warp density, and click  icon. Required number of threads in fabric width and the reed number for

requested density will be calculated in the Calculation of thread consumption window.

Figure 333: Calculating the number of threads in fabric width and the reed number from the warp
density   

14.1.2 DENTS

Instead of  Threads in fabric  width,  you can use

Number  of  dents  in  fabric  width.  You  have  to

change  the  program setting by choosing  Help >

Save setup.  In the  Save setup window click the

Weaving tab (Figure 334), and change the option

button  from  Reed  width  ->  Dents to  Dents  ->

Reed width.

14.2 FABRIC WIDTH

At the top right edge of the window, you enter the basic fabric widths: reed width (pattern only, no

selvages), raw width and finished width. This  is  necessary, if  you want the program to calculate the

finished density for you. If you do not have these data, you must enter the density by yourself in the

Set weaving density window (Fabric > Density and control).

Figure 334: Choosing the input unit for  fabric width
and consumption calculation - number of threads in

fabric width or number of dents in the reed width
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14.3 FABRIC (OR WARP) LENGTH

Depends on your preference, enter the Fabric length, for which you want to calculate the consumption,

and  the  program will  calculate needed warp length.  If  you prefer to start with warp length, so the

program calculates the fabric length, change the setting in the Save setup window.

With the  Fabric  length  ->  Warp  length option

button you choose either the  Fabric  length or

Warp length is  your input in the  Consumption

window.

Figure 336: From warp length to finished fabric

The raw fabric length is the warp length reduced by the take-up. The take-up is the difference in length
between the warp length and the length of fabric just taken off the loom.

RawLength(m)=
WarpLength(m)∗(100−TakeUp(%))

100

The finished fabric length is the raw fabric length reduced by finishing shrinkage.

FinishedLength(m)=
RawFabricLength(m)∗(100−FinishingShrinkage(%))

100

Warp length

Figure 335: Choosing either Fabric length or Warp
length as the input value in the Consumption calculation

Finishing shrinkage
Finished fabric length

Raw fabric length
Take-up
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Figure 337: Calculating the warp length from the Fabric length input

14.4 WEFT DENSITY

There are three kinds of weft threads density:

• Weft density on the loom (number of weft thread insertions per length unit)—you have to enter it

• Weft density of the raw (gray) fabric—calculated

• Weft density of the finished fabric—calculated

14.4.1 WEFT DENSITY ON THE LOOM

Weft density is the density, set on a loom. It is the only one of three weft densities, which you have to

enter in the Calculation of the thread consumption window.

14.4.2 WEFT DENSITY OF THE RAW (GRAY) FABRIC

The  Weaving  shrinkage variable  generally  depends on loom setting (warp and fabric  tension),  used

weaves,  material.  It  causes the difference between the density  on the loom (weaving density)  and

density in the raw fabric. The weaving shrinkage is part of the take-up, and cannot be higher than take-

up. It is expressed in a percentage (%). ArahWeave calculates the raw weft density using the following

formula:

RawWeftDensity (wefts /cm)=
LoomWeftDensity (wefts /cm)∗(100+WeavingShrinkage(%))

100

14.4.3 WEFT DENSITY OF THE FINISHED FABRIC

The finished weft density is  calculated from the  Finishing shrinkage,  which means the shrinkage (or

elongation)  of  fabric  (warp)  during  the  finishing  process.  ArahWeave  will  also  take  into  account

regulator or variable weft density when calculating the weft density of finished fabric.

The finishing shrinkage is expressed unit is percentage (%).

FinishedWeftDensity (wefts /cm)=
RawWeftDensity (wefts /cm)∗(100+FinishingShrinkage (%))

100
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Figure 338: Weft density calculation
 

14.5 SELVAGES

You can enter selvages data in two ways:

• Enter  Selvage pattern,  which  is  the  full

pattern describing left  selvage (the  right

one is assumed to be equal), and Selvage

denting.  The  program  will  calculate  the

required number of dents and reed space

for selvage.

• If you want, that selvages are taken from

the fabric ground, then enter the number

of  Selvage dents and  Denting,  and leave

the  Selvage pattern empty.  Figure  340

shows  data  of  fabric,  which  has  12

threads (Selvage denting  (2) by  number

of selvage dents (6)) from ground in each

selvage.

Figure 340: Selvage from ground

Figure 339: Selvage pattern and selvage denting
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14.6 YARN CONSUMPTION

The  scrollable  window  below  the

technical  data  entry  fields  contains

the  complete  consumption

calculation. It is in HTML format and

is  equal  to  the  printed  page  of

technical data. You can save it  using

Save technical data as HTML from the

main  File  menu.  By  default,

ArahWeave saves it in the data/html

directory.

The  data  contained  in  the consumption  calculation  should  be  pretty  obvious  to  anyone,  who  has

calculated it “manually” a couple of times. There are only a few points that need further clarification.

The formulas for calculation of consumption are as follows:

TakeUp(%) of 2% is assumed to be 1.02

Loss(%) of 2% is assumed to be 0.98

Unit is reported in parenthesis.

ConsumptionWarp(kg)=
TotalNumberOfThreads∗Length(m)∗TakeUp( )

YarnCount (Nm)∗1000∗Loss( )

ConsumptionWeft (kg)=
ReedSpace(cm)∗DensityWeft (threads /cm)∗Length(m)

YarnCount(Nm)∗1000∗Loss ()

Weight (g/m)=
(ConsumptionWarp(kg )+ConsumptionWeft (kg))∗1000∗Loss ()

Length(m)

Calculations of the number of threads of each color, total consumption, weight per square meter, etc.

are trivial, and there is no need to go into obvious details.

In the table below the reed information, you have an overview of all the repeats in the fabric. In this

way, you can check if they divide each other as expected, or the total repeat size will  be a very big

number. Currently, the repeat limit for the consumption calculation is 65520 threads.

The cover factor for warp and weft is calculated based on weave density and diameter of yarns. It is not

an absolute value, you will learn with time how dense will the fabric be if the total cover factor is 78%.

Figure 341: Yarn consumption calculation
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The transparency gives you the percent of area with background color in the simulation. The heddles

table shows you the number of threads that are lifted by each shaft.

At the bottom of the table, you will also find the weight in g/m for each shaft. We assume that each

shaft is lifting 1 m of warp, and the program reports the corresponding weight. This is useful, when you

have yarns with different yarn counts in warp, and in this case, the number of threads for each shaft

does not reflect the true shaft load.

14.7 ADVANCED LOOM CONTROL FUNCTIONS

ArahWeave supports the following weft variables (loom control) functions:

• Variable weft density

• Warp Tension

• Loom Speed

• Selvedges

• Terry

• Pile height

• Tension pile

• Tension ground

To enable desired weft control function, open the Set weaving density window, and check the button at

the left side of the option. You can enter data for variable function s in two ways: by entering a pattern

in  an  adequate text  field,  or  by  drawing  the pattern  on  the right  side  in  the weave editor  in  the

adequate control column.

14.7.1 VARIABLE WEFT DENSITY

Variable weft density is set in the Density window (Fabric > Density and control). You need to mark the

Weft density check box in the Variable field.

Then  in  the  text  field  we  type  the

variable density pattern. In Figure 342,

the  density  pattern  means,  that  400

picks have density a, which we set to

25 picks per centimeter, then 50 picks

are woven at density b, which we set

to 28 wefts per centimeter, then 112

wefts  are  woven at  density  c,  which

we set to 34 picks per centimeter, and

then  again  50  picks  are  woven  at

density b. The program also calculates

the  total  number  of  wefts  in  the

variable  weft  density  repeat  (612),

and the average weft density (27 per

centimeter).

Figure 342: Setting variable weaving density
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Figure  343 shows  the  fabric  with  a  variable

density.

Figure 343: Variable density in fabric simulation

Beside  the  numeric  way  of

entering variable density,  you can

draw it with a mouse in the weave

editor.  The  variable  density

pattern is shown on the right side

of  the regulator  column.  To draw

it, you have to (of course, it should

be enabled in the  Variable field in

the  Set  weaving  density window)

select  the  desired color (letter)  in

the  top  right  corner  of  the  Edit

weave window. As you draw it, the

parametric  density  pattern  is

updated in the Set weaving density

window.
Figure 344: Variable weft density in Weave editor

Many times the variable weft density is  the

same  (or  very  similar)  as  the  weft  pattern

(weft a has one density, weft b another etc).

In this case you can easily copy a weft pattern

to the variable weft density field by selecting

weft pattern text with  the left mouse button

(the  text  background becomes  black),  and

copying  by  middle  mouse  click  into  the

variable weft density field.

This  type  of  copy  /  past  works  among  all

text fields in ArahWeave.  But you can also

use  standard  keyboard  shortcuts  for

copy/paste: Ctrl+C, Ctrl+V.

14.7.2 GETTING A VARIABLE DENSITY PATTERN FROM A REGULATOR PATTERN

If  you want to  convert  a  design,  which is  made with  a  regulator,  to  a  design  woven  with  variable

density,  enable  Weft  density in  the  Variable field,  and click  the  Density  from regulator button. The

program calculates and writes the variable density pattern.

After that, you need to delete the regulator pattern, because the program will use both, variable density

and the regulator, to calculate the average density, which is used to generate the fabric simulation. 

Figure 345: Selecting text in the Edit warp and weft
pattern
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Figure 346: Density from regulator

 

14.7.3 GETTING A VARIABLE DENSITY PATTERN FROM JACQUARD CONVERSION

If  you uncheck the  Regulator check box in the Jacquard conversion

dialog, then the program will calculate and write the variable density

pattern instead of the Regulator pattern.

Figure 347: Variable weft density,
written by the program

14.7.4 SIMULATE REGULATOR WITH VARIABLE DENSITY

This  function transforms regulator  pattern into variable  density  pattern You get only  two different

densities, one for ground and one for “regulator” wefts (and, in case, you have fringe enabled in the

save cards for production window, you get the third density for the fringe).
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To use this function, enable the Variable weft density option in the Set weaving density window, and

click  the  Simulate  regulator  with  variable  density button.  ArahWeave writes  the  variable  density

pattern, and draws it in the variable weft density column in the weave editor.

Figure 348: Simulate regulator with variable density  

14.7.5 REGULATOR FROM DENSITY

If you click the Regulator from density button, you can specify the regulator pattern for each density

section in the Regulator from density window. ArahWeave calculates the resulting regulator pattern.
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Figure 349: Regulator from density

 

14.8 SAVING AND PRINTING TECHNICAL DATA SHEET (HTML AND PDF FORMATS)
Technical  data  can  be  saved  in  HTML  or

XML format. To save technical calculation

choose  File >  Save technical data as HTML

in main ArahWeave's window. You will get

window  with  many  options,  which  help

you  to  customize  your  technical  data

sheet.  If  you  want  only  to  save  the  file,

click  on the  OK button,  if  you want both

save and print, press the Print button. The

HTML file will  be open in  a  web browser,

from which you can print. File will have the

same name as the fabric file, the program

will add the html extension.

If  you  tick  the  PDF  check-box,  the  fabric

data will  also be saved as a PDF file  and

will be opened in a PDF viewer.
Figure 350: Save (and print) technical data window

Technical data consists of the following elements:

• Fabric quality data

• Warp pattern

• Weft pattern

• Warping

• Price

• Weave

• Fabric simulations
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If you uncheck the check-box at the left side of the segment, then it will not be saved (and printed) in

the HTML file.  (When you get a desired tables output by checking/unchecking various check-boxes,

save the current setting for future use by saving the Setup (Help > Save setup; click OK)).

Warp and weft patterns have the Vertical option; it means that they can be written in a vertical form. If

you like to have background colors of the letters, which mark warp and weft yarns, in the color of that

yarn, mark the Color letters option.

• Fabric quality data (number of threads, density, reed number, width, fiber composition of the fabric,

denting, regulator, repeat, cover factor).

Repeat
Weave

Fil Coupe
Design

Denting

Regulator

Weave

Design
Total

Warp
480

12 Shafts

1

0.02 cm

2

1 Dents

480

12 cm

480

12 cm

Weft 698
698

13.78 cm

698

551

advances

698

13.78 cm

698

13.78 cm

Reed number Reed width Denting Dents

19 / 1 cm 316.00 cm 2 6001

Selvedge 2 x 0.32 cm 1 2 x 6

Total 316.63 cm 6013

Warp length 6497 m

Fabric length 6400 m

Raw width 310 cm

Finished width 300 cm

Density Warp 40 / cm

Density Weft 40 / cm

Average Density Weft 50.67 / cm

Weft Total

Ground

Regulator

698

551

147

Take-up 1.5%

Waste warp 3%

Waste weft 2%

Consumption 1492 kg

Raw weight
227.2 g/m

73.3 g/m2

Finished weight

Fil coupe

210.0 g/m

70.0 g/m2

Composition 

86.92% PL Polyester

13.08% CO Cotton

Cover factor

Warp Weft Total Transparency

62.07% 76.19% 69.13% 12.60%

shaft 1 2 3 4 5 6 7 8 9 10 11 12 

Heddles 1251 1251 1250 1250 100 100 100 100 1650 1650 1650 1650 

g/m 9.8 9.8 9.8 9.8 0.8 0.8 0.8 0.8 12.9 12.9 12.9 12.9 

Drafting: 50(1 - 2 - 3 - 4) 2(5 - 6 - 7 - 8) 66(9 - 10 - 11 - 12) 2(5 - 6 - 7 - 8) 
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• Warp pattern (has also the  Vertical option, and if  you want to pass only this  information to

weaving mill, there is option saving on New page).

Selvedge pattern: 36A

Warp pattern (66x): 1A 2B 3A 3C 3D 8C 3E 7C 3D 3C 3A 2B 1A 48B

Leftover (36 threads): 1A 2B 3A 3C 3D 8C 3E 7C 3D 3C 

1 a 16-4019 Forever Blue 17/1 tex 470 Z 

2 b 14-0114 Celadon Green 17/1 tex 470 Z 

3 a 16-4019 Forever Blue 17/1 tex 470 Z 

3 c 14-0755 Sulphur 17/1 tex 470 Z 

3 d 12-0106 Meadow Mist 17/1 tex 470 Z 

8 c 14-0755 Sulphur 17/1 tex 470 Z 

3 e 18-1454 Red Clay 17/1 tex 470 Z 

7 c 14-0755 Sulphur 17/1 tex 470 Z 

3 d 12-0106 Meadow Mist 17/1 tex 470 Z 

3 c 14-0755 Sulphur 17/1 tex 470 Z 

3 a 16-4019 Forever Blue 17/1 tex 470 Z 

2 b 14-0114 Celadon Green 17/1 tex 470 Z 

1 a 16-4019 Forever Blue 17/1 tex 470 Z 

48 b 14-0114 Celadon Green 17/1 tex 470 Z

90

Warp
Repeat

threads

Design

threads

Selvedges

threads

Total

threads

Repeat

%

Design

kg

Selvedges

kg

Total

kg 
A 8 532 2*36 604 8.89 5.463 0.739 6.203 

B 52 3434 0 3434 57.78 35.265 0.000 35.265 

C 21 1407 0 1407 23.33 14.449 0.000 14.449 

D 6 402 0 402 6.67 4.128 0.000 4.128 

E 3 201 0 201 3.33 2.064 0.000 2.064 

Total 36+66*90 =5976 +72 =6048 61.369 +0.739 =62.109 

Warp A B C D E 

Count 17/1 tex 17/1 tex 17/1 tex 17/1 tex 17/1 tex 

Composition
60% CO Cotton

40% PL Polyester

60% CO Cotton

40% PL Polyester

60% CO Cotton

40% PL Polyester

60% CO Cotton

40% PL Polyester

60% CO Cotton

40% PL Polyester 

Twists(/m) 470 Z 470 Z 470 Z 470 Z 470 Z 

1
16-4019

Forever Blue

14-0114

Celadon Green

14-0755

Sulphur

12-0106

Meadow Mist

18-1454

Red Clay 

Program writes this table only if

the Vertical option is on

Color letters enabled
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• Weft pattern (you can save it in the Vertical form, and on the New page; the letters of the 

pattern can be written in yarn colors)

Weft pattern : 8b 153d 9b 37a 9b 36a 8b 68a 106(1c 1a) 1c 67a 8b 36a 9b 37a

8 b 17-2120 Chateau Rose 

153 d 16-1143 Honey Yellow 

9 b 17-2120 Chateau Rose 

37 a 15-1309 Moonlight 

9 b 17-2120 Chateau Rose 

36 a 15-1309 Moonlight 

8 b 17-2120 Chateau Rose 

68 a 15-1309 Moonlight 

1 c 14-1318 Coral Pink 106 X

= 2121 a 15-1309 Moonlight 

1 c 14-1318 Coral Pink 

67 a 15-1309 Moonlight 

8 b 17-2120 Chateau Rose 

36 a 15-1309 Moonlight 

9 b 17-2120 Chateau Rose 

37 a 15-1309 Moonlight

698

Weft
Repeat

threads

Repeat

%

Weight

%

Fil coupe

%
kg

a 387 55.44 52.40 0.00 453.130 

b 51 7.31 3.54 8.92 30.623 

c 107 15.33 33.43 37.88 289.117 

d 153 21.92 10.62 0.00 91.869 

Total 698 864.739 

Weft a b c d 

Count 78/1 dtex 4/1 tex 18/1 tex 4/1 tex 

Composition 100% PL Polyester 100% PL Polyester 100% CO Cotton 100% PL Polyester 

Twists(/m) 0 0 420 S 0 

1 15-1309 Moonlight
17-2120

Chateau Rose

14-1318

Coral Pink

16-1143

Honey Yellow 
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• Weave in GIF format

 

• Simulation in JPG format: you have three options here: simulation in actual (real) size, simulation 

of one repeat (if the repeat is too big, the program reduces the zoom so the repeat fits into set 

size), or both. For simplicity reasons, one file is named fabric_name.jpg and the other is 

fabric_name.jpeg). You can set the resolution in dpi (default is 100 dpi) and both width and height 

of the simulation size (default is 150 mm) 

14.8.1 SAVING JACQUARD CONVERSION DATA

Among other things,  the Save technical  data dialog  enables you to save Jacquard conversion  data,

which lists the color-weave combinations (color RGB, weave name and size, and weave’s floats).

The table shows Jacquard conversion data of a 12-color image. Data of RGB, weave, size and long floats

data is next to every color cell.
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Color RGB Weave Size Long floats 
1 219,203,163 2up24 24x120 23,7 

2 0,0,255 1up5 24x120 23,8 

3 255,143,203 1up5 24x120 23,8 

4 87,151,255 1up 24x120 23,9 

5 175,175,175 2up24 24x120 23,7 

6 0,0,0 1up5 24x120 23,8 

7 0,219,191 2up14 24x120 23,6 

8 95,195,0 2up14 24x120 23,6 

9 0,111,51 2up23 24x120 23,8 

10 167,95,199 1up 24x120 23,9 

11 255,179,7 2up14 24x120 23,6 

12 107,107,107 2up24 24x120 23,7 

14.8.2 SAVING THE PRICE CALCULATION

If you tick the Price check-box, the Price table from the Price calculation will be saved in HTML file.

Cost €/m % 
Warp 1.84193 29.54 

Weft 1.95796 31.40 

Yarn price 3.80 60.95 

Warping 0.20816 3.34 

Weaving 0.87550 14.04 

Darning raw 0.10200 1.64 

Finishing 0.91800 14.72 

Darning finished 0.30000 4.81 

Transport 0.02418 0.39 

Margin 30% 

Divisor 0.7 

Industrial cost 
Raw net 4.91 

Raw gross 4.92 

Finished 6.23 

Price 
Raw 7.02 

Finished 8.91 

14.8.3 VIEWING THE FABRIC DATA FILE IN WEB BROWSER (OR PDF VIEWER)
As you click the Print button in the Save technical data in HTML dialog, the file is opened in the default 

web browser, or in the PDF viewer, if the PDF check-box is marked in the Save technical data dialog.

You can change the default browser (Firefox) in ArahWeave's Save setup window. For instance, if you 

prefer Chrome (of course Chrome should be installed on your system), choose Help > Save setup, in the 

Save setup window click the Expert tab, and type-in /usr/bin/chromium in the WWW browser 

field.
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Figure 351: ArahWeave's HTML data in Mozilla Firefox

 

ArahWeave enables direct saving to PDF format, which may be easier to send by email, because the 

tabla data, a fabric simulation and a weave are written in a single file.
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Figure 352: Technical data in PDF format

 

15 WARPING

The Warping feature calculates:

• yarn consumption for particular warp

• the number of required cones per yarn color

• the length (weight) of yarn per cone

• the yarn cones layout for  selected warper.

15.1 WARPER CONFIGURATION

First  you need to edit  or add  a  .warper file in  the /home/user_name/data/warp/  folder.  The file is

description of your warper and should contain:

• Number of creels
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• Number of creel blocks

• Order of yarn cones.

There are eight possible directions.  ArahWeave uses simple two letters nomenclature for that: first

letter means a starting point (L-left, R-right, U-up, D-down), and second letter means the direction).

LD Left Down

RD Right Down

LU Left Up

RU Right Up

UR Up Right

UL Up Left

DL Down Left

DR Down Right

The  layout  of  warper(s),  used  in  the  warp  directory  is  read  at  program  startup  from  location

/home/user_name/data/warp/.warper

The location of the .warper file can also be different, if the path to warp files, as defined in your .arahne

file, is different.

The structure of  the .warper configuration file is  very strict.  If  there are any errors  in  the file,  the

program ignores  it  and uses  the default  warper.  The  .warper file  must  use  Unix  line  endings,  not

MSDOS (CR/LF). You should use a plain text editor on Linux (kwrite, kate...),  or take care of the file

ending conversion, if you edit the file on Windows. The easiest way to edit the file is to copy text below

into  the  editor's  window, then edit it,  and save it  as .warper (note the dot at the beginning of the

name). Or you can contact Arahne (arahne@arahne.si),  and we will  create a file based on warper's

specifications.

Here is one example of .warper file contents, explanation follows below:

#WARPER

#NUM_WARPERS=2

#WARPER_NAME=warper1

#NUM_DIRECTIONS=2

DR

UL

#NUM_CREELS=3

#CREEL_NAME=A

#NUM_CREEL_BLOCKS=6

6x7

6x7

5x7

5x7

5x7

5x7

#CREEL_NAME=B

#NUM_CREEL_BLOCKS=6

5x7

5x7

5x7

5x7

6x7

6x7

mailto:arahne@arahne.si
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#CREEL_NAME=C

#NUM_CREEL_BLOCKS=1

5x7

#WARPER_NAME=warper2

#NUM_DIRECTIONS=1

LU

#NUM_CREELS=2

#CREEL_NAME=A

#NUM_CREEL_BLOCKS=1

24x7

#CREEL_NAME=B

#NUM_CREEL_BLOCKS=1

24x7
The  sample  file  defines  2  warpers.  You  can define up  to 5  warpers,  as  it  is  unlikely  that a single

company would have more than 5 different warpers. Each warper should have a distinct name. Each

warper can have up to 5 creels. Each creel can have up to 50 blocks. The dimension of a block can be up

to 100. Let's follow the example and comment on it:

#WARPER --- file signature, just to identify the file type. Does not have any parameters.

#NUM_WARPERS=2 --- number of warpers defined in the file

#WARPER_NAME=warper1 --- name of the first warper

#NUM_DIRECTIONS=2 --- number of allowed directions of filling in the creel with cones

DR --- first direction: begin in upper left corner, and fill in the cones down, and to the right

UL --- second direction: begin in lower right corner, and fill in the cones up, and to the left

#NUM_CREELS=3 --- number of creels for first warper

#CREEL_NAME=A --- name of the first creel

#NUM_CREEL_BLOCKS=6 --- number of creel blocks

6x7 --- size of creel block, horizontal x vertical

6x7 --- repeat until you define all the blocks

...

#CREEL_NAME=B --- name of the second creel

#NUM_CREEL_BLOCKS=6 --- number of blocks in the second creel

5x7 --- size of creel block, horizontal x vertical

#CREEL_NAME=C --- name of the third creel

#NUM_CREEL_BLOCKS=1 --- last creel has just one block

5x7 --- the size of the creel block

#WARPER_NAME=warper2 --- the name of the second warper

#NUM_DIRECTIONS=1 --- number of directions on the second warper

LU --- begin in lower right corner, and fill in the cones left, and then up

#NUM_CREELS=2 --- we have just two creels on the second warper

#CREEL_NAME=A --- name of the first creel of second warper

#NUM_CREEL_BLOCKS=1 --- number of blocks of the first creel of second warper

24x7 --- horizontal x vertical number of cone positions

15.2 EDITING THE WARP

To edit the warp, choose Fabric > Warping.

You have to enter in the following data:

• Number of sections – depends on the number of threads in the width and the warp pattern repeat.

Number of threads and the length of the warp are taken from the Calculation of thread consumption

dialog.
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• Threads – number of yarn cones in one section

• Times – number of section’s repeat

• Filling direction on the creel of warper. Program allows eight filling directions (the letters indicate

direction of first and second move), which have to be declared in the warper configuration file. To

change the direction, click on the icon.

The goal of ArahWeave is to allow you graphical specification of number of warping sections, relative

length of each section, with the number of repeats of each section. The output of the program is the

exact count on cones for each yarn color and for each length (number of warp repeats).

Figure 353: The Warping dialog
 

Program also gives you the graphical map of cone placement on the creel. The cone placement should

be taken with a grain of salt, as intelligent workers may be able to better optimize each individual case.

In the warping window it will also indicate with red or green color, if the number of repeats of each

section is correct.

15.3 HTML OUTPUT

There are three options in the warping section of the HTML output:

• Warp simulation: it creates an image of one repeat of the warp pattern.

• Warp section image adds an image of current warp section, with the unused parts of the warper

marked in black and white check board pattern.

• Cone layout enables or disables cone section layout printout.

In the report of the warping section, the program explicitly tells that one section is equal or mirrors a

previous section, if one section repeats a previous one. If the section is a complete repeat or mirror of

another section, it is not reported in table form to save space in the HTML report.
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Figure 354: HTML output of warping data

16 CALCULATING THE PRICE OF FABRIC

16.1 NECESSARY INPUTS FOR THE PRICE CALCULATION

You have to input following data in the  Price window (Fabric >  Price) in order to calculate the fabric

price:

• The price for each yarn used in the fabric (in the Yarns window)

• The cost of warping per length unit

• The cost of sizing per weight unit

• The cost of weaving per number of picks (default unit is 1.000 picks; you can change it in the Save

setup > Units)

• The cost of darning per length unit

• The cost of piece dying per weight unit

• The cost of transport per weight unit

To calculate the final price, you have to enter some financial ratios:

• the Operating margin (%)

• Financing (%)

• Provisions (%)

• the Commercial margin (%)

After entering the parameters, click OK to get the price calculation.
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Figure 355: The price calculation dialog
 

If you don’t use some of the production phases, just set them to zero. You can also print out the fabric

calculation, if you select it during HTML saving/printout. If you want to have an online price calculation

during designing, you can enable it in the  View menu, and  the  program will  display the price in the

program title bar based on current fabric parameters.

The processing costs which depend on fabric weight, use the raw fabric weight for calculation.

16.2 SETTING THE CURRENCY

To set the currency, in which you want to

display the price, open the Save setup, and

enter  the  currency  code  in  the  Currency

field.

Figure 356: Setting the currency

17 PRINTING THE FABRIC SIMULATION

ArahWeave always  prints  a  fabric using  current  View mode  and  Zoom level.  Normally,  it  is  the

Simulation view at 100% Zoom. But any other combination is also possible. To print a fabric simulation,

select the Print fabric to printer function from the File menu.
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17.1 PRINT SIZE

To control the size of the printout and its position on the paper, enter

the print  size  (Print  width and  Print  height),  and position  (distance

from top and left border  of the paper), in the fields in the  Print size

area.  To  check  the  maximum  printable  area,  press  the  Full  page

button. If you insert an area out of range (too big for the paper size), it

will be trimmed to a specific printer size and you will be warned with a

beep.
Figure 357: The print size

dialog

17.2 SETTING PRINT AREA

The print area starts from the bottom left corner of the fabric in the main ArahWeave window. You can

position to the desired starting point of the printout with the program’s scroll bars.  So if you want your

fabric to be printed from  the first warp and first weft, position the program scroll  bars in the main

window to the leftmost and bottom position.

Figure  358 shows  a  fabric  with  a  circle  motif,  the  size  of  the  motif  area  is  approximately  10x9

centimeters; the red rectangular indicates the print area. If we want to print a motif, we need to move

the program's scroll bars to get the desired print area in the lower-left corner.

Figure 358: The red rectangular indicates the print area

In  case  that  you  can’t  position  the desired  starting  point  of  the printout  to  the lower-left  corner,

because the current view of the fabric doesn’t require scroll bars, there is an additional setting in the

Print fabric to printer window – coordinates of starting point in fabric. You can set the numbers in two

ways: Ctrl+left mouse click in the fabric, where the printout should start, or you can set these numbers

manually in the First Warp/Weft text fields.
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Figure 359: Ctrl+left mouse click in the fabric sets the starting point of printout

17.3 PRINTING OPTIONS

The printing option toggle buttons are below the Print size text fields. Simply, by marking the check box

in front of the option, you include that in the printout:

• Title;  you will  get  an  extended title  with  date,  user  name,  customer name (your company)  and

version of the program at the top of the page. The printed fabric name is the current fabric filename,

but if you enter the data into the Properties window (Fabric >  Properties), then the fabric name is

taken from there.

• ;  You can choose the type of scissors

cut: straight, zigzag with white background,

zigzag with transparent background. 

• Density;  the  density  of  the  fabric  will  be

written in the title line.

• Yarns; the  yarn  color  tabs  will  be  printed

below fabric simulation.

• Color; you can enable  Code,  Name,  CIE Lab

and  RGB values to be printed in  the  color

tab.

• Warp/weft  pattern; you will  get  warp and

weft patterns at the bottom of the printout.

• One  repeat,  as  name  indicates,  will  print

only one repeat of the fabric, mostly useful

for  one  repeat  designs  (blankets,  table

linen).

• ; the text, which you have in the Registered design text field in the Appearance tab of the Save

setup window, will be printed (or saved) in the fabric simulation printout.

• ; if you enable it, the program prints a text, which you have entered in the Custom print text field

in the Appearance tab of the Save setup window, over the fabric simulation.

Figure 360: Printing the fabric simulation
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Figure 361: Registered design text, custom print text and the right side part of the title in the
printout

 

• ;  if  you  check the  Overprint box,  the colors

from the overprint image (Fabric >  Simulation >

Overprint)  will  be  printed  in  the  lower  left

corner of the simulation.

• ;  The  printout  will  be

divided  into  halves:  one for

the  face  and  other  for  the

back of the fabric.

Figure 362: Color chips of overprint image

Figure 363: Face and back printout
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17.4 PRINT PREVIEW

When the settings are correct,  check the  Print preview.  It

displays simulations exactly as it will  be placed on a paper

(left and top offset). If everything is in a proper place, close

the print preview, and click OK.

Figure 364: Print preview

17.5 PRINTER SETUP

If you want to print to  a  different printer or file, you

should select Printer setup in the Print fabric to printer

dialog to change printer settings. In the Printer setup

dialog  (Figure  365),  you have to choose the desired

printer or graphics file format, print mode and density

(in  dpi—dots  per  inch).  For  higher  quality  printouts

use 1440 dpi, but in most cases 720 dpi is sufficient.

Figure 365: Printer set-up

17.6 CUSTOMIZING PRINTOUT

17.6.1 LOGO

To change a logo, which is printed in the upper right corner

of the simulation, you have to replace logo.gif file, which is

in  default  folder  for  saving  fabric  technical  data  in  html

format  (usually  /home/user_name/data/html folder),  with

your own logo image file. It can be in any common graphical

format, but the file name should remain logo.gif.

Figure 366: Logo and website in the
printout

17.6.2 TOP IMAGE

Beside logo, you can add a second image on HTML data sheet.  It will  be displayed at the top of the

page. The file name should be logoHTML.gif and placed in the default folder for saving fabric technical

data (usually /home/user_name/data/html folder).
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Figure 367: Additional image at the top of the technical data sheet.  

17.6.3 WEBSITE

You can have your website address printed near the logo. Just type it in the Print www field in Help >

Save setup > Appearance (please check chapter 20.4 about saving the setup).

17.6.4 TITLE OF THE FABRIC SIMULATION

You can use data from the Properties window (Fabric > Properties) to generate the title of the printed

fabric simulation.  The  HTML fabric  name format text field of the  Generate  filename section in Save

setup (Help > Save setup) enables you to declare which properties are used for an auto-generated fabric

simulation title.

The format of the fabric name formula has only one rule: the number of a field which will be used in

the fabric name, should stand after the dollar sign ($), which is there to indicate that the used number

is the field number and not a character which would be part of the text. After the field number you can

enter whatever character you want, like space, slash,  hyphen, and it  will  be used in  the generated

filename.

The text fields in the Properties dialog have following numbering labels:

Field Label

Division $8, $9  *

Name $1

Quality $2

Design $3

Version $4

Season $5, $6  *

Designer $7

Notes $N

Variants $V

• * $8 takes only the first word (anything until the space character) from the division code (or name),

while $9 takes the whole name. Same applies to Season: $5 takes only the first word, while $6 takes

the whole code.

You can use four additional signs for automatic title generation:
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Fabric filename $0

Jacquard image filename without suffix ** $I

Scissors *** $@

Directory, in which the fabric is saved $D

• ** It is a capital letter I.

• *** Scissors sign can be printed only on multi fabric print,  when the Multi-print option in the Print

dialog is enabled. The scissors mark $@ should be written in the Multi-fabric 1 or Multi-fabric 2 field

of the Generate filename section (see chapter 17.8).

Let’s see an example: if you have written $1  $2/ $3 - $4 as a rule in HTML fabric name format, and have

entered following text in the Properties window:  Overcoat as a Name (Field 1),  117 as a Quality

(Field 2),  B as a Design (Field 3),  and  12 as a Version (Field 4), then the generated name would be:

Overcoat 117/  B – 12.

Figure 368: The fabric properties, which can be used in automatic generated fabric name,
the fabric name rules in Save setup, and generated title on the printout
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17.7 PRINTING MORE SIMULATIONS ON ONE PAGE IN ONE STEP

To print more fabric simulations on the same page, without error-

prone calculation of  positioning  of  the printouts  to the available

space,  you have a possibility  of  selecting two more fabrics  (to  a

total of three) to be printed on the same area. Click on the Fabric 2

button or the Fabric 3 button in the Print fabric to printer window.

This will  open the fabric browser, from which you load additional

fabrics. The  available  area will  be  divided  horizontally  in  two or

three equal spaces.

Figure 369: Printing of two fabrics

17.8 MULTI-FABRIC PRINT

There  is  another  possibility  to  print  more  fabric  simulations  at

once. In the Print fabric window (Figure 360), mark the Multi-fabric

toggle button. The Multi-fabric dialog will pop-up. (Figure 371). Set

the number of fabrics in the Fabrics X and Fabrics Y field. You can

print up to 8 by 8 fabrics. To load fabrics use Browse window, which

you get by double clicking in the window or by clicking the Browse

button  in  the  lower left  corner  of  the window.  You  can set  the

alignment  of  the fabric  title  by  changing  the  alignment  option

buttons.

To view the Print preview, click Preview in the Print fabric to printer window.

Figure 371: The Multi-fabric print dialog and the print preview  

Figure 370: The alignment option
buttons for title positioning
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17.8.1 TITLE OF THE FABRIC SIMULATION IN THE MULTI-FABRIC PRINTOUT

Similar  to  “normal”  printout,  the title  of  the fabric  simulation  in  the  Multi-fabric printout  can  be

generated from the fabric’s preferences. You can have two titles at different positions. The idea behind

two titles  is  to create something similar to “real” fabric  samples,  which are usually  put on a black

cardboard with main design and few color variants, which can have a different title than main design.

Figure 372: Multi fabric print with title one and title two

17.9 PRINTING TO FILE (SAVING FABRIC SIMULATION AS A DIGITAL IMAGE)
Instead of printing it, you can save fabric simulation as a

digital image. In the  Print fabric to printer window click

the  Printer setup button.  In  the  Printer  setup window

choose the graphical format, in which you want to save

the picture (PNG, GIF, JPEG, TIFF), and dpi (dots per inch)

of  the  image.  Dpi  can  be  selected  independently  for

width and height of the image. Click the OK button, and

close the window. Figure 373: Printer setup for saving
simulation as an image file
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In the  Print fabric to printer window, you have the

option to select where this  file should  be written:

the Desktop, USB flash drive or the  tmp folder,  or

you can choose Browse to select a destination from

the file dialog. Then enter a file name for the image

(in Figure  374 it is “sample”). The program adds a

file  name  extension  (file  format)  automatically.

When you close the Printer setup window, there is

new  information  in  the  Print  fabric  to  printer

window:  the  printer name is  changed to a  chosen

file format, then there are the pixel density and the

size  of  image  in  pixels.  When  you  click  the  OK

button, simulation is saved as a digital image.

Figure 374: Printing to file

17.10 PRINTING TO AN UNSUPPORTED PRINTER

ArahWeave superb fabric simulation print quality is  the result of custom printer drivers and printer

color  profiles.  Because  there  are  many  printers  on  the market,  Arahne  can’t  support  all  of  them.

However, if your printer is not supported directly in ArahWeave, you can still print from it (of course, it

should  be supported in  the Linux  OS),  but  the printouts  will  not  have the same color  accuracy as

printed on native supported printers.

To print on a printer, which is not listed in the Printer setup window, you should select TIFF as a type of

your printer. The rest of the procedure is the same as with a “normal” printer. ArahWeave creates an

image file in tiff format, and your Linux print system is  properly configured, the TIFF image will  be

automatically recognized and converted into printer specific code.

17.11 SUGGESTED PAPER TYPE

We calibrate  EPSON Photo printers  using  Epson  Photo  Quality  Ink  Jet  Paper S041061,  so  you  will

achieve color matching results only printing to this type of paper. There is one exception though, Epson

Stylus Photo R2400 uses Matte Paper Heavyweight S041256.

17.12 SAVING FABRIC TEXTURE

To save fabric simulation as a texture (image in repeat for use in ArahDrape, for web background etc.)

choose File > Save fabric texture from the main Arahweave’s window.
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Figure 375: Saving fabric texture
 

The file name is set automatically based on the current fabric name (you can change it, if you want),

plus the suffix from the chosen image format. You can set image format (JPG, PNG, TIFF), dpi – dots per

inch; probably 100 to 150 dpi will suffice for most cases, and the number of design repetitions.

Program displays the actual texture size in pixels above the file name, so you have the feel for the size

of your texture. If your fabric repeat is small, and the pixel size is 3000×3000, then your dpi is probably

too high. If your image repeat is very big, you can also lower the dpi to get a reasonably sized fabric

texture. Also, if the file size is too big, you can choose PNG as a file format, and mark the 8-bit button to

save texture in the indexed (256) color mode. This will make a much smaller image, and ArahDrape will

work much faster, as it will need less memory.

If you want to save only the warp image, tick the Warp check box next to the warp icon .

18 SAVING LOOM (OR OTHER CAM) DATA (CARDS FOR PRODUCTION)

18.1 SAVE CARDS FOR PRODUCTION DIALOG

Arahweave’s  Save cards for  production dialog enables you to save a fabric  data into any supported

machinery format (a machine readable file),  which you then transfer by data storage medium (floppy,

USB flash drive) or network to the loom controller, jacquard controller, or to the electronic card punch

machine, warper or drawing-in machine. 

The appearance of the  Save cards for production window depends on the chosen machine and a file

format, as some formats have more options than others. Saving to jacquard format (Stäubli,  Bonas,

Grosse...) means the most complex window with hook layout and other settings. If you save a file in

one of  the loom (dobby)  formats,  a dialog  window looks  similar  as  for Jacquard,  except it  doesn’t

contain  a  hook  layout,  while  a  dialog  for  saving  to  drawing-in  machine  format  or  warper  format

basically consists just from filename field and the OK button.

Almost all  necessary information for creating a CAM file is  taken from the fabric  file,  like a weave

structure, weft color pattern, a regulator and variable weft density. Usually, you need to edit the hook

layout, then enter the selvedge weave, choose a format and destination for saving, and a filename. 
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Figure 376: Save cards for production window; a Jacquard layout

Figure 377: The program hides the jacquard hooks layout, if you choose a loom (like Dornier, Picanol,
Vamatex…) format

When  you  finish  editing  various  settings  in  the  Save  cards  for

production  window,  you  can  save  the  loom  layout  for  future  use

(choose  File >  Save loom layout from the menu bar in the  Jacquard

conversion window). To load a loom layout, choose  File >  Load loom

layout, or click Choose in the same menu bar, which displays a list of

saved loom layouts in the currently selected loom directory. The list

shows more information (format, number of hooks, a file name) than

usual Load file dialog, so it is easier to find a layout you want to use

for saving a production file.
Figure 378: List of saved loom

layouts shows more
information than usual Load file

dialog

18.2 SETTING THE NUMBER OF HOOKS ( JACQUARD)
The number of hooks is basic information, when you save a jacquard

card. Enter it in the Number of hooks field.

Figure 379: Number of hooks
and Weft bytes fields
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18.3 SETTING THE NUMBER OF ELECTRONIC FUNCTIONS ( JACQUARD)
With the mechanical Jacquard, additional Jacquard functions (weft selection, regulator,  weave fringe,

pile  loops...)  could only be controlled by using actual hooks. Instead of  these  function hooks,  most

electronic  Jacquard  machines have  electronic  functions  (virtual  or  electronic  hooks),  which  don’t

actually  show  up  in  the  head  as  physical  hooks.  Bonas  controllers  always  include  32  of  these  in

positions 1..32 (the first physical hook is #33) while Grosse controllers optionally include 64 to the right

of the last real hook. Stäubli controllers optionally include 32, positioned either to the right or the left

depending on your preferences.

Enter the number of electronic functions in the  Weft bytes field next to the Hooks field (see Figure

379). Usually it is four bytes (32 hooks). For the exact position of each control bit (hook) refer to your

loom and Jacquard documentation.

18.4 SETTING HOOKS POSITION AND FUNCTION (LOOM LAYOUT)

Usually we use some of the hooks in the jacquard head for other

purposes than lifting heddles (warp  threads), for example, weft

change,  regulator,  selvage,  weft  density.  You  set  the  position

and function of  hooks  in  the  Loom layout section of  the Save

cards for production window.

Figure 380: The Position and
element type button and the

Length field

To choose the type of the field (hooks function), click the field button (it

is labeled  Empty hook by default),  and select the function (type) from

the  drop  down  menu  (Figure  381).  In  the  Length field,  enter  the

determined number of hooks for that function. Then press the Enter key

on  the keyboard,  which  confirms  the data  and  opens  the next  field.

ArahWeave limits the number of fields in the loom layout to 50,  which

should  be more than enough in  most  cases.  When you enter  all  the

fields, save your loom layout (File >  Save loom layout),  so  that you will

have it ready for next time.

Figure 381: Menu for
selecting hooks function
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18.5 LOADING THE SELVEDGE WEAVE

To load a selvedge weave into the Save cards for production window, do one of

the following:

Double click on the  Selvedge area on the right of the window. It opens Weave

editor’s file dialog, from which you load the weave to be used for selvedge.

• Select  the  area,  labeled  Selvedge,  and  load  any  of  the  default  weaves by

pressing weave’s shortcut on a keyboard (see Chapter 5.7).

• Click the  Weave to editor icon ( )  which replaces the current weave with

selvedge weave in the weave editor. Apply desired changes on the selvedge

weave,  and  click  the  Weave  from  editor icon  ( ).  This  action  puts  the

selvedge weave back to the Save cards for production window, and restores

the previous (jacquard) weave in the weave editor.

Figure 382: The
selvedge weave

entry

To delete a selvedge from the field, select it and press the Delete key on your keyboard.

If the repeat of a selvage weave divides the number of wefts in the design, the weave dimension is

depicted in black; otherwise, it is shown in red.

18.5.1 ELONGATING THE SELVEDGE ON REGULATOR

You can add a space for the extra wefts in the selvedge by using the  Elongate selvedge on regulator

option. It  can have five distinct settings ranging from 0 to 4.  A value of 0 (zero) indicates that the

application does not modify the selvedge. When set to 1, it repeats the selvedge weft on the regulator

with the same weaving points as the previous weft. If it is set to 2, it replicates it in the warp direction

as well. At 3, it will place blank weave (warp down) on the wefts of the regulator. At 4, the warp-up

weave will be placed on the regulator's weft.
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Figure 383: Regulator is highlighted in red and selvedge is highlighted in
green on the jacquard card previeew. The image depicts five different

elongation option possibilities.

18.5.2 FIL COUPE SELVEDGE

It is  a special function for handling selvedges in fil coupe. Some customers complain that cutting of fil

coupe threads tears off the selvedges, if fil coupe threads are woven in the selvedge. But we can also

not leave them unattached on the edges, since they will  randomly fall  back in the fabric and create
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defects. By enabling  Fil coupe selvedges, the program will put  a weave for fil coupe weft only on the

first six ends of the selvedge. That is enough to make them stay at their place during weaving, but they

will also gracefully fall out during fil coupe shearing. Again, some people don’t like this, and you can

disable it.

This option is available only when the ArahWeave mode is set to Expert.

18.6 WEFT CHANGE, CUSTOM WEFT CHANGE

When one hook activates one weft, this is referred to as a typical weft change. In the Save cards for

production window it is simply indicated as  Weft change. It is  the default setting in  ArahWeave, and

program automatically takes one hook for one weft – first hook for weft a, second for weft b etc. But

some Jacquard settings have so called Custom weft change. In this case you should choose Custom weft

change in your Loom layout and load a weave, which indicates the position of weft selector hooks, in

the Custom weft change field in the right column of Save cards for production window. To load a weave

into the field (you have to prepare and save a weave before) double-click on Custom weft change field.

The file dialog will pop up, and you have to double-click the desired weave file.

Figure  384 shows  the position  of  eight  weft selectors:  normal,  and  two examples  of  custom weft

changes: binary and doubled weft change.

Figure 384: Normal weft change, binary, and custom weft change

 

Figure  385 shows  the  weft  change  of  pattern

1a1b2c1b1d in Jacquard cards with normal weft change,

binary weft change, and custom weft change (note, that

last one is just an example of custom weft change; your

may be different). Last column is just a color indication

of weft selection.

No matter which type of weft selection you use, the weft

pattern  is  always  taken  from  the  Edit  warp  and  weft

pattern window.

If the weave size in weft direction is not divisible by weft

pattern repeat, the program will make a Jacquard card in

the size of lowest common multiplier. Example: if your

weft  pattern  repeat  is  6,  and  weave  size  is  100,  the

height of Jacquard card will be 300.

18.6.1 WEFT REPEAT LIMIT (65533 THREADS)
Sometimes users combine a weave with a weft pattern whose repeat number is not divisible by weave

height. In that case, the program automatically prolongs the height of the fabric repeat until the weave

height and weft pattern match. If they don’t match, it stops at a height of 65533 wefts. (If you have the

ArahWeaveXL edition, this limit is set to 250000 picks.)

When you save a jacquard card of such fabric, the program

creates  an extremely  large file,  because the file  will  have

65520  wefts  (picks).  To  prevent  this  kind  of  problem,

ArahWeave issues  an error if  the final  repeat is  cut off at

65533 threads, but a weave or a weft pattern do not have a

repeat of 65533 wefts.

Figure 385: Weft change 1a1b2c1d1b

Figure 386: Error message tells you to
check the weave and weft pattern repeat
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The fabric repeat size, expressed in the number of warp threads by the number of weft threads, is

always displayed in the window title, so pay attention if you see the number 65533 in the window

title.

18.7 ENTERING A FILENAME

Type a filename of the CAM file, or click the arrow  at the left of the Filename text field to auto-fill

a  fabric’s filename into the  Filename field. The necessary prefix or suffix will  be added automatically

according to specifications of the selected jacquard format. Some jacquard formats may not be able to

handle  long  filename;  use  only  8 characters  for  filename  if  you  run  into  trouble.  ArahWeave

distinguishes capital and small letters. If you are still using floppies, insert an empty MS-DOS formatted

floppy, click OK, wait a little and your design is ready for weaving, or choose location on a hard disk, or

send a file by network to the loom.

18.8 SELECTING A FILE FORMAT

Select the desired electronic jacquard format from

the drop down menu. The first group contains the

true  electronic  jacquard  formats,  the  second

contains  graphics  file formats  (you might want to

use it to transfer data to another CAD system), the

third contains electronic dobby formats, and fourth

the drawing-in machines.

Figure 387: Choosing CAM format

18.8.1 SAVING BONAS FORMAT EXCLUDING ELECTRONIC FUNCTIONS (WEFT BYTES)
There is special case with Bonas format implementation in some Jacquard machines, mainly in China,

when electronic functions should not be written in the file (technically speaking they are written, but

the 32 bits are taken from the number of hooks), otherwise a loom controller can't read a file. So, to

write a file without electronic bytes, set the number of weft bytes to 0 (zero), and mark the Weft bytes

first check-box. Program will write a jacquard file in a width that exactly matches the number of hooks

set in the loom layout.

Graphics file formats

Jacquard formats

Dobby formats

Drawing-in

machines
Warper formats
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Figure 388: Saving a file in Bonas format without weft bytes

 

18.9 CHOOSING A LOCATION FOR SAVING CAM (MACHINE) FILE:

Prior to saving the file, choose a location for saving a file. You have following 

options:

• A: (a floppy disk).

• Desktop: (it is easy to copy or attach from here).

• /tmp/: (to put it in the temporary directory of Linux).

• Browse: to select directory.

• Send: to send it via network to the loom.

• USB: When selected, the program saves a file to USB flash memory.

• Emulator: When selected, the program saves a file to USB flash memory, which 

should be formatted as a floppy disk to use with the Floppy emulator drive 

(please note, that user should be in the disk group in Linux system. This allows 

formatting of the USB memory drive to regular users.)

18.9.1 WRITING A FILE TO MULTIPLE FLOPPY DISKS

You can save up  to 1.44  MB of  data on a  floppy  disk.  If  you

choose a floppy disk as a destination for saving and a jacquard

file does not fit on  a  single floppy  disk,  ArahWeave splits a file

into as many as needed floppy disk files.  For instance, if  a file

size is 3 MB, it will be split into three files: 1.44 MB + 1.44 MB +

0.28  MB.  The  Save  cards  for  production  dialog  will  pop-up,

displaying buttons labeled with file names. To copy a file, insert

a floppy disk,  and click the first file name button. Wait until it

finishes copying the first file. Eject a floppy disk, insert another

one, and click the second file name button. And so on till the last

one.

Figure 390: Saving a file to multiple
floppy disks

The dialog also offers the possibility to copy all the files to the desktop (click the Copy files to desktop

button). This is useful for customers, who do not have a floppy drive (for example Mac users) and only

Figure 389:
Choosing a
location for
saving a file
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want to email the files to the weaving mill, which will later copy them to floppy disks. This operation

will only work for jacquard floppy disk formats in DOS format. So Stabuli JC3 and JC4 are not supported.

18.9.2 USING USB FLOPPY DISK DRIVE EMULATOR

A USB floppy drive emulator is a small box with a USB port, a plug-in replacement for a floppy disk

drive. It  has the same size and connector as an old  regular floppy disk  drive,  so  it  is  quite easy to

replace a floppy disk drive with a USB floppy drive emulator. After you have installed an emulator into a

jacquard controller, it will think it still works with an ordinary floppy disk drive.

Figure  391 shows  a  USB  floppy  emulator

installed on  the Stäubli  JC5 controller.  There

are  three features  on  the front  side:  a  USB

port,  where  we  plug  a  USB  flash  memory

drive,  a  two-digit  display,  which  shows  a

number of the selected floppy, and two push

buttons, which enable us to set a number of a

floppy,  from  which  we  want  to  access

designs. You can store up to 100 virtual floppy

disk  drives on the flash memory drive (from

00 to 99). For instance, if you have saved a file

to floppy no. 5, you have to set the number on

the  display  to  05,  and  then  insert  the  flash

memory drive. 

Before  installation  of  the  USB  floppy  emulator,  you  should  check  the

position of a jumper on jumper pins on the backside of the emulator. For

instance,  the JC4  controller  requires  a  different  position  of  the jumper

than the JC5 controller. The JC4 jumper must be on S0 position (first pair

of pins), while the JC5 jumper must be on S1 position (second pair of pins).

Figure 391: USB floppy emulator installed on Stäubli JC5
controller

Figure 392: Jumper pins,
connector pins, and power
connector are located on

the backside of an
emulator.
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18.9.3 SAVING DESIGNS TO A USB FLOPPY EMULATOR WITH ARAHWEAVE

Prior saving a design to USB floppy emulator, you have to format a USB Stick in a way that it will be

recognized on Jacquard controller  as  a  “virtual  floppies”  carrier.  To do this,  set  the Emulator  as  a

destination for saving in the Save cards for production window, and choose File > Format USB for floppy

emulator. The Format USB for floppy emulator dialog will open. Enter the floppy range, determined by

From and To number. Figure 393 shows formatting of 21 virtual floppy disk drives – from 0 to 20.

Figure 393: Formatting a USB stick for use as a floppy disk drive emulator

When you save a design to Emulator, you have to

specify  the number of  the virtual  floppy that you

want to save a design to. 

If a design requires more floppy disks, it will start writing from selected

floppy onward. For instance, a design from Figure 394 will be written on

three  floppies:  No  5,  No  6  and  No  7.  When  you  load  a  design  on  a

Jacquard controller,  you will  need to set  the emulator  number to 05,

load first floppy, disconnect the memory key, then change the number to

06, connect the memory key, load a second floppy, again disconnect the

memory key, set the number to 07, connect the memory key, and load

the design's last part.

18.9.4 CONFIGURING AN EXTERNAL (USB) FLOPPY DRIVE ON OPENSUSE LINUX 
If you need to write only DOS files, like Bonas, Grosse, JC5, JC6 and most of newer dobby formats, you

can save file to a hard drive, and then copy it to a mounted USB floppy in Dolphin file manager. Or

mount a floppy first, and then use the Save to USB option in the Save cards for production window in

ArahWeave.

But this way of writing a file to the USB floppy has one serious shortcoming. If the file is bigger than 1.4

MB, you can’t save it. Multi-floppy file writing works only, if  the ArahWeave thinks that you have a

Figure 395: Multi-floppy
design

Figure 394: Selecting a floppy number in the From
field
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“real old” floppy drive. A USB floppy drive is recognized by the system as a regular USB memory device,

like a USB memory key, except that is, by today’s standards, extremely small.

So, if  you want to write non-DOS file formats (JC3,  JC4),  or multi  floppy JC5, or some older dobby

formats, you have to fool the system that your USB floppy drive is actually the old a: drive. To do this,

you need to edit one of the Linux configuration files, like it is described below.

• Connect a USB floppy drive  to PC; no floppy inside.  There shouldn’t  be any other USB memory

devices connected.

• First, you need to find which device name is used in your system for the USB floppy drive. Open a

terminal window (System > Terminal > Konsole (Terminal).

Figure 396: Opening the terminal window

 

• In the terminal type following command (press the Enter key after it): ls /dev/sd*

The output of the command is the device list. You can distinguish the USB floppy drive from the hard

drive(s) quite easily: the USB floppy drive is usually listed as a last device, and it does not contain

partitions, which are represented as numbers on the end of the names. On the image below, the

floppy drive is labeled as /dev/sdb

Figure 397: The terminal window
 

• Then go to Suse menu (green icon) > System > File manager > File manager -Super user mode.  After

opening, you will need to enter the administrator (root) password.

Figure 398: Opening the file manager - super user mode
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• In the file manager, navigate to /etc/init.d, and right-click on the boot.local file icon. Choose Open

with > Kwrite.

Figure 399: Opening the boot.local file in KWrite
 

• Add the following lines at the end of a file (we use  /dev/sdb as a device name in the commands

below. You should use the device name according to the output of  ls /dev/sd* command on your

system.):

rm /dev/fd0

chmod 777 /dev/sdb

ln -s /dev/sdb /dev/fd0

ln  -s   /dev/fd0 /dev/fd0h1440

chmod 777 /dev/fd0*

Figure 400: Editing the boot.local file
 

• Save the file (File > Save), and close KWrite editor.

Figure 401: Saving a file
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Restart computer. If you leave the USB floppy drive plugged in all the time, it will always use the same

device label, so you won’t need to modify the boot.local file again.

With  these  settings,  you  need  to  choose  a: as  a  destination  for  saving  in  ArahWeave.  Also  for

formatting, you need to choose either Format floppy or Format floppy JC4.

To save to Dornier Dialog Panel II amv format you need to install the “dosemu” program in Yast.

18.10 CARD PREVIEW

The Card preview enables checking the data prior writing them in the Jacquard format. We want to be

sure that weave design parts are at the correct locations, so on the top middle of the window, you have

one button for Verdol cards preview, and another for linear card preview.

Figure 402: Verdol type of card preview

 

Figure 403: Linear type of cards preview

 

As you move the mouse in the preview, it shows you the current / hook / weft position. Zoom in/zoom 

out works the same as in the main ArahWeave window, Ctrl + mouse wheel, or you can press  or 

icons.

18.11 OTHER OPTIONS OF THE SAVE CARDS FOR PRODUCTION DIALOG

· If you still use mechanical Jacquard machines,  controlled by paper cards, instruct the program to

Repeat the first weft,  which makes  it  easier to attach the paper cards into an endless loop.  You

should not use this option, if you have an electronic jacquard.

· By selecting the Raise unused toggle button, the unused hooks will be raised. On some electronic

jacquard machines, the energy consumption is lower if hooks are raised, so it is preferred to have

them in that position.
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· Weft bytes first: weft bytes are written at the right part of the cards (after “real” hooks section).

Some file formats require weft bytes at the beginning (left side of the cards). If this is your case,

mark the Weft bytes first toggle button.

· Regulator in ground can be used to diminish the error in weaving, when the loom switches from

weaving with regulator to normal weaving. On some very dense upholstery fabrics, and sometimes

also on curtains, this can be seen as a line of irregularity in weaving. If you set  the  regulator in

ground to one, then the program will  add one regulator to every second ground weft. This  will

effectively double the density, so you need to halve the loom density, in order to keep the proper

density of weaving. The loom will then weave with the regulation (stop motion) on all areas, so the

transition from weaving with regulator and without regulator will be less visible. This is the only

parameter of the loom layout which gets saved in the fabric, and not in the loom layout. The reason

is, that problematic regulator handling is more a property of a particular fabric than of a loom.

· Elongating the selvedge on the regulator does exactly that—it makes room for the extra wefts in the

selvedge. It can have five distinct settings ranging from 0 to 4. A value of 0 (zero) indicates that the

application does  not  modify  the selvedge.  When set  to  1,  it  repeats  the selvedge weft on  the

regulator with the same weaving points as the previous weft. If it is set to 2, it replicates it in the

warp direction as well. At 3, it will place blank weave (warp down) on the wefts of the regulator. At

4, the warp-up weave will be placed on the regulator's weft.

· Fil coupe selvedge enables a special function for handling selvedges in fil coupe. Some customers

complain that cutting of fil coupe threads tears off the selvedges, if fil coupe threads are woven in

the selvedge. But we can also not leave them unattached on the edges, since they will randomly fall

back in the fabric and create defects. By enabling Fil coupe selvedges, the program will put a weave

for fil coupe weft only on the first six ends of the selvedge.  That is enough to make them stay at

their place during weaving, but they will also gracefully fall  out during fil coupe shearing. Again,

some people don’t like this, and you can disable it.

This option is available only when the ArahWeave mode is set to Expert.

· Invert regulator: default sign for regulator on is a black point (up). Some looms use white point for

regulator on, and black point for regulator off. If this is your case, switch on the Invert regulator

toggle button.

The loom layout follows some implicit rules, that should be OK for the majority of cases, but it does not

hurt if you know what they are:

• If the specification of layout is shorter than the number of hooks, it will be automatically repeated

to fill in the unused hooks. If you want the hooks to remain unused, add an empty field at the end.

• The Selvedge mirror entry serves for mirroring left selvedge to the right one, if you use such layout.

• ArahWeave permits creation of a design with a selvedge weave, which does not divide the jacquard

weave, or a weft pattern which does not divide the jacquard weave.

18.12 ONE PIECE DESIGNS

Some designs like blankets, shawls, napkins, or table cloths are woven as “one piece designs”, so they

require at least a cut mark between two pieces. Instead of drawing it in an image or in a weave, you can

add wefts for Top edge, Bottom edge, Fringe and Cut mark in the Save cards for production window. You

get these options after marking the One piece check box. For every option you can enter the number of

weft threads. If you select Top edge or Bottom edge, then you need to load the weave for each one. To

load a weave, double click on the Top edge area in the column on the right. It opens Weave editor’s file

dialog, from which you load the weave to be used for  Top edge. Repeat procedure for  Bottom edge.

Between two pieces you can have fringe. Specify the length of the fringe (number of weft threads) in

the Fringe field. If you check the Cut mark box then program puts two threads in a plain weave in the

middle of fringes,  so you can separate two fabric pieces exactly in the middle. If  you want to have

fringe at the beginning and at the end of repeat, turn on the Center button. Program splits the number

of fringes, and puts half of them at the beginning, and half of them at the end of one piece design.
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Figure 404: Settings for One piece design in the Save cards for production window

 

18.13 CREATING FABRIC HEADER AND FOOTER

ArahWeave enables  the  user  to  create  a

production label, which can be woven as the initial

and final part of the jacquard fabric.

Figure 405: Fabric with a woven label

18.13.1 STEPS IN CREATING HEADER AND FOOTER

To open the  Make fabric  header/footer dialog choose  Change >  Make fabric  header/footer from the

Save cards for production window menu bar.

Figure 406: The Make fabric header/footer dialog

 

• Defining weaves

ArahWeave takes the main weave for the label directly  from the weave of  jacquard design.  This

guarantees that the quality of the label is the same as quality of main fabric, thus not causing any

problems later in the finishing. But you define (load from library) weaves for three different parts of

header/footer:

Title – weave for characters in the text (if you  don’t set it, the program simply takes the inverted

jacquard weave for the character weave).

Background – weave of the letters background.

Border – weave for the  Top edge,  which is  woven after  fabric’s header,  preventing header to be

damaged, when you put fabric off the loom.

• Choosing a starting weft 
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By default, fabric’s header starts with a design’s first weft (pick), so it just continues (repeats) from

design. If for some reason you want to use a different part of the design for the label weave, you can

set a different starting point of the label weave.

• By default,  the  header has  the  same content as a footer. If you want to have them different, just

uncheck the Header = Footer   check box, and a new editing space for footer is added to the Make

fabric header/footer window.

• Setting the number of picks for label and label text

Enter the number of picks used for  the  whole label  in the  Picks field.  Enter the number of picks,

which will be used for the text, in the Label field. Apparently, the Label number cannot exceed the

Picks number. Then, you can also define the number of border picks. Border is usually added at the

end of header to prevent label damage, when you remove fabric from the loom.

• Setting the text layout (orientation, alignment, position)

You have full  freedom to position  the label  text  any way you

want. First  set the orientation (mirroring),  then the alignment,

and then the vertical position.

To align text within the left and right edges, use the Align left ,

Center , Align right , and Justify (repeat across whole design

width)  icons.

To align text vertically within the top and bottom edges of the

label, use the Align top , Center , and Align bottom  icons.

The text mirror feature enables you to create readable text on

reversed fabric. 

Figure 408:  Four examples of same text created with different mirroring options
 

• Enter the text you want to have in the label.

The text entry field for the label is next to the number of wefts

for label text 

• Setting the weft thread pattern for a label

By default,  ArahWeave takes a weft color pattern from the main design. If you want that label  to

differ  in color from  the  main fabric or you  just  want to use a different pattern, set it in the  Weft

pattern text field. Additionally, you can define the pattern for Top edge.

• Setting the number of design repeats (weaving program)

Figure 407: Orientation,
alignment and vertical

justification options

Figure 409: Text entry field for the
label
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Set the number of weave repeats to be woven before the header  in the  Weave repeats field. For

example, if  the repeat size is  half  of  a  meter, and the length of piece on the loom should be 70

meters, then you set the Weave repeats to 140.

Picks – similar to weave repeats – here you set the number of picks to be woven before the header.

Obviously, ArahWeave can take into account only one parameter, either number of weave repeats or

number of picks.

• Saving header/footer card files for production:

The last section of the Make fabric header/footer window consist of three options:

Modify fabric is mainly used as a header/footer preview. ArahWeave adds header and footer to the

initial fabric and generates a new fabric. If you want to save cards of the header and footer, you have

to load the initial fabric again and use the Make cards function.

Make cards saves three jacquard card files (the file of initial fabric, and both header and footer card

file) to the location, which is set in the Save cards for production window. ArahWeave will also write

Stäubli program file, which starts with  a  footer, continues with  a  configured number of repeats of

the main design and finishes with a header.

Make fabrics saves only header and footer fabric files for later use.

Figure 410: The initial fabric, and the modified fabric with header and footer  

18.14 WEAVE SHUFFLE

Weave shuffle function enables you to mix the pattern hooks in the desired order. If you leave it empty,

a pattern will be unchanged and will repeat in the normal way. If you enter 1 2 3 0 the pattern will be

interpreted as 1 2 3 0 4 5 6 0 7 8 9 0 10 11 12 0... where 0 means skipped (unused) hook. This can be

useful for lowering the warp density without changing loom tie-up.

You can also mix groups of hooks like this 1 3 2 4 The interpretation will be 1 3 2 4 5 7 6 8 9 11 10 12 13

15 14 16 17 19 18 20... This can be useful for terry or velour fabrics, when you want your hooks to be

rearranged in a special way due to the way your loom is operating. And last, but not least, you can

write your complete layout from the first to the last pattern hook. This gives you complete freedom to

shuffle it any way you want. The field to enter weave shuffle is visually short, but can contain large

quantities  of  data,  up  to  60000  characters,  which  is  enough  for  specifying  20000  hooks.  This

information can then be saved to a loom layout file for future reuse. If you have support from Arahne,

and you do not change a loom layout every day, then Arahne will prepare the layout according to your

wishes.
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You can also specify  ranges of  numbers in  the weave shuffle. This  is  useful,  if  you have numerous

hooks, which should be just mirrored or mixed by large consecutive blocks. Now you can specify hook

shuffle range simply by writing 5-10, which means the same as 5 6 7 8 9 10, or 10-5, which means the

same as 10 9 8 7 6 5. The ranges are always consecutive and inclusive of the first and last hook. If the

first number is lower than the second, then the range is rising, otherwise it is falling. You should not

have any spaces between the minus (-) and the range numbers.

When you use  the  weave shuffle, it  is  important to know the total number of hooks in the shuffle.

Program will calculate that for you in the Weave shuffle label as for example Weave Shuffle [4800]. This

is especially useful if you have skipped hooks (shuffle with zeros), since the program will calculate both

the total number of hooks in the shuffle, as the effective number of hooks (the number of hooks which

are actually working). This will be displayed as Weave shuffle [1320->1200].

Usually, the shuffle is applied only to the design hooks. But in some special cases, you also want it on

the selvedge hooks, so you can click on the Selvedge toggle button within Weave shuffle to enable it.

18.14.1 CHANGING STARTING POINT OF JACQUARD CARD WITH WEAVE SHUFFLE

Sometimes you don’t want to start a Jacquard card with a first thread in the weave, but with some

other. You can shift the weave, but it is faster, if you “tell” the program what the starting point should

be. Just enter the desired number in the weave shuffle field, for example 1201–and the first pattern

hook will be taken from the weave position 1201. 

18.14.2 MAKE SHUFFLE: DOUBLE REPEAT HALVE DENSITY

A loom equipped with Jacquard offers great design flexibility with respect to dobby loom. Any kind of

weave  can  be  woven without  changing  the  loom.  But  this  flexibility  comes  at  a  price  of  one  big

inflexibility: you can't easily change warp density, or total number of warp threads. On dobby, you can

simply use a different reed, you insert the threads in the shaft’s heddles the way you want, and you

have any density you wish. In jacquard the hooks are tied up to the loom in a certain way, and there is

no simple way to change it. Tying hooks on a jacquard can take a few days, and costs a considerable

amount of money.

So a weaver must resort to advanced tricks to weave at a lower density. We will try to weave with two

times  lower  density,  but  without  losing  any  of  the working  hooks.  Our  pattern  will  not  have  less

resolution. This trick is only applicable, when you have a smaller jacquard which needs to repeat the

hooks two or more times, to weave all the warp threads. On a full  width (jumbo) jacquard, you can

simply use the weave shuffle of “1 0”, which means that every second hook will be skipped, and this is

it. On a repeated layout, the shuffle of “1 0” would cut down the number of useful hooks from, for

example 1200 to 600. We do not want this. We wish to lower the density two times, we don’t want to

change hook arrangement to the loom, and still use the full 1200 hooks for the design. Can it be done?

Smart people can do it.

This  function automatically  writes a shuffle, which enables you to make a design with double sized

width of the repeat. The design will halve the density of the current setup, because you use odd hooks

(1,3,5,...)  in the first half of the repeat (even hooks are unused in this part), and even hooks in the

second part of the repeat (odd hooks are unused in this part). For instance, if you have 2400 design

hooks, ArahWeave will write the following shuffle: 1, 1201, 2, 1202, 3, 1203, 4, 1204...

Figure  411 shows two fabrics woven on the same loom, but fabric on the right was made with halve

density of the first fabric, so the repeat is twice bigger. The Jacquard card was modified by using the

Double repeat-halve density function.
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Figure 411: Double repeat halve density
 

18.14.3 SKIPPED HOOKS MAP

Instead of entering skipped hooks with zeros,  you can draw an image  in  ArahPaint (or weave in the

weave editor);  the size  of the image in horizontal direction should be equal to  the number of hooks.

Size in vertical direction is not important, it can be  simply  2.  Then draw the skipped hooks by black

points. It is easy in the weave editor with a copy tool. So you get the Skipped hooks map image, where

black points represent the skipped hooks on the loom. Save this “hooks weave”, because you will need

to load it into the Save cards for production window.

Figure 412: Draw the skipped hooks image (weave)

 

Open Save cards for production. The last section on the left is  the Skipped hooks map. Load the “Skip

hooks map” weave into that field. The numbers on the weave shuffle tells you how many hooks are

skipped out of all  hooks,  and out of design hooks.  In Figure  416 the number of hooks is  2688. The

number of skipped hooks is 168. Out of 2400 design hooks there are 2250 working hooks.
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Figure 413: Save cards for production with skipped hooks map

 

The cards preview shows the position of skipped hooks.

Figure 414: Cards preview; notice the skipped hooks

 

If  you have mirroring,  or pointed hooks,  you have to write them in the weave shuffle field without

skipped hooks. Only working design hooks should be written.

18.14.4 EXTRACTING WEAVE SHUFFLE WITH SKIPPED HOOKS FROM OLD FILES

Sometimes  you  have  a  very  complicated  loom  layout  (cast-out)  where  hooks  are  dropped  in  an

irregular manner, for example in first 100 hooks designs skips every 9 th hook, on hooks 101-1100 every

8th hook is skipped, and on hooks 1101-1200 again every 9 th hook is skipped.

Sometimes you are lucky and you already have a design with such a cast-out. If only you could import

this cast-out in an automatic way! Fortunately, you can. First you load this card image and remove the
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empty space and weft change, so that you are left with only the weave (with skipped hooks) in the

weave editor.  Then, in the window  Save cards for  production,  call  function  Change >  Guess  skipped

hooks. Program will check which hooks are skipped and which are not, and write you the weave shuffle

in an automatic way. This can serve as the base for your new loom layout.

18.15 STÄUBLI JC5 ZONES

If  your selected jacquard format is Stäubli  JC5, you have an additional field at the end of your hook

specification: Zones. The Zones field allows you to divide the hook areas into distinct sections (zones),

each with its own name. Normally, there are the hooks on zone one, and weft (function) bytes are on

zone two. You can use the Weft bytes first toggle button to put them before or after the jacquard hooks

zone. If you want something more complicated, you must use the Zones field. This is an example of a

zone entry:

48(left selvedge)2400(design)48(right selvedge)32(control)
This  specifies the total of  2528 hooks and gives proper names to the zones (in  parenthesis).  If  the

number of hooks does not match the sum of zones, then zones are not used. The use of zones can

simplify changing of the selvedges on the loom controller, since it is easy to change the weave in the

whole zone.  Sometimes,  a  specific zone layout  is  required to load the design  onto the Stäubli  JC5

controller, if the user is not able to configure the input filters on the controller. So we must write the

design with the exact same layout of zones as the controller is configured to.

18.16 STÄUBLI JC6
The new Stäubli JC6 controllers can display images and some additional information, which are stored

in  the JC5 card file.  ArahWeave stores  fabric  simulation,  the name of  the weave,  number of  warp

threads,  weft  density,  names  of  weft  colors,  and amount  of  each  weft  color.  These  are  saved

automatically, if you select JC6 jacquard format. The file extension of the saved file will still be JC5, and

the resulting file is compatible with JC5 controllers. The JC6 file size is slightly bigger, since it also stores

the image icon.

Figure 415: Stäubli JC6 controller
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Figure 416: Full screen simulation preview on Stäubli JC6 controller  

18.17 SUPPORT FOR DOBBY CAM INTERFACES

You can save the weave card in following loom formats:

• CCI Tech (write)

• Dornier AMV (write)

• Dornier DoTech (write)

• Dornier DoStyle (read and write)

• Dornier DoWeave (read and write)

• JiangYin TongYuan SGA598 (write)

• Nuovo Pignone FAST (write)

• Panter (read and write)

• Picanol Des (write)

• SmitTextile G6300 (read and write)

• Somet DOP / COP (read and write)

• Stäubli 1858III (read and write)

• Toyota JAT710 (write)

• Vamatex PID / PIW (read and write)

18.18 SUPPORT FOR DRAWING-IN MACHINES

The support for these machines is available as the last group of entries in the selection of jacquard

formats. When you select VEGA format, almost all the loom layout entries are hidden, since they are

not used. But a new field appears – Drop wire rows,  where we can select the number of rows of drop

wires. Almost all other parameters for creation of drawing-in data are present in the weave window

(drawing-in)  and in  the  consumption window (denting  for  selvage,  denting  for  pattern,  number of

threads for selvage, etc.). The only other parameter which you can enter is selvage weave – you can

load it in the same way as for jacquard. The selvage shafts will always be extra to the normal pattern

shafts.

ArahWeave, due to its dual dobby / jacquard nature, also supports complex setups, where you have

dobby and jacquard on the same loom. The ground is usually woven using the dobby, while some labels

or writings are inserted using jacquard in a certain portion of the fabric. This raises the complexity of

warp preparation to a higher level,  since we need to distinguish  jacquard threads from the dobby

threads. The jacquard threads should not be drafted into shafts. We are using a special notation for this

purpose—positive and negative denting values. Positive denting values indicate the dobby part of the
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pattern, while negative denting values indicate jacquard part of the pattern. This  distinction has no

influence on the fabric look in the main window and is used only in output to drawing-in machines. The

negative denting values are interpreted as skip shaft but insert reed and drop wires as normal. Empty

dents are also properly supported as: skip reed, no skip on shafts, no drop wires. The repeat blocks in

writing the VEGA format are supported, so files are not too long.

18.19 NETWORK DATA TRANSFER

ArahWeave supports direct transfer to the jacquard controller via FTP protocol. In these instructions,

we assume a basic knowledge of TCP/IP and networking administration. To make it work, you must

have your jacquard controllers connected to the same network as the  ArahWeave’s computer. Each

controller  must have a unique IP address  and you must know it.  Before setting the ftp transfer in

ArahWeave, you should check if it works manually. In these instructions, we will use 129.0.0.19 as the

IP address of the Jacquard controller, you should use the actual address of your jacquard controller.

Open a terminal window and type:

ping 129.0.0.19
and CTRL+C to stop. If it transmits packets without errors, it means that you are correctly connected to

the loom via TCP/IP. Now we want to check if we can talk to the FTP server on the controller. Type:

ftp 129.0.0.19
You will be prompted for a user name, enter “anon” and press the Enter key for the password. This will

work  on  JC5  controllers  (JC4  controller  does  not  support  the  ping  command,  you  should  try

connection with the ftp command), but you may need to use specific usernames and passwords for

other jacquard controllers. Please refer to the documentation of your jacquard controller regarding the

usernames  and  passwords  of  the  FTP  server.  While  you  are  connected  to  the  ftp  server  via  ftp

command, you should try to send a file. We will set the binary transfer, send the file test.jc5 and

logout.

bin
put test.jc5
bye
If this all worked without errors, we can integrate FTP into ArahWeave. You need to set up the loom

network configuration file (.looms file) in the default directory of your loom configurations.  To open it

in  ArahWeave,  choose  Help >  Save  setup,  click  on  the  Expert tab,  and  click  the  Loom  network

configuration button. 

Figure 417: Starting Loom network configuration editor
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If you start the editor for the first time and there is no .looms file, the editor is opened with blank data.

First set the number of looms (rows) that you have in the network.

Figure 418: The loom network configuration editor

 

To enter data in the cell,  click on it, and type in the data. If there is something already in, it will be

overwritten. To edit data, which is already in, click on cell, and press F2 on the keyboard.

You must enter the loom (or location) name which will be visible to the user of the program (so users

do not need to remember IP addresses). Then you must also enter the IP address (or a ftp server name

or a  path of  a  directory),  then username, password,  path (if  you want the files  to be placed in  a

different path from the default directory into which ftp users log in), jacquard format, and the number

of hooks of particular loom. If you do not know the number of hooks, or if it does not matter, just enter

0, the Hooks field cannot be empty. If any of the other parameters is not necessary, just leave it blank.

Note that jacquard format must be written in the same way as it appears in the menu, but instead of

the correct “Stäubli  JC5” (with umlaut),  you can enter “Staubli  JC5”. You can have up to 300 looms

configured in this way. Once you have finished with editing, click the Save setup button. Program will

create the .looms file, where all these settings are saved. ArahWeave requires a restart before you can

use newly created or changed the .looms file.

Figure 419: Loom network configuration editor with data

 

18.19.1 SENDING FILE TO THE LOOM

There are two ways of sending file to the loom:

• First way: sending a file from the Save cards for production window:

Choose  Send (Figure  420)  as  the  file  destination  in  the  Save  cards  for

production  window,  and  click  OK. After  the  system  has  created a  file  and

written it to /tmp directory, it opens the Send file to production dialog.

The displayed list of looms is created dynamically, based on two criteria: number of hooks and file

format to prevent sending a file to the wrong loom. For instance, if you create 2688 hooks file in

Staubli JC4 format, the list will display only looms, which have 2688 hooks and have  a  JC4 loom

Figure 420: Selecting
a file destination
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controller. To send a file, click on the looms to which you want to

send the file, and click the OK button. Figure 421 shows an example,

where the Jacquard file will  be sent to three selected looms.  You

will be informed of the success or failure of each file transfer.

• Second way: sending a file directly from the Send file to the production window:

Choose Weave > Send file to production from the main window. The Send file to production window

displays  all  looms,  which you have in  the  .looms configuration file.  Click  Browse to choose the

Jacquard card, which you will send to the selected loom. With OK you confirm sending the file.

18.20 EXTRACTING DATA FROM CARD USING LOOM LAYOUT

This is the opposite operation of Save cards for production. Use it, when you have only the card file, but

not  the fabric  or  weave file,  and  you  need  to  create  a  simulation  or  save  the weave in  different

Jacquard format.

Load the card into the weave editor. Load a corresponding loom layout into Save cards for production

window.  Then choose  Change >  Extract  data  using  loom layout  from the  Save  cards  for  production

window. If the settings are correct, you get the jacquard weave and the regulator pattern in the weave

editor and the weft pattern in the Edit warp and weft pattern window.

18.20.1 GETTING SELVEDGE WEAVE FROM CARD FILE

If you want to get selvedges from the card file into Save cards for production window using the Extract

data using loom layout function, these two option must be set as described below:

• The  Elongate selvedge on regulator option should be set to zero

(0).

• The Save/load selvedge weave in fabric in the Weaving part of

the Save setup should  be on  (the number 1 in  the text field

means selvedge 1 in the Save cards for production window).

18.21 CONVERTING THE JACQUARD CARD FROM ONE LOOM LAYOUT INTO ANOTHER

Nowadays,  most  mills  buy  jacquard  machines  in  an  incremental  manner.  They  do  not  buy  100

jacquards of equal brand, model and size, but start with a small number and add new ones as their

needs are growing. Often, this also means that they choose a different brand or model, or that the new

jacquard will have a different loom layout, for some technical reason. ArahWeave has a simple system

for  converting  a  file  ready  for  weaving  from  one  jacquard  format  and  layout  to  a  different  one.

Obviously, this only works for jacquard machines with  an equal number of design hooks. You cannot

simply convert a 2400 hook design into a 1200 hook design. But you can easily convert a Grosse 1200

hook card file into a Stäubli JC5 card file. The selvedges, hook positions and weft change or regulator

can be different between the two files.

This  operation is  mainly intended for repetitive operations,  when you are often converting designs

from one particular layout to a different layout. First, you need to understand and save loom layouts of

both (all)   jacquard  looms  you want to convert among. Then use command Weave  >  Load jacquard

Figure 421: Send file to
production
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cards, if your jacquard file is already on the hard disk. As a second step, choose Weave > Save cards for

production, and load the loom layout, which corresponds to that file. Once the correct layout has been

loaded, apply function  Change >  Extract data using loom layout. This will use the information in your

current loom layout to throw away the empty space on the hooks, retaining just the weave. It will also

extract weft change and regulator, if present. If you would now save the design, it would be saved in

the same way as you already have it. So you need to go in File > Load loom layout and load the layout of

the jacquard to which you want to save the design. You can save it as it is,  or modify weft change,

selvages, or whatever is necessary.

The main advantage of this approach is that you can do it even for old designs, which were developed

by external design studios, or other design systems. If the design was developed in ArahWeave, there is

no reason to work in this manner, since you can simply load the fabric and the loom layout you want to

use, and save the jacquard card design once again, for each jacquard layout.

19 DATABASE CONNECTIVITY BY XML

19.1 INTRODUCTION

ArahWeave  enables  you  to  integrate  its  design  data  with  the company’s  production  management

system (ERP-Enterprise Resource Planning). 

Arahne has developed several tools to import and export data to and from ArahWeave. It may look

complicated, but don't be scared. It is possible to make this kind of connection, and you will not be the

first one to implement it.

19.2 DATA IMPORT

All  the import  and export  data formats  are based on XML.  XML is  a  simple  standard which allows

vendors to describe the format of data exchange files. We are using a very basic version of XML - one

XML file, and one DTD file which describes the valid structure of the XML file. You can use the DTD file

to verify your imported or exported files. The DTD file is not actually used in import or export; it just

defines the structure of the XML file, so you know which fields are obligatory and which are optional. If

you place the DTD file in the same location as the corresponding XML file, then some browsers will be

able to verify the correctness of the XML file structure, and display a tree structure of the XML file.

Figure 422: XML file in a text editor

 

Even  before  describing  the  data  formats,  we  must  know  where  they  come from.  In  the  simplest

situation, you just copy the XML import file to the standard location (data/xml) for Arahweave’s XML

files  (or to another location defined in  .arahne configuration file). You can change the default XML

location by exporting an XML file to a different location, and then saving the setup.
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In a more complex setup, you can use the FTP protocol to get the import file from a different computer.

The FTP specification and the actual import/export is executed in Help > Save setup, the Data export 

tab. To use the FTP, fill in the box labeled Send XML data by FTP. You must specify the IP address (as 

numbers or as domain name), the username, the password, and whether to use the passive mode FTP.

The FTP location is the same for export and for import. To use FTP in XML import, you must enable FTP

in the  Import data box, and optionally, you can specify a directory for XML import files. This can be

useful,  so  the export  and import  files  are not mixed in  the same directory.  Another option during

import is to delete old files. Use with caution! It is most useful during the testing phase of import, since

the  program  will  automatically  delete  all  the  previously  imported  files.  Once  the  system  will  run

normally, you should not need to use this kind of destructive import, since all the data should have a

clear creation path and be inserted only once, without fear of duplication.

Figure 423: Data export in Save setup

 

Now  let’s  start  with  the  specification  of  the  actual  import  files.  If  you  have  any  experience  with

databases, you will wonder what is a unique key in our definitions. All the entries containing a word

Code should be unique. 

19.2.1 WARP PATTERNS

They are specified by the following simple DTD file named ArahneWarpPatternImport.dtd
<?xml version="1.0" encoding="UTF-8"?>

<!ELEMENT ArahneWarpPatternImport (Pattern*)>

<!ELEMENT Pattern (Code, Value)>

 <!ELEMENT Code (#PCDATA)>

 <!ELEMENT Value (#PCDATA)>

The XML file for warp import must have the name ArahneWarpPatternImport.xml and this is a

small example of such a file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE ArahneWarpPatternImport SYSTEM "ArahneWarpPatternImport.dtd">

<ArahneWarpPatternImport>

<Pattern>

<Code>00001</Code><Value>2a 1b</Value>

</Pattern>

<Pattern>
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<Code>00002</Code><Value>1a 20(1c 1d)</Value>

</Pattern>

<Pattern>

<Code>00003</Code><Value>5a 70[1d 2c2b]</Value>

</Pattern>

</ArahneWarpPatternImport>
The value of Code is equal to the code of your warp pattern in the database. Avoid using "/ " or "\" in

the codes, since the code is then used as a filename to store the warp pattern. The value of the warp

pattern is any regular warp pattern which you can write in ArahWeave. Capital and lowercase letters are

not important, you can use spaces or not, you can have several levels of parenthesis.  If you use the

parenthesis, use only () or [], not both within the same pattern. Allowed yarn letters go from A-Y, and

the  longest  permitted  warp  pattern  has  65520  threads.  As  each  pattern  is  imported,  it  is  also

interpreted and checked for correctness. At the end of import, the program notifies you of the number

of correctly imported files and the number of failed ones, if any. In the testing phase, when you want to

see on which pattern is the import failing, you can run the program from the console by typing

aw/aweave
and the patterns which fail to import will be written to the text console.

You can start the warp pattern import by pressing on the Warp pattern button in the Import data box of

the Save setup window, Data export tab. During import, the current fabric is redrawn as each pattern is

interpreted.  This  is  normal,  and serves  you as  a feedback of  the program's  activity.  Once they are

imported, you can browse them in a graphical way, as described in section 7.3.

19.2.2 WEFT PATTERNS

They are handled in exactly the same way as warp patterns, and everything written above still holds.

Only the filenames of the DTD and XML files are slightly different.

This is the file ArahneWeftPatternImport.dtd
<?xml version="1.0" encoding="UTF-8"?>

<!ELEMENT ArahneWeftPatternImport (Pattern*)>

<!ELEMENT Pattern (Code, Value)>

<!ELEMENT Code (#PCDATA)>

<!ELEMENT Value (#PCDATA)>

And this is the corresponding XML file ArahneWeftPatternImport.xml 

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE ArahneWeftPatternImport SYSTEM "ArahneWeftPatternImport.dtd">

<ArahneWeftPatternImport>

<Pattern>

<Code>00001</Code>

<Value>2a 1b</Value>

</Pattern>

<Pattern>

<Code>00002</Code>

<Value>1a 20(1c 1d)</Value>

</Pattern>

<Pattern>

<Code>00003</Code>

<Value>5a 70[1d 2c2b]</Value>

</Pattern>

</ArahneWeftPatternImport>



 w w w.ar ahne .s i  ArahW eave   
U se r  Guid e   

  23 7

19.2.3 YARN COLOR NAMES

In databases, everything needs to be coded. So every color name needs to have a code. This import file 

allows you to specify color names. First, here is the DTD file ArahneYarnColorImport.dtd
<?xml version="1.0" encoding="UTF-8"?>

<!ELEMENT ArahneYarnColorImport (YarnColor*)>

<!ELEMENT YarnColor (YCode?, YColorCode, YColorName, YNumValues?, Value?)>

<!ELEMENT YCode (#PCDATA)>

<!ELEMENT YColorCode (#PCDATA)>

<!ELEMENT YColorName (#PCDATA)>

<!ELEMENT YNumValues (#PCDATA)>

<!ELEMENT Value (CIE_Lab, RGB, Percent?)>

<!ELEMENT CIE_Lab (#PCDATA)>

<!ELEMENT RGB (#PCDATA)>

<!ELEMENT Percent (#PCDATA)>

And now a small sample XML file ArahneYarnColorImport.xml
<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE ArahneYarnColorImport SYSTEM "ArahneYarnColorImport.dtd">

<ArahneYarnColorImport>

<YarnColor>

<YColorCode>332323</YColorCode>

<YColorName>Rossignol</YColorName>

<YNumValues>1<YNumValues>

<Value><CIE_Lab>75.23 65.23 15.23</CIE_Lab><RGB>255 10 12</RGB></Value>

</YarnColor>

<YarnColor>

<YColorCode>333523</YColorCode>

<YcolorName>Girasole</YcolorName>

<YNumValues>1<YNumValues>

<Value><CIE_L>85.23 12.03 75.23</CIE_Lab><RGB>2550210 17</RGB></Value>

</YarnColor>

<YarnColor>

<YColorCode>234523</YColorCode>

<YColorName>Printed 5 colors</YcolorName>

</YarnColor>

<YarnColor>

<YColorCode>434543</YColorCode>

<YColorName>melange 50</YColorName>

<YNumValues>2<YNumValues>

<Value><CIE_Lab>83.23 1.03 -1.23</CIE_Lab><RGB>0 0 0</RGB><Percent>50</Percent></Value>

<Value><CIE_Lab>23.23 -1.03 -4.23</CIE_Lab><RGB>0 0 0</RGB><Percent>50</Percent></Value>

</YarnColor>

</ArahneYarnColorImport>
As you can see, this XML file allows you to specify a name for every yarn code, and also the optional CIE

Lab values of the colors. Most ERP systems do not contain actual yarn colors specified in a colorimetric

way, so they omit the Lab values. But if you had all the colors measured by photo spectrometer, and
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inserted in this XML file, you could load them in. Some yarn colors can be multicolor, for example in

mélange.

Although the  ArahneYarnColorImport.xml file can be imported on request, it  is  actually  read

every time you run the program, if it is stored at the standard XML location. The importing of this file

does not generate new color files in Arahweave’s data files. It only helps the program to display correct

yarn color names during yarn browsing.

19.2.4 YARNS

The database view of  the yarn  is  somewhat different from the CAD view of  the yarn.  ArahWeave

worries about the right color, shape, luster, hairiness, diameter, everything to make a nice fabric image.

Database,  on the other  hand,  only  cares  about  numbers  and codes.  There is  some intersection of

interests, and this is what we try to import from the database to ArahWeave.

The ArahneYarnImport.dtd is shown below:

<?xml version="1.0" encoding="UTF-8"?>

<!ENTITY % cUnit "count Unit (Tex|Nm|NeC|NeW|Np|Ny|NeL|NeS|Td|Run|dtex) #REQUIRED">

<!ENTITY % lUnit "lengthUnit (mm|cm|m|in|ft|yd) #REQUIRED">

<!ELEMENT ArahneYarnImport (YarnImport*)>

<!ELEMENT  Yarn  (YCode,  YName,  YCount,  Ply,  Twists,  TwistContraction,  Model?,  DimensionFactor?,

HairLength?, HairProbability?, Fibre*)>

<!ELEMENT YCode (#PCDATA)>

<!ELEMENT YName (#PCDATA)>

<!ELEMENT YCount (#PCDATA)>

<!ATTLIST YCount  %cUnit; >

<!ELEMENT Ply (#PCDATA)>

<!ELEMENT Twists (#PCDATA)>

<!ATTLIST Twists %lUnit; >

<!ELEMENT TwistContraction (#PCDATA)>

<!ELEMENT Model (#PCDATA)>

<!ELEMENT DimensionFactor (#PCDATA)>

<!ELEMENT HairLength (#PCDATA)>

<!ELEMENT HairProbability (#PCDATA)>

<!ELEMENT Fibre (#PCDATA)>

<!ATTLIST Fibre percentage CDATA #REQUIRED >
A sample of ArahneYarnImport.xml

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE ArahneYarnImport SYSTEM "ArahneYarnImport.dtd">

<ArahneYarnImport>

<Yarn>

<YCode>202245</YCode><YName>Lana 40</YName>

<YCount countUnit="Nm">40</YCount>

<Ply>2</Ply>

<Twists lengthUnit="m">600</Twists><TwistContraction>0</TwistContraction>

<Fibre percentage="100">WO</Fibre>

</Yarn>

<Yarn>

<YCode>202234</YCode>

<YName>Lana 48</YName>
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<YCount countUnit="Nm">48</YCount>

<Ply>2</Ply><Twists lengthUnit="m">700</Twists><TwistContraction>2</TwistContraction>

<Fibre percentage="100">MD</Fibre>

</Yarn>

<Yarn>

<YCode>302231</YCode>

<YName>Misto 12</YName>

<YCount countUnit="Tex">12</YCount>

<Ply>1</Ply><Twists lengthUnit="m">400</Twists><TwistContraction>0</TwistContraction>

<Fibre percentage="60">CO</Fibre><Fibre percentage="30">MD</Fibre>

<Fibre percentage="10">PL</Fibre>

</Yarn>

</ArahneYarnImport>
Yarn code and yarn name fields need no explanation. Some customers use "/" in the yarn codes, and

program allows that, using some tricks. When it is saving the imported yarn in yarn directory, it flips

the "/" character into "\", since filenames in Unix cannot contain "/". When it loads such yarn, it flips

the yarn code back to the original. So your yarn codes will be correct in all the cases.

Yarn count is entered with the unit of the count. You can use any unit supported by ArahWeave.

Number of plies is also obvious, and the number of twists are again entered with its own length unit.

Twist contraction tells us by how much does the yarn count shrink due to twisting. Just leave it at zero,

if you do not need it.

And finally you can enter up to 6 fiber components, each with its own relative percentage. The fiber

codes must be composed of two letters. It is better if they are written according to the standard which

is  used in  ArahWeave. Once you load the yarn with fiber composition, the program will  be able to

calculate the fiber composition of final fabric 

Note that yarn is colorless – the same yarn can exist in many different colors. Also, we do not expect to

import any of the yarn visual properties, since ERP systems do not store this kind of information.

19.2.5 YARN TO COLOR ASSOCIATION WITH PRICES AND AVAILABILITY

Finally we have all the components to specify which yarns do we actually have. We need to associate

the yarn code to yarn color code, and tell how many kilos of yarn do we have, and how much does it

cost. The DTD file to specify the format is ArahneYarnToColor.dtd
<?xml version="1.0" encoding="UTF-8"?>

<!ELEMENT ArahneYarnToColor (Yarn*)>

<!ELEMENT Yarn (YCode, YColorCode, YStockKG, YPriceKG, Season*)>

<!ELEMENT YCode (#PCDATA)>

<!ELEMENT YColorCode (#PCDATA)>

<!ELEMENT YStockKG (#PCDATA)>

<!ELEMENT YPriceKG (#PCDATA)>

<!ELEMENT Season (#PCDATA)>
And this is an example of a valid XML file ArahneYarnToColor.xml

<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>

<!DOCTYPE ArahneYarnToColor SYSTEM "ArahneYarnToColor.dtd">

<ArahneYarnToColor>

<Yarn>

<Ycode>Chenille</Ycode>

<YColorCode>0014</YColorCode>

<YStockKG>360</YStockKG>
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<YPriceKG>6</YPriceKG>

</Yarn>

<Yarn>

<Ycode>Chenille</Ycode>

<YColorCode>0016</YColorCode>

<YStockKG>360</YStockKG><YPriceKG>6</YPriceKG>

</Yarn>

<Yarn>

<Ycode>Chenille</Ycode>

<YColorCode>0021</YColorCode>

<YStockKG>360</YStockKG>

<YPriceKG>6</YPriceKG>

</Yarn>

<Yarn>

<Ycode>Boucle</Ycode>

<YColorCode>V009</YColorCode>

<YStockKG>34</YStockKG>

<YPriceKG>15</YPriceKG>

</Yarn>

<Yarn>

<Ycode>Boucle</Ycode>

<YColorCode>V007</YColorCode>

<YStockKG>52</YStockKG>

<YPriceKG>15</YPriceKG>

</Yarn>

</ArahneYarnToColor>
The elements of this XML file are obvious: yarn code, yarn color code, yarn stock quantity in kilos, and

yarn price in whatever currency you like to use. Season is an optional yarn property. A normal weaving

mill  will  try to reduce the number or yarns in contemporary use, to minimize fragmentation of yarn

stock. So for only a smaller set of yarns will be used in a particular season. A yarn in certain color can

have up to six seasons. In the yarn browser, this allows us to show only yarns of a particular season,

instead of all the yarns, which were ever used in the mill’s history.

19.3 EXPORT OF DATA – USER’S VIEW

Why is export of data difficult? Because artists do not understand accountants.

In  ArahWeave, we try to give the designer total freedom. Want to change the weave? Click, and you

have a new fabric. Want this stripe to be larger? Click on the yarn, draw into the fabric, done. Want a

darker red on that yarn? Click, drag, done.

In ERP systems, it doesn’t work like that. Everything needs to be coded and tagged, you need to have

your building blocks ready, and then you assemble your skyscraper. If you need to change the yarn

color in fabric into darker red, you first need to create that color, give it a code, apply that code to the

yarn, then if you change the width of the stripe, this makes a new warp pattern, so it needs to be saved

with a new code,  and in  turn this  needs  to  be associated with  the new warp,  which  needs  to be

associated with a new fabric, and only then you can move on to weaving this piece.

Not that one is better than another – they just serve two different purposes: creativity and production.

How do we marry the two approaches? By allowing the freedom to the artist, and when the sale of the

masterpiece is confirmed, we pass it to the accounting department. That means, that after the fabric

simulations  were confirmed by  the buyer,  we need to  fill  in  the codes,  so  that  the fabric  can be
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exported. Fabrics without proper codes are useless in the ERP, so  ArahWeave must ensure that you

have all the codes, prior to exporting.

That means that before exporting a fabric, you will need to load a fabric and fill in some details which

you did not care about in the creative phase. First, choose Fabric >  Information, and fill in the Name,

Quality,  Design and Version. Second, all the yarns must have associated the yarn code and color code.

The easiest way to do it is to use the yarn browser in the Yarns window. Using the yarn browser, you

can simply click yarn by yarn, and fill in all the yarn technical data. By default, toggle button Load only

codes will be enabled. This means that the program will only load the values relevant to XML export,

without the actual yarn color or yarn image, and other yarn simulation parameters.

If  you have set  all  the values,  you can proceed to  File >  Save  technical  data  as  XML.  Program will

automatically set the XML filename equal to the name of your fabric, and it will add the .xml at the end.

If  the  FTP sending  is  configured,  then  the fabric’s  XML  file  will  be  sent  to  the  specified  location.

Otherwise the XML file will just be saved to the XML directory.

In the Data export section of save setup, we have some other options we did not mention earlier.

If you enable Save codes with XML, then the program will also save the warp and weft patterns before

exporting XML. It will do it in a smart way: first it will check if an equal warp or weft pattern already

exists. If it does, then it will apply its code to the fabric. If not, then the warp or weft pattern will be

saved with a new name. We have another option, which controls how the new name is generated. If

the Use first free code option is active, then the program will find “holes” in your coding and use the

first free code. If not, then it will increment the last code if found, leaving the empty areas of codes.

The checking of existing warp and weft patterns is smart, since it does not compare the way the pattern

is written, but its meaning. So  the program will know that 1a 1b 1a 1b 1c is the same as  2(1a
1b) 1c, and it will use the same warp or weft pattern code.

Finally, it is very useful to enable the Check fabric codes with XML option , since then the program will

verify if all the required fields have been filled in. If not, it will warn you about it and inform you exactly

what is missing on which yarn.

Maybe you will be surprised that we do not deal a lot with coding weaves in the export. Our view is that

the ERP system does not need to know too much about them. Weaves are big, so they cannot be stored

in ERP. In the past, some companies spent a lot of time coding the dobby cards and reusing them. Now,

this is all nonsense. Any decent mill will have electronic transfer of dobby and jacquard cards. So there

is no time saving by trying to reuse the old ones, making all the codes and stuff. The weave should be

born and die with the fabric article. The ERP system only needs to know enough to understand which

warps are compatible. The actual weave is irrelevant to ERP, as this is handled by the ArahWeave CAD.

19.4 EXPORT OF DATA – EXPERT’S VIEW

In order to import the XML fabric, you will need to write a program which will read the Arahne fabric

XML file and fill  in  the appropriate tables in your database. There will  be many fields you probably

won’t need, so you can skip them. And there will be other fields, which it will not contain, for example

custom code. Here, you need to work with the weaving mill and fill in the missing fields with proper

defaults.  Alternatively,  you can implement a second phase of import, where the operator will  fill  in

some fields in a manual way. Even with manual checking of some fields, the time savings achieved by

automatic transfer  will  be  very  big.  Anyone who spent  her  or  his  life  retyping  warp patterns,  will

confirm this.

The current versions of ArahneFabric XML and DTD file is available for download from Arahne's web

site:

https://www.arahne.si/xml/ArahneFabric.dtd

https://www.arahne.si/xml/SampleFabric.xml

We will not repeat the actual XML files here, to save the rainforest.

http://www.arahne.si/xml/SampleFabric.xml
http://www.arahne.si/xml/SampleFabric.xml
http://www.arahne.si/xml/SampleFabric.xml
http://www.arahne.si/xml/ArahneFabric.dtd
http://www.arahne.si/xml/ArahneFabric.dtd
http://www.arahne.si/xml/ArahneFabric.dtd
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All the entry fields have logical names, so you can understand what they mean. Try to use ArahWeave

and export a couple of XML files, and you will see how they look. If you have a valid support contract,

we will also gladly help you in the implementation and explain all the details.

19.5 CASE STUDY: PROTEX - COMPUTER HOUSE DI PRATO

The implementation of the connectivity is sometimes done by weaving mill internal IT staff. But more

often it is done by an external company, which supports the weaving mill ERP system. In Italy, we have

done this with our partner Computer House di Prato (CHP), with which we share many customers.

CHP's ERP is called Protex, and it is using a database running on Oracle in Linux or Unix, with a Windows

graphical interface on new versions, or text based terminal interface on older versions. Programmers of

CHP have written two modules for Protex, one called PROCAD, which periodically writes the import files

for ArahWeave, with all the yarns, names and yarn availability. ArahWeave then reads this data by FTP,

when the user requests data import or yarn availability. 

The other program is called CAD-LINK and it is periodically checking if ArahWeave has sent it any fabric

XML  file  by  FTP.  If  it  finds  any  files,  it  imports  them and deletes  them.  If  there  are errors  in  the

imported XML fabric file, it sends an e-mail to the Protex administrator, so failed imports get noticed.

Figure 424: PROCAD and CAD-LINK
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20 SAVING SETUP (PREFERENCES)

20.1 SETTING DEFAULT FABRIC

When you open  ArahWeave,  it displays the default fabric. If

you want to change it, load a fabric that you want to be the

default one, and choose  Help >  Set current fabric  as default

from the main menu bar. 

Figure 425: Setting current fabric as
default

20.2 CHANGING DEFAULT LOCATION FOR OPENING AND SAVING FILES

To change the default  file  or  directory,

where the files  are saved,  you  have to

load  the  desired  file  from  a  specific

location  into  ArahWeave (fabric  file  in

the main ArahWeave window, weave file

in the Weave editor, yarn file in the Edit yarns window, image file in the Jacquard conversion window,

loom layout file in the  Save cards from production window, etc...).  Then choose  Help >  Save setup.

Check the Set default directories button, and click the OK button in the Save setup window.

There  is  also  an  option  to  save  the  position  of

default  opening  location  for  particular  directory

directly from the menu:

• Fabrics: Help > Set current fabric as default.

• Colors: Help > Set current color atlas as default.

• Loom  layouts:  Help >  Set  current  layout  as

default.

• Yarns, Weaves, Images, Cards, HTML, XML: Help

>  Set current directory as default,  and select a

type  of  files,  for  which  you  want  to  keep  a

current opening location.

Figure 427: Setting current directory as default  

20.3 WEAVING SECTION

The  Save  setup dialog  has  a  special  weaving  part  for  all  weaving  related settings.  To access  them,

choose Help > Save setup, and click the Weaving tab.

Figure 426: Setting the default directories
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Figure 428: Save setup - weaving
 

• You can change the option button from Reed width -> Dents to Dents -> Reed width to use Number

of dents in fabric width instead of Threads in fabric width in the Consumption window.

• With the  Fabric length -> Warp length option button you choose either the  Fabric length or  Warp

length is your input in the Consumption window.

• Report yarn consumption as length—if it is on, then the consumption is calculated in length of yarn

instead of weight of yarn

• The default Reed unit is 1 centimeter, but you can change to whatever your reed unit might be.

• Save/load selvedges in weave—if it is on, then the selvedge, which is currently loaded in the Save

cards  from  production window,  is  saved  with  a  weave.  When  you  load  such  a  weave,  then  it

overwrites the selvedge which is currently loaded in the Save cards from production window.

• Save/load selvedge weave in fabric—if it is  set to 0, then the selvedge weave is  not saved in the

fabric. If it is set to one of the three possible numbers 1,2, or 3 (Selvedge or Selvedge 2 or Selvedge

3  respectively), then the selvedge,  which  is  currently  loaded in  the  Save  cards  from  production

window, is saved with a fabric. When you load such a fabric, then it overwrites the selvedge which is

currently loaded in the Save cards from production window.

• Use final yarn count—if it is on, then the program takes the yarn count number for calculating the

simulation (diameter of the yarn) or yarn consumption as the absolute yarn count regardless if it is

single yarn or multiply yarn. The display of yarn count is also different, if you use final yarn count.

• Mirror numeric drafting—choose either the first shaft is the nearest or the farthest to the weaver.

• Print dobby rectangle in light red—default color for dobby rectangle is red—but if you photocopy

(black&white) the print, then you can’t distinguish between rectangle and weave. Solution? Print it

in light red.

• Black grid gray points—if  it is on, the program prints warp points in gray color and weave grid in

black color, which is just opposite to the defaults.

• Report weft density per yarn—in some textile areas in Italy they use density per yarn color to help

them to calculate the consumption, so we included this as an option in ArahWeave.

• Sort Jacquard image colors by popularity—does just as it sounds; it sorts colors of the image in the

Jacquard conversion window by colors popularity. If the option is off, then ArahWeave sorts colors

like they are written (saved) in the image file.

• Always fix floats on saving jacquard cards—if you have set the float limits (see chapter 5.10) in the

fabric, and the option is on, then ArahWeave automatically checks and corrects long float errors.
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• Reload jacquard weaves only to equal colors—if you load a different image, weaves will be retained

only if  colors are exactly the same, and  the  program will  not try to map the weave to the most

similar color.

• Capital letters in CAM suffix—some users still  have a lot of loom files written in old DOS systems,

which don’t distinguish between capital and lowercase letters—thus this option allows you to save

CAM files in the same way.

• Warning  on card  overwrite—if  the option is  on,  then ArahWeave warns  you,  when you use  the

already existing file name for CAM file.

• Save unused warp/weft in fabric—by default, ArahWeave saves only yarns, which are used in fabric,

in the fabric file. Next time, when you load that file, only saved (used) yarns are loaded, the other

yarns in the Edit warp and weft pattern dialog (25 yarns for each) are default yarns. But if you enable

the  Save unused warp/weft  in fabric option,  then all  current yarns  from the  Edit  warp and weft

pattern dialog are saved in the fabric file, and thus loaded when you open the fabric file next time.

Then there is the Properties section. You can control which text fields and options are present in the

Properties window (Fabric > Properties).

• Division

• Fabrics

• Name

• Derived from

• Cut

• Stock

The Warning on saving wrong section consists of two options:

• Threads  in  fabric  width—if  the  number  of  threads  is  not  “compatible”  with  denting  and  reed

number, ArahWeave warns you before saving a fabric.

• Weave—if the weave of the fabric, which you want to save, has unfinished (or no existing) drafting

into shafts, ArahWeave warns you before saving a fabric.

20.3.1 GENERATING FILENAME, FABRIC SIMULATION TITLE OR HTML FABRIC NAME FORMAT

The  Generate  filename section  of  Save  setup  enables  you  to  declare,  which  data  from  the  fabric

properties (Fabric > Properties) is used for generating:

• Fabric filename

• Fabric name in HTML technical data file (this is also used as a Fabric name on printout)

• Fabric name on multi-fabric printout

The format of fabric name formula has only one rule: the number of field which will  be used in the

fabric name, should stand after the dollar sign ($), which is there to indicate that the used number is

the field number and not character which would be part of the text. After the field number you can

enter whatever character you want, like space, slash,  hyphen, and it  will  be used in  the generated

filename.

The text fields in the Properties dialog have following numbering labels:

Field Label

Division $8, $9  *

Name $1

Quality $2

Design $3

Version $4

Season $5, $6  *

Designer $7

Notes $N



24 6    C hap t er  2 0   
 Savi ng Se t up  (P re fer en ce s)

www.arahne.si  

* $8 only takes first word (anything till first space character) from the division code (or name), while $9

takes the whole name. Same applies to Season: $5 takes only first word and $6 takes the whole code.

Beside Properties, four additional signs were introduced for automatic title generation:

Fabric filename $0

Jacquard image filename without suffix $I **

Scissors $@ ***

Directory name $D

** It is the capital letter I.

*** Scissors sign may be used only on multi fabric print.

Let’s see an example: if you have written  $1 - $2 $3-$4 as a rule in the  Automatic fabric name

format field fabric name format, and have entered following text in the Properties window: Pale Blue as

a Name (Field 1), B as a Quality (Field 2), 14 as a Design (Field 3), and 08 as a Version (Field 4), then the

generated name would be: Pale Blue - B 14-06. To generate  a  filename, click   icon in the Save

fabric dialog.

Figure 429: The fabric properties, which can be used in automatic generated fabric name, the fabric name
rules, and generated file name

20.4 PERSONALIZING ARAHWEAVE

The  Appearance  section  of  the  Save  setup window  contains  most  of  the  program’s look-and-feel

settings.

Figure 430: The Appearance section of  the Save setup dialog  
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20.4.1 SETTING USER INTERFACE FONT

You can choose your preferred font style for user interface from the

drop-down menu. The font menu shows only font styles, which are

available for the currently selected language. If you are using Latin

script,  then  the  default  font  (Sans)  is  normally  a  good  choice.

Choose Garuda or Tahoma for Thai language, you can use FZKaiTi or

similar  font  for  Chinese;  Chinese  language  package  should  be

installed in Linux.

ArahWeave uses two font sizes: Normal (most of the program text) and Small (filenames in the browse

window, color names). You can adjust the size by changing the number of points in an adequate field. 

The Calculation of thread consumption window, the Price calculation window, and the Yarn windows

use a web browser engine to display HTML code in tables in their windows. To set the font size in these

tables, edit the font size numbers in the  Size list HTML (points,...) field. The  Bold HTML titles button

serves to disable the default bold titles in the HTML code, because sometimes (especially when you use

Chinese language) characters in bold style are difficult to read.

20.4.2 SETTING THE FONT FOR PRINTING

You set the print font in the same way as font for screen (user interface).

20.4.3 USER INTERFACE COLORS

Click the Colors tab in the Save setup window to set the user interface colors.

You can change following user interface colors:

• Background color of the program

• Mouse pointer color

• Background color  of the  Weave editor (on some LCD monitors the default

color  is  too  light,  so  it  is  difficult  to  distinguish  the background from the

editing area)

• First level grid color in the Weave editor (Grid 1)

• Second level grid color in the Weave editor (Grid 2)

To change color, click the Edit button. Use the Color editor to specify or define

a color for the selected portion of the user interface. Color field displays the

spectrum of available colors. The cross hairs indicate the current color. Click

anywhere or drag in the color field to select a color.  Enter a value for the

luminosity, or drag the pointer on the slider to set the luminosity. You can also use the eyedropper tool

( ) to select any color from your screen. You confirm the changes by clicking the OK button.

Figure 432: Colors
section of the Save setup

Figure 431: Choosing font
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Figure 433: Color editor used to select user
interface colors

 

20.4.4 MISCELLANEOUS SETTINGS

20.4.4.1 OPEN WITH BROWSE

If you select it, then ArahWeave opens a fabric browser automatically at startup.

20.4.4.2 HIDE SAVE MENU

Some customers work really fast, and sometimes hit  Save instead Save as. And there is no way back,

when a file is overwritten. But, if you enable Hide save menu, then this will never happen to you again.

20.4.4.3 HIDE LOAD MENU, USE BROWSE

As the option name indicates, the Load file menu opens the graphical Browse window and not the text

based Load file dialog.

20.4.4.4 MOUSE WHEEL DOWN – ZOOM IN

You can change the default direction of the mouse wheel zooming.

20.4.4.5 OPEN NEW FABRIC IN DEFAULT VIEW

When you load a new fabric, it will use the default view setting, regardless of current view.

20.4.4.6 HTML LOGO SIZE %
It is quite difficult to predict the size of the logo in the HTML printout. So you can adjust HTML logo size

% to your liking.

The logo  file  is  the  same as  it  is  used on printout  – it  is  stored in  /home/capdam/data/html
directory and the filename should be logo.gif but it can be in any graphics format.

20.4.4.7 REGISTERED DESIGN TEXT

The text, which you have in the  Registered design text field, will  be printed (or saved) in the fabric

simulation printout (if you enable it in the Print fabric to printer dialog).

20.4.4.8 CUSTOM PRINT TEXT

The  text,  which  you  have  in  the  Custom  print  text field,  will  be  printed  (or  saved)  in  the  fabric

simulation printout (if you enable it in the Print fabric to printer dialog).
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20.4.4.9 TITLE

In the Title section, you can declare what data is used for the right-side part of the title. You can include

Owner (the Owner’s name from Save setup), User ( name of the user’s account),  Date, and the fabric

Filename.

Here you can also enter the web site address, you want to be printed in the title.

Figure 434: Registered design text, custom print text and the title in the printout
 

21 RUNNING ARAHWEAVE IN SERVER MODE FROM THE COMMAND LINE

If  you  use  ArahWeave on  your  desktop,  starting  it  from the command line  is  usually  unnecessary

(unless you need debugging information from the terminal). However, if you want ArahWeave to start

automatically from a time-dependent script, or if you want ArahWeave to start alongside other services

from a script, you can include the command that starts ArahWeave in server mode.

If  you  start  ArahWeave  from  the  command  line  the  folder,  where  it  is  installed  (usually  it  is

/home/UserName), the command is ./aw/aweave -nosplash -server. (Figure 435).

Figure 435: Starting ArahWeave in server mode from the command line

 

If you include the command in a script, use the full path to the program:

/home/UserName/aw/aweave -nosplash -server
(UserName is the actual user’s name).

When the program is  in server mode, the title bar displays,  in  addition to regular information,  the

number of processed files.

Figure 436: The number of processed files is displayed in the title bar.
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If you need a high performance ArahWeave server, we suggest you install it on a multicore computer,

and start several copies of ArahWeave servers.  You can safely start the same number of ArahWeave

servers as the number of CPU cores of your computer. ArahWeave server has been designed in a way to

allow concurrent operations of several programs.

21.1 SERVER CONFIGURATION OPTIONS IN THE SAVE SETUP

• In the Save setup (Help > Save setup; the Expert tab), you can specify the number of processed files

before ArahWeave is restarted.

Figure 437: Setting the number of processed files before restarting the server, as well as enabling
the server log files.

• You can enable writing of log files. They are written in /tmp/arahneServerLog folder. Once XML

files have been executed, log files are copies of all incoming XML files and reply XML files. This can

aid in error debugging by determining whether other programs have passed correct information in

the XML. If the server fails to execute an XML file, the reason will be provided in the reply XML. The

filename of the reply XML will be the same as the filename of the input XML, with the exception that

it will be placed in the "out" directory.
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Figure 438: Server log files

• The processing  delay  in  milliseconds  can be set  in  the  Data  export tab.  It  refers  to  the interval

between incoming XML file checks. The XML processing delay is measured in milliseconds. If your

server's jobs are small and you require a highly interactive system, you can set the delay to as little

as 100 milliseconds (0.1 second).

Figure 439: Setting the interval between two checks of the input folder.  

22 SUPPORTED FORMATS

22.1 WEAVING CAM FORMATS

You  can  write  these  formats  from  Save  cards  for  production window,  and  read  from  the  Browse

Jacquard  cards window,  or  the  Browse  weaves or  Load  weave window.  ArahWeave recognizes  file

format automatically,  and displays  file icon in  the browse window. All  CAM formats are treated as

binary, black and white images.
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Name
Read

Write

Filename

extension
Type Notes

JC3
rw .JC3 jacquard

• non-DOS formatted floppy; only one design per floppy

• multiple floppy support for large designs

• can be written as a DOS file, for sending by email

JC4

JC4B

rw .JC4 jacquard

• non-DOS formatted floppy; several designs per floppy

possible

• multiple floppy support for large designs

• can be written as a DOS file, for sending by email

JC5
rw

.JC5

.ZC5
jacquard

• optional compression (good)

• multiple floppy support for large designs

JC6
rw

.JC5

.ZC5
jacquard

• same as JC5, but with fabric simulation for the file icon

on the loom, weft yarn count and color information in

the text field

rw .EP jacquard
• optional compression (poor)

• multiple floppies

rw .WEA jacquard

• multiple floppies support (filenames on all floppies are

same; if  you send files by email  you have to rename

them, and when you copy them back to floppies, you

have to rename them back to original filename

rw .S01 jacquard

Compu-Jacq
rw .JP1 jacquard

• handloom electronic jacquard format

• includes support for display of weft colors

rw .DAT jacquard

Actrom
rw

.P

.S01
jacquard

• including support for multiple floppies

• two files for one design!

Varitex rw .PAT jacquard • for narrow weaving

Eltex
r .EJP

jacquard

import
• for narrow weaving

Arahne

weave
rw native

• textile CAD manufacturer

• compressed format

• ideal for browsing of weaves, will load fastest

• unified format for jacquard and dobby weaves

• contains shaft information

• contains weave system information

• optional separate weaves for left and right selvedges

Sophis card
rw punch • textile CAD manufacturer (reverse engineering)

Sophis weave
r import

• textile CAD manufacturer (reverse engineering)

• only  normal  weaves  are  supported,  not  compound

weaves

card
rw punch • textile CAD manufacturer (reverse engineering)

weave
r .BBI import • textile CAD manufacturer (reverse engineering)

r .PUN punch • textile CAD manufacturer (reverse engineering)

QTE r .QTE import • textile CAD manufacturer (reverse engineering)
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Name
Read

Write

Filename

extension
Type Notes

PNG rw .PNG image

• Arahne's default format

• compressed format

• supported in browsers and mailing programs

GIF rw .GIF image
• compressed format

• supported in browsers and mailing programs

TIFF rw
.TIF

.TIFF
image • optional compression

BMP rw .BMP image
• optional compression

• For use with Digital Weaving TC-1

Weaving

Information

File

rw .WIF dobby

• for  interchange  of  weaving  files  among  hobbyist

programs

• up to 99 shafts

• up to 24 weft selectors

• warp/weft pattern

• warp/weft colors

• warp/weft density

Tech
w .SF2 dobby

• up to 24 shafts

• variable weft density

• fringe

• regulator

w .AMV dobby • writing to floppy

DoStyle
rw dobby

• up to 28 shafts

• variable weft density

• variable warp tension

• variable weft speed

DoTech
w .PAT dobby

DoWeave
rw .DES dobby

JiangYin

TongYuan

SGA598 rw .DY dobby

• up to 20 shafts

• up to 8 weft selectors

• up  to  4  variable  densities,  regulator  interpreted  as

second weft density

FAST
rw .ARM dobby

• filename limit 6 characters

• up to 20 shafts

• up to 8 weft selectors

• variable weft density

• regulator

• pile height

w .D dobby
• up to 28 shafts

• variable weft density

w .des dobby

• up to 24 shafts

• up to 8 weft selectors

• fringe

• loom speed

• up to 8 variable densities



25 4    C hap t er  2 2   
 Sup p ort e d  format s

www.arahne.si  

Name
Read

Write

Filename

extension
Type Notes

G6300
rw .ARM dobby

• up to 24 shafts

• up to 16 weft selectors

• fringe

• double weft insertion

• up to 16 variable weft densities

rw .DOP dobby • dobby information (can also contain weft change)

rw .COP dobby • weft change information

1858 III
rw .DB1 dobby

• up to 28 shafts (26, if used with variable density)

• up to 8 weft selectors

• regulator

• up to 4 variable weft densities

rw .UWF dobby

rw .PID dobby

• up to 27 shafts

• up to 12 weft selectors

• fringe

• regulator

• variable weft density

rw .PIW dobby

• up to 12 weft selectors

• fringe

• regulator

• variable weft density

AT710
w dobby

• up to 20 shafts

• weft change information

• variable weft density, with absolute density values

• fringe

• regulator

• double weft insertion

Tsudakoma

rw .DP5 dobby

• up to 20 shafts

• weft change information

• variable weft density, with absolute density values

• fringe

• regulator

• double weft insertion

22.2 IMAGE FORMATS

All  image formats  are automatically  detected, no user intervention is  necessary.  The weaving CAM

formats are also read as black and white images, but we will not repeat them here.

For saving in selected format, just add the filename extension. Without extension, the program will

save the image as a PNG file.

File format Read

Write

Filename

extension

1-bit 8-bit

colormap

24-bit

true

color

Notes

PNG rw .PNG ✔ ✔ ✔ • Arahne's default format

• very good compression

• Alpha  channel  transparency  is  not

supported
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File format Read

Write

Filename

extension

1-bit 8-bit

colormap

24-bit

true

color

Notes

GIF rw .GIF ✔ ✔ • good compression

• interlaced GIF is not supported

• transparent  colors  in  GIF  are  not

supported

JPEG rw .JPG

.JPEG

✔

grayscale

only

✔ • lossy  compression  –  saving  image

several times will lose details;

• not appropriate for saving cleaned up

jacquard images

TIFF rw .TIF

.TIFF

✔ ✔ ✔ • optional compression

WebP rw .WEBP ✔ • not appropriate for saving cleaned up

jacquard images

• Alpha  channel  transparency  is

supported

BMP rw .BMP ✔ ✔ ✗ • optional compression, but very bad

• 24-bit  is  not  supported  in  Arahne's

programs

PBM r .PBM

.PGM

✔ ✔ ✔ • not compressed

Sophis

image

r ✔ • textile CAD manufacturer

• (reverse engineering)

• not compressed

CSS

JacquArt

r .APF ✔ • textile CAD manufacturer

• optional compression

EAT image

r ✔ • textile CAD manufacturer

• reverse engineering

• not compressed

• .eatpc not supported

IAM image

r .PAT ✔ • textile CAD manufacturer

• reverse engineering

• not compressed

Colorado

image

r ✔ • textile CAD manufacturer

• reverse engineering

• compressed

r .PAT ✔ • textile CAD manufacturer

• not compressed

Text w .TXT ✔ • for manual card punching

22.3 OTHER CAM FORMATS

ArahWeave also supports drawing-in machines and few warpers.
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Name Read

Write

Filename

extension

Type Notes

CCI Tech w .SF2 warper

Vega

w .VIF drawing-

in

• shafts

• reed

• empty dents

• drop wires

SuperVega w .SVI drawing-

in

• shafts

• reed

• empty dents

• drop wires

Delta

100/110/200

w .DAT drawing-

in

• the filename of the drawing-in file 

is:  prog0001.dat

• the filename of the warp pattern 

file is: scha0001.dat

• number in the filename can be 

from 000 to 999

Suzuki

w .MZ warper

JiangYin

TongYuan

w .CEL warper

22.4 XML FORMATS

All XML files should be placed in the default xml location, specified in the .arahne configuration file. If

the files are only shared by NFS, then this location is usually /home/capdam/data/xml

If the files are shared by a web server, then this location is usually /srv/www/htdocs/xml

For  simulation/weave  orders/replies  we  place  the  XML  files  in  subdirectories,  to  avoid  confusion.

ArahWeave imports also XML files by ftp from the specified host, this is configured in the Data export

section of Save setup, and saved in .arahne configuration file.

Name Read

Write

Format DTD

(document type definition)

Notes

xyz.xml w ArahneFabric.dtd • xyz corresponds to 

fabric name

• contains all fabric 

related data, which EDP 

software would need

ArahneWarpPatternImport.xml r ArahneWarpPatternImport.dtd • warp patterns and 

codes, no colors

• all patterns in one file

ArahneWeftPatternImport.xml r ArahneWeftPatternImport.dtd • weft patterns and 

codes, no color

• all patterns in one file

http://www.arahne.si/xml/ArahneWeftPatternImport.dtd
http://www.arahne.si/xml/ArahneWarpPatternImport.dtd
http://www.arahne.si/xml/ArahneFabric.dtd
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Name Read

Write

Format DTD

(document type definition)

Notes

ArahneYarnColorImport.xml r ArahneYarnColorImport.dtd • list of yarn colors

• all colors in one file

ArahneYarnImport.xml rw ArahneYarnImport.dtd • yarn definitions from 

database point of view

• all yarns in one file

ArahneYarnToColor.xml r ArahneYarnToColor.dtd • association of yarn 

color code to yarn code,

with price and 

availability

• all yarns in one file

ArahneFabricStatus.xml r ArahneFabricStatus.dtd • list of different statuses,

like Sample, Production,

Test...

ArahneFabricTypeBits.xml r ArahneFabricTypeBits.dtd • list of fabric types, 

finishing processes

ArahneFinishingBits.xml r ArahneFinishingBits.dtd • list of finishing 

processes

ArahneDesigners.xml r ArahneDesigners.dtd • list of designers

ArahneFinishingImport.dtd r ArahneFinishingImport.dtd • list of different finishing

processes with code for 

each process

ArahneCustomerImport.dtd r ArahneCustomerImport.dtd • list of customers

ArahneSeasonImport.dtd r ArahneSeasonImport.dtd • List of seasons, like 

Spring 2018, ...

22.4.1 ARAHWEAVE SERVER MODE XML FILES

Name Read

Write

Format DTD

(document type definition)

Notes

xyz.xml

...xml/simulationOrder/in

r ArahneSimulationOrder.dtd • xyz  corresponds  to

simulation order

• specifies  request  for

generation  of  fabric

simulation  based  on

warp,  jacquard  card,

weft  density  and  weft

yarns

xyz.xml

...xml/simulationOrder/out

r ArahneSimulationOrderReply.dtd • xyz  corresponds  to

simulation order reply

• reports success or 

reason for failure

xyz.xml

...xml/weaveOrder/in

r ArahneWeaveOrder.dtd • xyz corresponds to 

weave order

• specifies request for 

creating card files and 

sending them to the 

loom

http://www.arahne.si/xml/ArahneWeaveOrder.dtd
http://www.arahne.si/xml/ArahneSimulationOrderReply.dtd
http://www.arahne.si/xml/ArahneSimulationOrder.dtd
http://www.arahne.si/xml/ArahneSeasonImport.dtd
http://www.arahne.si/xml/ArahneCustomerImport.dtd
http://www.arahne.si/xml/ArahneFinishingImport.dtd
http://www.arahne.si/xml/ArahneDesigners.dtd
http://www.arahne.si/xml/ArahneFinishingBits.dtd
http://www.arahne.si/xml/ArahneFabricTypeBits.dtd
http://www.arahne.si/xml/ArahneFabricStatus.dtd
http://www.arahne.si/xml/ArahneYarnToColor.dtd
http://www.arahne.si/xml/ArahneYarnImport.dtd
http://www.arahne.si/xml/ArahneYarnColorImport.dtd
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Name Read

Write

Format DTD

(document type definition)

Notes

xyz.xml

...xml/weaveOrder/out

w ArahneWeaveOrderReply.dtd • xyz corresponds to 

weave order reply

• reports success or 

reason for failure

xyz.xml

...xml/deleteOrder/in

r ArahneDeleteOrder.dtd • xyz corresponds to 

delete cards from 

loom order 

• specifies request for 

deleting jacquard card 

file from the loom

xyz.xml

...xml/deleteOrder/out

w ArahneDeleteOrderReply.dtd • xyz corresponds to 

delete order reply

• reports success or 

reason for failure

xyz.xml

...xml/reloadCardOrder/in

r ArahneReloadCardOrder.dtd • xyz corresponds to 

reload card from loom 

order

• specifies request for 

reloading jacquard 

card file from the loom

xyz.xml

...xml/reloadCardOrder/out

w ArahneReloadCardOrderReply.dtd • xyz corresponds to 

delete order reply

• reports success or 

reason for failure

xyz.xml

...xml/headerFooterOrder/in

r ArahneHeaderFooterOrder.dtd • xyz corresponds to 

header/footer order

• specifies request for 

generation of header 

and footer fabrics with

weaving program and 

optional text.

xyz.xml

..xml/headerFooterOrder/out

w ArahneHeaderFooterOrderReply.dtd • xyz corresponds to 

header/footer reply

• reports success or 

reason for failure

xyz.xml

..xml/statusOrder/in

r ArahneStatusOrder.dtd • xyz corresponds to 

staus order

• it serves only to test if 

ArahWeave server is 

running, it does not 

perform any operation

xyz.xml

..xml/statusOrder/out

w ArahneStatusOrderReply.dtd • xyz corresponds to 

status order reply

http://www.arahne.si/xml/ArahneStatusOrderReply.dtd
http://www.arahne.si/xml/ArahneStatusOrder.dtd
http://www.arahne.si/xml/ArahneHeaderFooterOrderReply.dtd
http://www.arahne.si/xml/ArahneHeaderFooterOrder.dtd
http://www.arahne.si/xml/ArahneReloadCardOrderReply.dtd
http://www.arahne.si/xml/ArahneReloadCardOrder.dtd
http://www.arahne.si/xml/ArahneDeleteOrderReply.dtd
http://www.arahne.si/xml/ArahneDeleteOrder.dtd
http://www.arahne.si/xml/ArahneWeaveOrderReply.dtd
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23 GLOSSARY

This  is  not a true glossary,  only some tips to help you out of confusion in textile terms. It lists  the

synonyms for a given term. Some of these terms do not really mean exactly the same thing, but are

often interchanged in the industry. We only use one term, so that a reader will  not assume we are

talking about two different things.

• warp thread = end

• weft thread = pick

• weft density = pick gear

• weave = weave structure = binding

• pattern draft = dobby weave with all the elements: weave, drafting, tie-up, dobby card

• regulator = warp let-off = stop-motion = dead pick = cramming

• shaft = heald

• fabric = cloth

• drafting = draw-in = heddling = threading

• dobby card = peg plan = chain

• yarn = thread

• warp yarn = end

• weft yarn = pick = filling = fill

• multi-layer weave = compound weave = double weave

• weft change = weft selector = box motion

• extra weft = lancee = supplemental weft = figuring weft = tissue pick

• blanket = colorway

• cone = bobbin

• fill coupe, antique cut

24 KEYBOARD ACCELERATORS

Keyboard accelerators (also called hot-keys) should enable an experienced user to work faster, by being

able to select some commonly used functions directly from the keyboard instead of the menu. We have

decided not to translate accelerators – that means that we have the same key accelerator layout for all

the languages. Mostly, they are mnemonic in English (the first letter resembles the function in English).

Accelerators work only if the appropriate window is active; normally the active window is indicated in a

different window frame color.  We have tried to link one key to one program function, but in some

cases it was also logical to make the same key activate different functions, depending on the active

window (part of the program we are working on at the moment).
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25 LIMITS

ArahWeave is a very powerful program, but it has its limits. Mainly, these limits were imposed so that

we could perform more efficient range checking on user entry, faster file loading, to improve reliability.

Sometimes they are also motivated by deeper technical reasons.  In any case, you have the right to

know what they are,  so  you do  not buy  the program,  and later  discover  you cannot  do your  job.

Obviously, we can also raise some of these limitations, should it prove to be necessary.

• Maximum weave size:  ArahWeave Pro 65520 by  65520 threads;  ArahWeave Pro XL  262 080 by

262080 threads

• Maximum number of shafts: 99

• Maximum size of image for jacquard conversion: 65520 by 65520

• Maximum number of hooks in jacquard loom layout: 65520

• Maximum number of entries in the description of loom layout: 50

• Maximum number of warp threads in consumption calculation: 65520

• Maximum number of threads in one dent: 125

• Empty dents (0 threads per dent) are supported, but fabric cannot start with an empty dent, and

cannot have only empty dents

• Maximum number of consecutive wefts with active regulator: 125

• Fabric cannot start with an active regulator.

• Accurate fabric simulation, where top layer yarns completely cover bottom layers: 3 warp systems, 3

weft systems. It is possible to make simulations of fabrics with more layers, but they will  appear

more open, not completely closed.

• Maximum weave system: 16 warps and 16 wefts.

• Number of different yarns in warp or in weft: 25 (A-Y)

• Maximum number of  different color  components  within  one yarn (for  mélange,  mouliné,  space

dyed): 6 (all of them can be calibrated colors); internally ArahWeave generates two darker and two

lighter variations of each color, so the actual maximum number of colors in simulation of one yarn is

30.

• Maximum number of  fabrics  /  images  /  weaves  /  yarns  /  warp patterns  /  weft patterns  in  the

browsers: unlimited. We have tested the system with over 150.000 files loaded contemporary and it

worked without problems.

• Maximum number of sections in blanket in warp and in weft: 30

• Maximum number of threads in one blanket section: 3000

• Maximum number of threads in one weft blanket section: 65000

• Maximum number of fabrics / weaves, which can be assembled together in a weft blanket: 80

• Maximum number of color / yarn variations of a single fabric / weave in weft blanket: 32

• Maximum number of colors in a color database: 65520

• Limits for entry of CIE Lab values: 0<=L<=100, -120<=a<=120.0, -120<=b<=120;

• Two decimal points Fabric density: minimum 1 thread per cm; maximum 50000 threads/cm

• Reed number: minimum 1 (dent/cm); maximum 1000 (dents/cm); 2 decimal points

• Reed space, raw width, finished width: minimum 5 cm; maximum 10000 cm; 2 decimal points

• Fabric zoom level: minimum 5% (twenty times smaller); maximum 2000% (twenty times bigger)

• You  can only  work  on  one  fabric  at  a  time,  but  you  can  contemporary  run  as  many  copies  of

ArahWeave as you like.
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In various  screenshots of  this  manual,  we use fabrics  and data of  the following Arahne customers:

Arazzo,  Danzo,  IBI  Kranj,  Paganini  Tessuti,  Pure  Country  Weavers,  Lanificio  di  Sordevolo,  Svilanit,

Tekstina, Tessilbiella, Velana. Color shading photo of Illy coffee on the island of Kos by Dušan Peterc.

Chinese program text translation: Peak Ding

Finnish program text translation: Antti Alalammi

French program text translation: Alexander Peterc, Vincent Masurel

German program text translation: Polona Dobnik Durbrovski, Andreja Gutmaher, Jan Peter Elsebach

Italian program text translation: Riccardo Sattier, Dušan Peterc. Manual translation: Davide Sasso, Anna

Negri, Stefano Bellanca; inspection and correction by Antonio Danzo.

Portuguese program text translation: Joaquim Alves Pereira

Spanish program text translation: Jaime Vives Piqueres, Manual translation: Flavia Esperón

Thai program text and manual translation: Vichai Tantikunakonrat

Turkish program text and manual translation: Sabri Sever
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